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Chapter 1
Product Description

This chapter provides an overview ofWebtop (WT) and DocumentumApplication Connectors (DAC).

Documentum Webtop
Webtop is an easy-to-use interface that allows users to access Documentum repositories and content
management services within a standard browser application. Webtop is ideal for users particularly
when content is accessed from remote locations across the Internet.

Key features of Webtop include the following:

• Access to core content services. Grants employees convenient Web access to core Documentum
content services including security, version control, library services, content lifecycles, and search

• Advanced content services. Manages advanced content services including workflows, virtual
documents, content subscriptions, categorization, and My Files

• Multilingual aptitude. Supports multilingual content through international language packs and
support for Unicode

• Easy search. Provides convenient one-box search in every view

• Rapid deployment. Deploys quickly throughout an enterprise, leveraging standard Web browsers
on client machines

Documentum Application Connectors
Documentum Application Connector enables you to access a Documentum repository directly from
one or more of the following Microsoft Office applications:

• Excel

• Outlook

• PowerPoint

• Word

Documentum Application Connector comes bundled with Documentum Webtop.
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Section 508 Compliance
This product has been evaluated for compliance with U.S. Federal government Section 508 regulations
and W3C Priority 1 guidelines. It has also undergone user testing for accessibility and usability by
the NFB (National Federation for the Blind). For details, see the compliance self-certificate in the
Powerlink site (http://powerlink.EMC.com) for your product version. To locate the compliance
self-certificate, navigate to Support > Documentation and White Papers Library, then select your
product.

Note: The majority of Content Management products are listed under Software D > Documentum
?, where ? = a letter, or letters, in the alphabet.
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Chapter 2
New Features and Changes

EMC Documentum Webtop 6.5, 6.5 SP1, 6.5 SP2, and 6.5 SP3 include a variety of new features and
improvements. This section describes the major enhancements. Refer to the product documentation
for complete information about these features.

New features and changes for 6.5 SP3
There are no new features in Webtop 6.5 SP3. This release contains only bug fixes.

New features and changes for 6.5 SP2
The following provides descriptions of the new features and enhancements in the 6.5 SP2 release:

Webtop 6.5 SP2

The following new items apply to Webtop for Documentum 6.5 SP2:
• Convert Desktop DRLs to Webtop URLs, page 23

• Deep folder export provides "always” and "never” options for overwriting files, page 24

Convert Desktop DRLs to Webtop URLs

The Documentum Desktop client has been phased out. As a result, Desktop users can no longer
access DRLs (links to repository documents) embedded in e-mail messages. Documentum Webtop
6.5 SP2 provides existing Documentum Desktop client users with the DRLinvoker application
(DRLinvoker.exe.config) that enables them to access DRLs and open the relevant linked documents.
This tool converts the DRL into a Documentum Webtop Universal Resource Locator (URL), and
opens the linked document in a browser window.
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Deep folder export provides "always” and "never” options for
overwriting files

Prior to Documentum 6.5 SP2, when a folder was deep exported to a location where a folder by the
same name exists with all or some of the same files as those being exported, users were prompted to
overwrite each duplicate folder and file. The prompt for overwriting each folder and file appeared
with the Yes and No buttons.

With release 6.5 SP2 release, the following additional buttons are displayed while prompting you to
overwrite folders and files: Yes to all and No to all buttons. If you click the Yes or No button, the
overwrite setting is applied to the current file. If you click the Yes to all or No to all button, the
overwrite setting is applied to all files on which the deep export operation is performed. In the
context of UCF, the overwrite setting is applied to all files for that UCF client session. Therefore, users
are not prompted every time a duplicate folder or file is overwritten.

New features and changes for 6.5 SP1
The following provides descriptions of the new changes in the 6.5 SP1 release:

Webtop 6.5 SP1

The following new items apply to Webtop for Documentum 6.5 SP1:

• Name change—Webtop Extended Search is changed to Webtop Federated Search, page 24

• Configuring JRE using UCF, page 25

• UCF Support to NTLM authentication (137831), page 25

• EMCMF support , page 25

• Mac support for BOCS Server, page 26

Name change—Webtop Extended Search is changed to Webtop
Federated Search

The name Webtop Extended Search has been changed to Webtop Federated Search from 6.5 release,
only the name. The Extended Search occurs in the Search chapter of the Documentum Webtop User
Guide version 6.5. This name change to Federated Search does not affect the functionality (advanced
search functionality such as clustering of the search results, real-time monitoring, and search
templates). The deployment of the corresponding DARs too remains unchanged. The deployment
instructions are currently documented in the Installing Documentum Webtop Federated Search
chapter of theWeb Development Kit and Webtop Deployment Guide, version 6.5 SP1.
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Configuring JRE using UCF

Prior to 6.5 SP1 release, in a client / target workstation, if the installed JRE version is higher than the
configured version, then you cannot install the configured JRE version. In a portal environment,
issues are noticed with the installed higher JRE version.

With the 6.5 SP1 release, you can configure Webtop in such a way that the configured JRE version is
always installed.

The value of enforceJreInstalltion is set to false by default. The following snippet is available in the
ucf.installer.config.xml file:
platform os="windows" arch="x86">
<java version="1.5.0" href="win-jre1.5.0_06.zip" exePath
="jre1.5.0_06\bin\java.exe" enforceJreInstallation="false"/>

If the value of enforceJreInstallation is set to false, increment the version in the app Id element of the
ucf.installer.config.xml file to force UCF to pick up the changes made to the ucf.installer.config.xml
file.
<app id="shared" version="6.5.0.036" compatibilityVersion="5.3.0"/>

to
<app id="shared" version="6.5.0.036a" compatibilityVersion="5.3.0"/>

Set the value of enforceJreInstallation parameter in the ucf.installer.config.xml file to true and restart
the application server in the 6.5 SP1 release. This setting will always install the configured JRE
version UCF.
<platform os="windows" arch="x86">
<java version="1.5.0" href="win-jre1.5.0_06.zip" exePath
="jre1.5.0_06\bin\java.exe" enforceJreInstallation="true"/>

Note: You can locate the ucf.installer.config.xml file, and the JRE in the following location:
<app>/wdk/contentXfer

UCF Support to NTLM authentication (137831)

Many corporate networks use NTLM authenticating forward-proxies to restrict Internet connectivity
to authenticated groups of users. Until Java 5, there is no good support for NTLM proxies in the
java.net package. Since the minimum client JVM version for D6 is Java 5, you can take advantage
of the NTLM capabilities in the HttpURLConnection class in the Java SDK. This authentication
helps support customers with NTLM proxies that the home-grown HTTP implementation of the
UCF client does not support.

EMCMF support

Webtop 6.5 SP1 email functionality works with 5.3 or 6.0 repositories, only if you have DCO,
Collaborative Services, and Messaging App DocApps installed on these repositories. These DocApps
are available with a DCO license. If you do not have a DCO license, then the Webtop 6.5 SP1 email
functionality is not supported on these repositories.

EMC Documentum Webtop Version 6.5 SP3 Release Notes 25



New Features and Changes

If you have installed the Collaborative Services DARs, Webtop 6.5 SP1 email functionality works
with 6.5 repositories. Refer toWeb Development Kit and Webtop Deployment Guide, version 6.5 SP1
for more details.

Mac support for BOCS Server

Distributed write for Mac is supported from this release, which implies the file and fork is transferred
through BOCS server. So performance advantages of BOCS write operations are now available
for Mac Clients.

Application Connectors 6.5 SP1

Application Connectors for Microsoft Word, Excel, PowerPoint, and Outlook remain bundled as part
of Webtop. The following new items apply to Application Connectors for Documentum 6.5 SP1:
• Support for Citrix 4.5 Environments, page 26

• Cancel during Save As , page 26

• Edit of Search Results, page 26

• Coexistence with Information Rights Management (IRM), page 27

Support for Citrix 4.5 Environments

You employ a Citrix virtual environment to deploy a standard Windows desktop to your user
community. Users log in to Citrix and gain access not only to a standardized Windows session, but
also to Microsoft Office applications such as Word, Excel, PowerPoint, and Outlook. Application
Connectors 6.5 SP1 has been improved to support such deployments. When The Application
Connectors application runs in the Citrix environment, enabling users who log in using Citrix to
access the Application Connectors functionality in Word, Excel, Power Point, and Outlook.

Cancel during Save As

Application Connectors 6.5 SP1fixes a problem that results in possible data loss if you cancel
Documentum > Save As operation. In 6.5 SP1, a modified document that has not been intermittently
saved will now retain recent modifications even after you cancel Documentum->Save As operation.

Edit of Search Results

In 6.5 SP1 and earlier releases, you cannot locate a document using Search and then choosing to edit
it directly from the Search Results. You can view or edit a document you have located using the
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Documentum > Open capability. You can now select a search result and then open the document
for viewing or editing.

Note: Run both Webtop and the Application Connector client in 6.5 SP1 to receive this functionality.

Coexistence with Information Rights Management (IRM)

In 6.5 SP1, WDK absorbs new IRM capabilities. Application Connectors are based on WDK, and
hence explicitly take into account documents that have been protected via IRM now.

To ensure compatibility with IRM and honor protected document status, Applications Connectors
have the following new behavior:

• You cannot see IRM protected documents when browsing folders through Application Connectors.

• If you open an IRM document from Webtop, Application Connectors operations Save / Checkin /
Save As / Cancel checkout are blocked.

• If you protect a local document using the Rights menu in an Office application, Application
Connectors does not allow you to save the document in a repository using the Save As option.

New features and changes for 6.5
The following provides descriptions of the new features in the 6.5 release:

Note: The Email conversion to EMCMF format is disabled in OTB Webtop. This feature is only
available for Windows-based Client.

This feature will be supported from 6.5 SP1.

Webtop 6.5

The following new items apply to Webtop for Documentum ECM 6.5:
• Email conversion to EMCMF format, page 28

• Page refresh enhancements, page 31

• Multi-select drag and drop, page 32

• HTTP or UCF choice enhancement, page 32

• Deep export, page 32

• Modal dialogs, page 33

• UCF performance improvements in Webtop, page 34

• Content transfer dialog, page 35

• Support for Lightweight System Objects (LwSOs), page 35
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Email conversion to EMCMF format

Email message (.msg) files are imported as a type or subtype of the dm_message_archive type and
are converted to the EMCMF format. UCF handles the conversion of native email messages to
EMCMF format.

The following functions are enhanced to support this conversion:
• Import. When a user imports an email message (.msg), the email message converts to EMCMF
format and gets stored as a dm_message_archive type. All attachments in the email are imported
and related to the email.

• Export. When a user exports an EMCMF object, the object converts to native email format (.msg)
for viewing by Outlook.

• View Properties and Listing pages. The Properties and Listing pages have been enhanced to show
email centric attributes such as To, From, Date Sent and Subject.

• Transform. EMCMF messages can be transformed to HTML, XML, or PDF.

Note: By default, the Email conversion to EMCMF format feature is disabled. If you enable this
feature, there is a delay when you first import or export an email message. In addition, the delay
occurs due to downloading a large executable file that initializes this feature.

Enabling email message archive import support in Webtop save the Outlook messages (.msg) in
email message format (EMCMF) with type as dm_message_archive on import. To convert existing
dm_email_message objects to dm_message_archive, refer theWebtop Email Migration Guide.

Disabling email message archive import support in WDK-based applications, on import of Outlook
messages (.msg) files get imported as dm_email_message object, and the import of .msg files fail in
case you set the type to dm_message_archive manually.

Webtop allows viewing of emails through a special HTML viewer. The HTML viewer provides user
access to related email attachments. Attachments can only be viewed but they can also be found
through a search results screen. You can copy and paste the attachment to a location within the
repository and make that attachment a new independent object, to version an attachment.
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Figure 1. HTML viewer for email

Users also see an enhanced search screen in Webtop, to search on email-specific attribute values ().
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Figure 2. Enhanced search

Also available is a conversion utility for emails already in a repository. This utility is run as a separate
application to convert existing emails to the EMCMF format ().
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Figure 3. Conversion utility for emails

Page refresh enhancements

Webtop improves performance by reducing the amount of refreshes and by making better utilization
of the AJAX framework. The following are a few examples:
• User chooses a folder in the browser tree to view a list of content contained in the folder. Before
Documentum ECM 6.5, there was first a refresh of the browser tree applet and then there was a
refresh of the content list. In Documentum ECM 6.5, there is no refresh of the browser tree.

• In the content list pane, the user double-clicks a subfolder to see contained content. Before
Documentum ECM 6.5, the browser tree applet refreshed and then the content pane refreshed
to show the content. The browser tree refreshes to show a selection of the folder in the browser
tree and if needed, to expand that folder. In Documentum ECM 6.5, the selection and expansion
is accomplished without a refresh.

• User has a checked out document. The user decides no changes are needed and wants to cancel
the checkout. The user selects the content and chooses the menu option to cancel checkout. Before
Documentum ECM 6.5, the screen went blank before bringing up a dialog to choose OK on the
cancel. After choosing OK, the user saw another blank screen and a progress bar to show the user
progress of the action. The application then returned to the content pane. While returning to the
content pane, the browser tree applet and content pane refreshed. The removal of refreshes, the
enhanced transfer progress bar, the use of modal dialogs, as well as the improved performance,
significantly enhances the user experience.

The reduction of screen refreshes are found throughout the product.
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Multi-select drag and drop

Users can select multiple files and perform a drag and drop. The multi-select drag and drop
functionality is available for all areas where single file drag and drop were previously available. For
example, users can multi-select files and drag and drop them to another folder in the repository.
Multi-select drag and drop can also work when exporting and importing multiple files to and from
the local file system.

HTTP or UCF choice enhancement

Webtop 6.5 enables administrators to specify HTTP or UCF content transfer for different users within
the same Webtop installation. Before Documentum ECM 6.5, all users within the same Webtop
installation had to use either HTTP or UCF content transfer.

Deep export

Webtop enables you to export one or many folders and allows the structure of those folders to remain
intact depending on the permission set of the files and folders ().

By default, Deep export is disabled. You must enable Deep export enabled in app.xml file to make it
work.

When you export files containing special characters (:, ?, <>, ", |, *) in their names, Webtop exports
the files after removing the special characters from the file name.

Deep export of a hidden folder is allowed when you export a parent folder. If a folder is not visible in
Webtop, all subfolders including hidden folders are exported during Deep export.

Some rules apply when using Deep export:

• Deep export is supported for UCF content transfer, not HTTP content transfer.

• Only the primary content is exported, no renditions are exported.

• Only the current versions of documents are exported.

• Deep export is trimmed down not to support VDM

• Deep export is automatic when a folder is selected for export.
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Figure 4. Deep export

Modal dialogs

This feature provides modal popup dialogs for action screens involving dialogs (). A modal dialog
is a child window which requires the user to interact with it before they can return to the parent
application. This feature enhances performance and allows the user to see the context from where the
action was launched. Previously, the user chose an action, the screen refreshed and took the user to a
new screen. With modal dialogs, a new window pops up on top of the previous screen. The previous
screen is viewable, but no actions can be taken on that screen while the modal dialog is active.
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Figure 5. Modal dialogs

UCF performance improvements in Webtop

UCF content transfer is more usable and performs better. The following lists the UCF enhancements
for Documentum ECM 6.5:
• Reduction in the number of round trips between the UCF client and server. This feature is
especially effective for improving transfer performance for smaller files over a high latency WAN.

• The following UCF client initialization/startup improvements:
— Sharing a JVM instance across multiple web sessions

— Starting JVM upon login

• Support for PDF byte streaming through a native viewer.

• Use of parallel streams to increase content transfer rate. This feature is especially effective for
improving content transfer performance of large files over a high latency WAN (outbound and
inbound).

• Freeing up stuck threads to optimize resources and increase concurrency.

• Reduction in unnecessary WDK UCF client calls.
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Content transfer dialog

An improved content transfer dialog box shows the action that is running (in the header of the dialog
box), the file that is currently being transferred, and the progress of that transfer. The new dialog box
is easier to understand and is similar to most applications that you use.

Support for Lightweight System Objects (LwSOs)

Webtop supports Lightweight System Objects (LwSOs). LwSOs store metadata, common to many
different (but similar) child objects, at the parent object level. This support reduces the storage
footprint and ingestion processing required for the child objects.

Email archiving provides a classic example for LwSOs where individual emails are grouped in order
of the user. Metadata common to all emails are stored at the parent (user) level. Thus the user is the
parent, and the emails of the user are the LwSO children.

Webtop interacts with LwSOs in the following manner:
• Browsing. When you browse through cabinets and folders, you cannot view parents or children
associated with LwSOs.

• Simple Search. When a user performs a simple search the results display shared parent objects
only, no children.

• Advanced Search. When a user performs an advanced search the results display children, but
NOT the parents, associated with LwSOs.

• Attributes. A user can open the properties of a LwSO and edit its properties from search results.
When an attribute is chnaged, the LwSO materializes into a full object.

• Properties panels show ALL attributes associated with a child along with any inherited attributes
from the parent. The properties panel relies on the attribute display configuration made using
Documentum Application Builder or Documentum Composer. You can use the properties panel
to mark attributes as editable or read-only. In either case, Webtop honors the configuration.

Native 64-bit support

Documentum 6.5 introduces native 64-bit support for running on 64-bit operating systems. The
native 64-bit support takes full advantage of 64-bits of address space and the concurrent use of
more than 4 GB of executable memory. For a fully qualified native 64-bit environment, you must
have a 64-bit processor, 64-bit operating system, 64-bit JVM, and 64-bit application server. Support
continues to be offered on 32-bit platforms.

IPv6 support

This product is compliant with IPv4-IPv6 dual-stack and native IPv6 enabled environments. The
Environment and System Requirements chapter provides more information on IPv6 support for
the product.
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Documentum Collaborative Services (DCS) 6.5

The Documentum ECM 6.5 release of Documentum Collaborative Services (DCS) strengthens and
enhances the native collaboration capability of the Documentum product family – an integration that
started with 5.3. The following new items apply to DCS for Documentum ECM 6.5:
• User experience improvements, page 36

• Web Services and additional APIs, page 37

• Transition to DAR and lightweight system object, page 38

User experience improvements

In Documentum 6, DCS introduced the use of data tables as a convenient way to create and manage
structured collections of similar data such as lists of issues, tasks, milestones, and contacts. In
Documentum ECM 6.5, data tables provide an improved summary for data table fields like the traffic
light. The data table entry view provides a visual and user-friendly view of table entries. The entry
view also supports attachments for a given entry as well as the ability to discuss the viewed entry.
Another usability enhancement () allows for in-place editing of notes.
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Figure 6. Improved user experience

Web Services and additional APIs

In Documentum ECM 6.5, discussions and rich text can be consumed as web services through
Documentum Foundation Services (DFS). In addition, room template support at the BOF API level
allows for the programmatic creation of rooms based on pre-defined templates. This functionality
provides a foundation for future enhancements and offerings, as well as partner integration
opportunities.
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Transition to DAR and lightweight system object

In the Documentum ECM 6.5 release, the DCS DocApp was migrated to the new Documentum
Archive (DAR) format. A DAR is compatible with the Eclipse-based Documentum Composer
development tool. In addition, compatibility testing with the new lightweight system object has
been performed.

Application Connectors 6.5

Application Connectors for Microsoft Word, Excel, PowerPoint, and Outlook remain bundled as part
of Webtop. The following new items apply to Application Connectors for Documentum ECM 6.5:
• Save As usability improvements, page 38

• Custom Documentum menu label in dialog frames, page 39

Save As usability improvements

Application Connectors for Word, Excel, and PowerPoint provide improved usability for
Documentum->Save and Documentum->Save As actions.

• By default, the Documentum warning dialog appears when you open a document for edit.
If you select the Do not ask again option in the Documentum warning dialog, then the
default preference is not selected in Documentum®Preferences. You can set the warning
preference in Documentum®Preferences when you open a document for editing, and use the
Documentum®Save As option in Documentum Application Connectors applications.

• When you open Doc1 from the repository and perform Save As of Doc1 to Doc2, Doc1 remains
checked out. However, a warning dialog box is displayed ().

Figure 7. Reminder to check in original document during Save As operation

• An application administrator or IT developer can configure the text in the Save As warning
dialog to fit customer terminology.

• When performing Save As of Doc1 from the local file system into the repository, Application
Connectors creates Doc1 in the repository and checks it out for edit. This behavior mimics native
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Microsoft Office behavior. If a user does not want to continue editing Doc1 (but wants to perform
an Import), the user can choose to continue editing after the Save As () operation.

Figure 8. Option to continue editing after Saving a document into the repository

• When performing an Open or Save As operation, the user sees the relevant document format
based on whether the user is in Word, Excel, or PPT.

Custom Documentum menu label in dialog frames

Customers can install Application Connectors and specify a custom label for the Documentum menu.
If a customer defined a custom Documentum menu label in earlier releases of 6.5, that label did not
appear correctly in dialog window frames. In 6.5, Application Connectors show the custom label
instead of the string, "Documentum” in dialog window frames (e.g. in the Save As dialog).
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Chapter 3
Fixed Problems

Within two weeks of the release, a list of the fixed problems in the release will be posted on the EMC
Powerlink website (http://powerlink.EMC.com). You must have a software support agreement to log
in and access the list of fixed bugs.

To view the list of fixed problems:

1. Log in to the Powerlink website.

2. Select the Search Support tab, and then click Advanced Search.
The Search Support page appears.

3. Under the Search Support heading, click All Support Resources and select Documents from
the list.

4. In the text field, type the product name.

5. Click Show Advanced Options to expand the Advanced Options pane.

6. Under Document Type, select Fixed Bugs List.

7. Click Search at the bottom of the Advanced Options pane.

8. Scroll down to see the search results listing the Fixed Bugs documents for each release of the
product.

9. Click the document name to view the file.
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Fixed problems
The following problems have been fixed:

Unable to import .msg files in the EMCMF format
(DC-24)

If you enable messageArchive-support in the wdk/app.xml file, log on to Webtop on a Windows
Vista Client computer, and import more than six (6) .msg files into the repository as EMCMF format
files, the Transport exception occurs. The .msg files are not imported successfully in the EMCMF
format.

When the primary server stops responding users
are unable to perform operations in Webtop
(WEBTOP-9604)

If Webtop is deployed on IBMWebSphere application server 7.0.0.5 in a clustered environment and
the primary server stops responding, users are unable to perform operations in Webtop although
another server is up and running.

Workaround:

Apply the following IBM WebSphere fix packs to resolve the NullPointerException issue in
CompoundClassLoader, and to prevent deadlocking that occurs between class loading and logging:
• 7.0.0.5-WS-WAS-IFPK90343 - Corrects deadlocking that occurs between class loading and logging

• 7.0.0.5-WS-WAS-IFPK93952 - Corrects NullPointerException from CompoundClassLoader

When you perform a full text search, Webtop
performance slows down considerably (WEBTOP-8696)

If you choose the option to view 100 search results per page and perform a full text search, Webtop
performance slows down considerably.

You can enhance query performance, by disabling Folder path display. This requires a configuration
change in search60_component.xml in the WebComponent layer, where you set the value of
the <displayresultspath> parameter in webcomponent/config/library/search/searchex/search60_
component.xml to false.
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Unable to specify properties for linked documents
while importing the parent document (WEBTOP-7962)

While importing a parent document that contains linked descendant documents, you cannot specify
properties for the linked documents.

Unable to view the selected inbox while working with
multiple repositories and inboxes (WEBTOP-8918)

When a user who is logged in to multiple repositories and working with multiple inboxes switches
over to another inbox after working on one inbox, the first inbox continues to be displayed. The other
inbox is displayed only when the user refreshes the browser.

Content specified in the User comments field is not
reflected in the Description field (WEBTOP-7996)

When you check in a file into Webtop, content specified in the User comments field is not reflected in
the Description field.

When you check out virtual documents a warning
message is displayed and a read-only version of the
document is checked out (WEBTOP-8666)

If a user selects the All, root, and descendants option while checking out a parent virtual document
whose descendants the user has already checked out, or if a user selects the All, root, and
descendants option while checking out a parent virtual document whose descendants are already
checked out by another user, the following message is displayed and a read-only copy of the virtual
document is checked out into your Checkout folder: "<document name> has been checked out in a
different machine. A read-only copy of this document will be used."

Unable to delete the link to a document and an error
occurs (WEBTOP-6022)

Consider a user with the Browse basic permission and the Change location extended permission on a
linked document in a folder of the Home Cabinet. If such a user deletes the link in the destination
folder of the Home Cabinet, an error message is displayed. The message indicates that the user does
not have the Delete permission on the document and cannot delete the link to the document.
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Data in numeric columns is sorted incorrectly (DCS-72)

Sorting works correctly if numeric columns contain numeric values only. However, sorting does not
work on alphanumeric data in numeric columns.

An error occurs when Webtop users with the Version
permission create a document (161635/WEBTOP-3945,
WEBTOP-7159)

When a user with the Version permission creates a document (dm_document object) in Webtop, the
"No write access" error occurs. However, a blank document is created successfully.

You can configure Webtop users with the Version permission to create dm_document objects by
customizing the newdocument_component.xml file and setting the value of the <enabled> tag in the
<wdk_new_doc_aspect> tag to true.

Modify the newdocument_component.xml file by adding the following code below the code for
combo_defaults:
<wdk_new_doc_aspect>
<enabled>false</enabled>
<exclusion_list></exclusion_list>
</wdk_new_doc_aspect>

1. This configuration enables users who do not have the Delete permission on the object being
created, to create a document as the object owner. For example, if you enable this behavior, users
with the Version permission can create new documents.

2. When this option is enabled, the application attaches a temporary permission by attaching a new
aspect and removes the aspect on the first version.

3. If you specify any custom types for dm_document, this behavior does not apply for these types
even if the option is enabled in step 2.

Note: This configuration is supported from Documentum 6.5 SP2 and requires the Documentum 6.5
SP2Webtop.dar to be compatible with the Content Server.

Missing MAXLENGTH support for string type of
attributes (WEBTOP-4521)

Text input controls (dmf:text and derived controls) in Documentum do not support the MAXLENGTH
attribute available in the HTML standard. This attribute limits the number of characters a user
can enter in a text field.

Text input controls have been enhanced to support the MAXLENGTH attribute that can be defined
for string type of attributes. If MAXLENGTH has been defined for a string type of attribute, the value
of MAXLENGTH determines the maximum number of characters that a user can enter in a text field.
For example, the MAXLENGTH attribute can be defined for a text control as follows:
<dmf:text name="txtSearch" id="txtSearch" size="35" maxlength="40"
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defaultonenter="true" tooltipnlsid=’MSG_GO’ autocompleteid=
"ac_simplesearch"/>

Data bound controls such as dmfx:docbaseattributevalue, dmf:docbaseattribute, and
dmfx:docbaseattributelist set the maximum input length of the text control to the length defined for
the string type of attribute in the data dictionary.

An exception occurs when you set a repeating attribute
for a custom field of an object (170393/WEBTOP-2473)

An exception occurs when you select a repeating attribute for a custom field of an object in Webtop.

Time out occurs while performing a second request for
content using a DRL or weblink (164691)

While using a DRL or weblink to access the content, the first transfer works fine. However,
subsequent requests fail. Depending on how the DRL is invoked, a blank browser window or the ucf
session wait timeout error on the client side is displayed.

Deep export of a folder does not allow always and never
to overwrite existing files (167447/WEBTOP-2726)

Deep export of a folder often contains lots of files, and it is not a viable option to confirm overwriting
files for every file. This missing option limits the usability of the Deep export severely.

WDK-based application displays a time-out error
if you belong to a larger number of groups
(169501/WEBTOP-1257, WEBTOP-7356)

When you log in to a WDK-based application as a member of several groups (approximately of
30K-50K), the login process takes more time (~ 5-10 minutes) and a time-out error occurs.
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Failed to convert the receive date java.
text.ParseException: Unparseable date:
"2008-12-02T18:32:29" (170760//WEBTOP-2496,
WEBTOP-7262)

If you import an email message in Webtop (English) on an application server (English) and Content
Server (English) that are set to Arabic regional settings, the import operation fails.

Mandatory user configuration on Firefox 3 for
Webtop to display the absolute path of the file
(170582/WEBTOP-2482, WEBTOP-7264)

In Mozilla Firefox 3.0.1, the file path of the document for Import Rendition, Checkin (UCF Mode), and
Checkin (HTTP mode) is not displayed. In addition, only the document name is displayed and you
are not allowed to perform further operations. See the Enabling content transfer in Firefox section in
theWeb Development Kit and Webtop Deployment Guide, Version 6.5 SP2 for more details.

Cannot set state on datagrid controls (145191/WDK-262)

The state of datagrid controls is not guaranteed. For example, a checkbox within a datagrid can have
an associated client-side or server-side event. However, the state of the checkbox is not maintained
when the datagrid is refreshed.

An error occurs if the preference repository is
unavailable when the application server is starting up
(170670/WEBTOP-6100, WEBTOP-6813)

If the Webtop application is started when the preference repository is down, Webtop fails to detect
whether the preference repository has become available again. In addition, Webtop is unable to
recover from the preference repository unavailability while the application server starts up. When the
application server starts up, an incorrect error message is displayed in the Webtop application.

An error occurs when the folder creation operation is
terminated abruptly (WEBTOP-6280)

The Webtop application fails while canceling the creation of a new folder, and the
[DM_API_E_NO_SESSION] error occurs.
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An error occurs when a Workflow task is forwarded
(WEBTOP-6286)

The Webtop application fails while forwarding a Workflow task, and the [DM_API_E_NO_SESSION]
error occurs.

The 404 error message is displayed when you click the
Help icon (WEBTOP-6547)

When you click the Help icon in the Choose a Location page that is displayed to remove locations
from other repositories while creating a preset, the 404 error message is displayed. The relevant
context-sensitive help must be authored and a new help ID must be mapped.

Webtop allows you to perform the Move Here operation
on an attachment copied from an email message
(WEBTOP-7510)

When you open an email message containing an attachment, copy the attachment to clipboard, close
the message, navigate to the location to which to move the attachment, open the location, and select
Edit >Move Here, the attachment is moved successfully.

Columns are not sorted properly in Workflow reports
(WEBTOP-6341, WEBTOP-6674)

Date columns in a workflow report are sorted alphabetically and not by date. In addition, all columns
can be sorted only in the ascending order and not in the descending order.

The "Edit successful" message appears after an error
message indicates that the local copy of the file that is
checked out is not available (WEBTOP-6877)

If you check out a file, delete it on the local machine, and select the same file in Webtop and choose
the Edit option to edit the file, an error message is displayed. However, after you click OK, the
message bar in Webtop displays the "Edit successful" message.
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An additional error message is displayed when you try
to check out a file that you have already checked out
on a different machine (WEBTOP-6878, WEBTOP-5965)

If you check out a file that is currently checked out on another machine, Webtop prompts you to
continue the checkout operation with a read only copy of the file or to abort the operation. When you
choose to abort the checkout operation, an additional error message is displayed.

JAWS is unable to read the identifiers of some tabs
while creating new objects (WEBTOP-3726)

Identifiers of the Create, Info, or Permissions tabs are missing. Therefore, JAWS is unable to read the
tab identifiers when you access the tabs while creating new objects.

An error occurs when you add a child document to a
subscribed virtual document in the Virtual Document
Manager (WEBTOP-4826)

An error occurs when you open a virtual document from the Subscriptions node, and add a child
document to it in the Virtual Document Manager.

The descendant XML file is not checked out into the
Checkout folder when the XML virtual document is
checked out (WEBTOP-5896)

If you add a descendant document to a parent XML virtual document separately in Webtop, and then
check out the parent virtual document with all its descendants, the descendant file you added to the
parent XML document is not checked out into the Checkout folder. In addition, the descendant file is
lost after the parent virtual document is checked in to Webtop.

An error occurs when a keyword in a document is
edited simultaneously (WDK-566)

The following warning message is displayed when multiple users edit the same document
simultaneously, and save the document: "Another user may have modified the properties since you
viewed them. OK to overwrite?" If you click Yes, the document is overwritten.
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Changes made in a parent XML file are lost and
versioning fails when only the root file is checked in
(WEBTOP-5903)

When you check out an XML file that contains multiple descendant files by selecting the Root only
option, and then check in the parent file back into Webtop, the parent file is not versioned. In addition,
although the file is physically removed from the local folder, all changes made to the XML file are lost.

Performance is impacted when you sort a folder
containing a large volume of subfolders and files and
non-standard display columns (WEBTOP-5942)

If a folder contains many subfolders and files (for example, 24000 objects), and it also contains
additional non-standard display columns, (for example, "Lifecycle" and "Lifecycle State" columns),
sorting the folder contents based on the "Lifecycle" or "Lifecycle State" column, slows the performance.

Webtop application is vulnerable to SQL injection
attack (WEBTOP-2666, WEBTOP-5951)

The Webtop application is vulnerable to blind SQL injection attacks.

Custom attribute values are truncated when they are
saved if the values contain the single quotation mark (’)
character (WEBTOP-6002)

When you create a custom type document with a property that contains the single quotation mark
(’) character in its value, and you save the document, the value of the custom attribute is truncated
when you view the properties of the document.

When multiple files are checked in by selecting
the "None" format, only the last file is checked in
(WEBTOP-6027)

When you check in multiple files into Webtop using the None format, only the last file is checked in,
while the remaining files remain checked out.
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An error occurs when you view search results from
federated multiple repositories (WEBTOP-6077)

An error occurs while viewing search results from federated multiple repositories. Webtop continues
to function erratically after you close the error message and refresh the Webtop browser window.

Unable to drag and drop files from the local machine
into Webtop (WDK-1585, WEBTOP-6088, WDK-1799)

When you drag and drop files containing a comma in their names from the local machine into
Webtop, an error occurs.

Lotus Notes and DocumentumWebtop stop responding
when a document is dragged and dropped from Webtop
into Lotus Notes (WEBTOP-6091)

When you drag and drop a document from Documentum Webtop to Lotus Notes, Webtop and
Lotus Notes stop responding.

Unable to import a document by dragging and dropping
it into Webtop if the document name contains a
semicolon (WEBTOP-6140)

If you import a document whose file name contains a semicolon into Webtop using the drag and drop
feature, a JavaScript error occurs and the import operation fails.

Unable to import multiple msg files as a specific
custom type (163339, 164694, 164964/WEBTOP-6184,
WEBTOP-6767)

If import_component.xml is configured to import only a specific custom_type of msg files, import of
multiple msg files of the specified custom_type fails. Only one file is successfully imported as the
specified custom_type of file, and the other files remain as dm_email_message type.
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Unable to view a checked in document in the Read Only
mode (WEBTOP-6252)

When you view a document that you checked out and checked in to Webtop, the document is not
opened in the Read Only mode. Instead, a separate Webtop login page is opened and the View
window stops responding. If you close the View window and the new Webtop login page and then
view the document again, the currently open Webtop window is refreshed.

Junk characters are displayed in emcmf files imported
as Hebrew or Arabic msg files and converted to emcmf
format (WEBTOP-6490)

If you import a .msg file containing 2-byte characters such as messages in the Hebrew or Arabic
language, and view the emcmf file, junk characters are displayed in place of the Hebrew or Arabic
characters.

An error occurs when you click a column
containing repeating integers to sort the results list
(157920/WDK-1587)

An error occurs when you click a column containing repeating integers to sort the results based on
the selected column.

An exception occurs while downloading files from
Webtop and DAM (WDK-1592)

The ClassCastException occurs if you download files from Documentum Asset Manager (DAM)
when Accelerated Caching Services (ACS) and Branch Office Caching Services (BOCS) are disabled.

UCF error occurs when you log in to Webtop with
SSO while the resident UCF invoker is enabled
(WEBTOP-6397)

When you log in to Webtop in the eTrust Siteminder Single Sign-on (SSO) environment where the
resident UCF invoker is enabled, the "Failed to connect to server" UCF error occurs.
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Dragging and dropping a file from Webtop into an
application copies a zero-byte file (WEBTOP-5940,
WDK-1617, WDK-1780)

When you drag and drop a file from the Webtop application into a message in MS Outlook or any
application, a zero-byte file is transferred.

Importing an email message fails for Arabic regional
setting (170760/WEBTOP-2496)

If you run Webtop on Windows 2008/Vista with [Arabic-AR] as a regional setting at operating system
level, the EMCMF (dm_message_archive) import fails with NullPointerException.

If two different users select an attribute that has a value
list on the Advanced Search page, the second user gets
an exception (168811/WEBTOP-1224)

If two different users select an attribute that has a value list on the Advanced Search page, an error
occurs for the second user. This error occurs if you have applied a hot fix for Bugs/Feature Requests
160047, 160041, 160761. If you have not applied the hot fix, then the second user will not encounter
this error.

Importing a .msg file with a different object name
and a different subject name results in the subject
name becomes the object name after import
(160296/WEBTOP-4835, WEBTOP-7074)

When you enable messageArchive-support, and import a .msg file with a different object name and a
different subject name results in the subject name change to the object name after import.

Import of an XML document using the DCTM Tech Pubs
XML application fails (DC-55)

If Webtop prompts you to provide the path to missing graphics associated with the source XML
document you are importing as a chunk_type of file associated with the DCTM TechPubs XML
application, an exception occurs and the XML document fails to be imported although you provide
the path to the graphics and click Continue.

52 EMC Documentum Webtop Version 6.5 SP3 Release Notes



Fixed Problems

Sorting fails when search results are sorted based on a
new column that is added after the search operation is
performed (WEBTOP-4457)

After performing a search operation that returns results, which span several pages, if you add a new
column using the Column Preferences option in the Search Results page, and sort the results based
on the new column, the results are arranged randomly and not alphabetically.

Presets scoped to a folder are not applied to its
subfolders (WDK-1599, WDK-1788)

Presets scoped to a folder are not applied to its subfolders.

The left panel is not refreshed when folders are moved
across the left and right panels or within the left panel
(WEBTOP-4696)

When a folder that is displayed in the right and left panels is dragged and dropped across panels or
within the left panel, the left panel is not refreshed.

For example, when a folder is dragged from the right panel and dropped in the left panel, the folder
is not displayed at the new location in the left panel, but it continues to be listed at the old location in
the left panel. However, since the right panel is refreshed, the folder is not displayed in the right
(source) panel. Further, if a folder is dragged from the left panel and dropped at another location in
the right panel, the folder continues to be displayed in the left panel, while it is also displayed at the
new location in the right panel. In addition, if a folder is dragged from the left panel and dropped in
another folder in the same panel, while the folder continues to be displayed at the source location in
the left panel, it is not displayed at the destination location in the left panel.

Drag and drop of files from or to the My Files node is
not supported (WEBTOP-2026, WEBTOP-7298)

Webtop users are not allowed to drag and drop files from or to theMy Files node.
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Items selected in the list view are not unselected when
you click outside the list view interface (WEBTOP-4945)

If you select multiple items in the list view of the Webtop interface by holding down the Shift or
Control key and click outside the list view, the items selected in the list view are not unselected
automatically.

Users are allowed to perform the right-click
operation in the browser tree of the Webtop interface
(WEBTOP-6057)

Webtop users are allowed to perform the right-click operation in the browser tree of the Webtop
interface, and select the required options.

WebLogic: XML files lose reference to external entities
(132735/DC-1228, DC-2064)

Some XML entities are lost when the import, export, view, or checkout operation is performed on a
WebLogic application server. The dtd file is available but the xml file is missing the references to
external entities. For example, in the following text "100&ndash;200" the entity &ndash; is lost and
the text becomes "100200".

UCF open threads can lead to server crash (115127/
WEBTOP-4597, WEBTOP-7100, 133197/DC-1229,
DC-2062, DC-2063)

UCF has open threads on the application server until the user session times out. These open threads
consume memory and can exceed the application server VM maximum thread count, causing the
server to hang or crash.

No restore button on preferences page (138410)

The preferences UI is missing the Restore to defaults button.
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Name of new group added to calendar event attendees
list replaces existing groups (138470)

When an event is created in the calendar with group1 as attendees, and this event is edited to add
group2 to the Attendee list, group2 replaces group1 (and all other groups) instead of getting added
to the list.

Unable to remove users from calendar event attendee
list (138472)

Once an event is created in a calendar with users or groups as the attendees, they cannot be removed
while editing.

Changing the items-per-page setting can turn off
pagination (139122)

If you run a full-text search, the change the number of items displayed per page, then edit and re-run
the search, you cannot page through the results. Pagination is turned off.

Data table number field rejects some content (139179)

In a data table number field, you are unable to save non-numeric characters, such as punctuation
used in currency values, phone numbers, and zip codes. The following error occurs: invokeMethod()
failed while calling: on Ok Failed to save object : [DM_VALIDATION_E_FORMAT]error: "value
must conform to format: {0}."

Start with another preset on wrong tab (139411)

The selection Start with another preset is on the Setup tab of the presets editor, but it should be on
the Rules tab, because only the rules from another preset can be copied, not the scopes. When the
user selects another preset, they will need to select a different scope. If they select the same scope, the
preset is not allowed because it would override the previous preset.

Need to click twice to add files for import (139591)

The import file selector window requires one click to activate the add files applet, and another click
for the Add Files button.
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The Save To Repository option is not available
when right clicking on an external search result
(139781/WEBTOP-170, 134651)

The "Save To Repository" option is not available when right clicking on an external search result.
The option is still available in the File menu.

When secondary link to a calendar event is deleted,
prompt to delete the link only or the event and all links
is not displayed (141185)

When you delete a link to a calendar event, the following prompt appears: "All recurrences and
exceptions of event event_name will be deleted. Are you sure you want to delete this event?" If
you click OK, the primary event and its secondary links are deleted. There is no way to delete the
secondary link only.

Member picker displays 0000000000000000 if row
saved with no member chosen (141416)

Member picker displays a row of zeros (0000000000000000) if the row is saved with no member
chosen. In that case the row should be empty.

Object ID is labeled as r_object_id (142516,
142771/CS-8111, CS-10070)

The label for object IDs is not picked up from the data dictionary on the properties page. The ID
should be labeled "Object ID" but instead is labeled "r_object_id".

Custom attributes not displayed in search results
unless configured as visible (143408)

By design, if loadinvisibleattributes is set to true in the basic search component definition, all columns
in the configuration will be queried so that a user can display them by adding visible columns in the
search results UI. However, custom attributes listed in the search definition are not queried unless
their visibility is set to true. This applies to search results for both basic and advanced search.

Workaround: Set the visibility of all custom attributes in the basic search definition to true.
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Create Room role is not enough to copy room with local
groups (143686)

A room member in the Create Room role but without CREATE GROUP privilege can copy and
paste a room, but an error appears and the room is created without local groups and contents. The
workaround is to give such a member CREATE GROUP privilege.

Member displays as ID instead of name after editing
member field in data table (143761)

In a data table with a members field that is edited so that the "Show only" option selected, in entries
with members not included in the "Show only" list, those members display as IDs, not display names
(for example, "1101939c80000154" instead of "cinadmin").

Disabled links do not display as disabled (145229)

The link control does not have a disabledcssclass attribute, so disabled links do not appear different
from enabled links.

Creating a note causes error unless application server
is restarted after installing DCE DocApp (149678)

If the application server has not been restarted after installing the version 6 SP1 DCE DocApp,
creating a new note results in a Java NoSuchMethod error. After restarting the application server, you
can create a note successfully.

Creating a note in a room or creating a room with a
banner graphic results in an error (149769)

When the ACL model is set to inherit from folder (not the default setting), and the 5.3 DCE DocApp is
installed with a D6 SP1 application server and D6 SP1 Content Server (the default configuration for a
repository before you install the D6 DCE DocApp), you can neither create a note in a room nor create
a room with a banner graphic. Installing the D6 DCE DocApp resolves this problem.
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After changing the entry node in Webtop, the browser
tree displays a strange node (159616)

After changing the entry node in Webtop from homecabinet_classic to cabinets in the
dam_browsertree_component.xml in the custom folder, within the Home Cabinet, the browser tree
displays the parent folder. The browser tree does not display the child folder under the parent folder.
This appears only within the Home Cabinet.

Help page does not get displayed for Properties page
(159710)

There is no help page associated with the Repeating attributes component (for example, Properties
page).

Help page is not working in the export contents to CSV
(160091)

Help page does not get displayed as there is no help context for export to CSV.

Search operation on a full text enabled repository fails
when the full name of the document to be searched is
not entered for the search criteria (160675)

The search result does not display the document if you don’t enter the full name of the document on a
full text enabled repository.

Changes made to the option for the Section to start
in to Webtop Preferences, redirects to the same page
as before after re logging (161369/WEBTOP-5547,
WEBTOP-6995)

When you change the option for the Section to start in, the changes made to Webtop Preferences
does not reflect after you log on to Webtop again.
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Export operation of folder containing EMCMF format
file with : fails (161370)

When you export a folder that contains EMCMF format file with ’:’ fails.

Parsing an email message body that contains rich
text content with embedded images throws an error
(161420)

An error is thrown when parsing an email message body that contains rich text content with
embedded images instead of successful parsing of the message body.

When you add to the clipboard and copy an EMCMF
format file to a different location or same location
fails but does not fail if the EMCMF format file has an
attachment then that attachment folder gets copied
(161507)

For dm_message_archive object type, in order to copy a message with the same message_id, you
need to drop the unique constraint on dm_message_archive object type. The following is the DQL
to get the constraint Name:
SELECT name FROM dmi_index WHERE index_type IN
(select r_object_id from dm_type WHERE name = 'dm_message_archive')
AND is_unique=1 AND attr_count=3;

Without dropping the constraint, if you try to perform a copy operation on dm_message_archive
object type, the operation displays an error. If dm_message_archive object type has an attachment
folder, then the attachment folder gets copied and cannot be rolled back.

Data loss while canceling the Save As operation
(163107)

When you perform canceling the Save As operation, it results in data loss.

Workaround: Perform the local save, and then Documentum->Save As operation.

Unable to attach a lifecycle to an EMCMF file (163753)

The life cycle that is attached to a .msg file during an import operation does not reflect in the EMCMF
file.
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Workaround: You can attach a lifecycle to the dm_message_archive object is to import a msg file,
open the properties page and then apply the lifecycle to the EMCMF file.

Error while importing an email message with .jpeg,
.bmp and .pdf attachments (163853)

When you import an email message with .jpeg, .bmp, and .pdf attachments results in a java heap
space error.

Webtop displays Cabinet contents when you try to view
EMCMF file format in thumbnail view (164357)

Log on to Webtop that uses a repository configured with thumbnail and MTS/ADTS. When you try to
view the EMCMF format by clicking the EMCMF object icon or through file-view, Webtop displays
Cabinet contents instead of opening the EMCMF file.

Unable to create a document of dm_message_archive
type (164381)

Webtop does not support creating an object of type dm_message_archive. If you create an object of
type dm_message_archive, the object gets created once but this object may not have the required
information and hence this object will not be usable.

Trying to delete an EMCMF format file which contains
an attachment that in turn contains an attachment pops
up an error (164492)

Log on to Webtop in Archive mode. If you try to delete an EMCMF file that contains an attachment
and that attachment has an attachment throws an error.

Drag and Drop of EMCMF file to .msg format fails
(164652)

Log on to Webtop and enable Drag and Drop in Preferences from Tools. When you drag and drop an
EMCMF file from Webtop to Desktop, Webtop throws an error "Failed to retrieve file”. With the new
Email Xtender executable (ExMRE.exe), Drag and Drop fails in Webtop.
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The ucf session wait timeout occurs when you perform
a second request for viewing content using a DRL or
Web-link (164691/WEBTOP-6322)

Log on to Webtop and create a Web-link or DRL to a document. Ensure that you close all browser
windows, and kill all javaw.exe to make sure that you have a clean start. Click on the Web-link, and
log on to Webtop and click View. Close the viewer application and click on the Web-link again and
a new browser window will open. The browser hangs with a blank screen, and then you see a
ucf session wait timeout message.

Unable to open the attachment in a folder attached to
a Task (165474)

Webtop does not allow you to open an attachment if the folder to which the attachment belongs is
attached to a task in the Inbox.

In Web Workflow Manager, clicking Help on
the Select Alias Set Dialog results in an error
(132064/WEBTOP-2090)

In Web Workflow Manager, clicking theHelp button on the Select Alias Set Dialog results in an error.

Unable to change the checkout location preference in
Webtop (171066/WEBTOP-2538)

In Webtop General Preferences page (Tools > Preferences > General tab), you have an option to
change the checkout location directory (where all the checked out files gets stored) on your local
machine. When you change the checkout location directory name, the new directory name does
not get updated.

Workaround: If you want to have a different checkout location on your local machine, please
navigate to <USER_HOME>\Documentum\ucf\<Machine Name>\shared\config\ucf.client.config.xml
(for example, C:\Documents and Settings\user1\Documentum\ucf\machine1\shared\config\ucf.
client.config.xml). Then, change the value of checkout.dir option to the new directory name.

You must restart the browser and the UCF client runtime (javaw.exe) on your local machine.

You can change the value as shown:

From
<option name="checkout.dir">
<value>C:\Documentum\Checkout</value>
</option>
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To
<option name="checkout.dir">
<value>New directory name</value>
</option>

Documentum menu continues to appear after
uninstalling Documentum Application Connectors
(169961/DAC-266, DAC-497)

Although Documentum Application Connectors is uninstalled, the Documentummenu continues to
appear in Microsoft Word.

The scope location configuration defined as a preset
for the new folder is not used while creating a folder
(DAC-488)

The scope location configuration for the new folder component defined in the
webtop/custom/config/newfolder_component.xml file does not work in the Application Connector.
When a user creates a folder using the Open or Save as option in the Application Connectormenu,
the scope location configuration that is defined as a preset in the newfolder_component.xml file, is
not used to create the folder.

Backward Compatibility of Documentum Application
Connectors (159474)

The Documentum Application Connectors 6.5 is compatible only with Webtop 6, 6.0 SP1, and 6.5.
You have to point to Webtop 6, 6.0 SP1, and 6.5 for DAC 6.5 MS Outlook to work during installation.

Unable to install Documentum Application Connectors
(DAC) using msiexec command (165024)

Using msiexec /i "Documentum-AppConnectors-Client.exe" /q ALLUSER=1 command throws ’This
installation package could not be opened. Contact the application vendor to verify that this is a valid
Windows Installer package’

Workaround: Install DAC using the following command:

Documentum-Appconnectors-Client-5.3.exe /s /v"qn WEBTOPURL=http://10.31.105.26:8080/webtop"
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Do you want to overwrite the already existing files
dialog appears while viewing the EMCMF format
message from the repository for the second time
(165102/DAC-368)

When you try to open an EMCMF format message for the second time, ’Do you want to overwrite the
already existing files’ dialog box appears instead of opening the mail.

Fixed limitations specific to version 6
The following limitation specific to version 6 have been fixed.

Cookie error on switching between 5.3.x and version 6
applications (136509)

When the browser connects to both 5.3.x and version 6 WDK-based applications with the same alias
on the same host, a cookie error is displayed and some JavaScript is cached that can interfere with
proper behavior. The cookie error is similar to the following:
java.lang.IllegalArgumentException: Cookie name "$17" is a reserved token
javax.servlet.http.Cookie.<init>(Cookie.java:140)

Workaround: Use two different aliases, for example, webtop and webtop2, or run one
application on a different port. If you must use the same alias, delete the Documentum cookie
(username@WDK_hostname) and clear the browser JavaScript cache. The cookie is named for the
user and the WDK application host, for example, alyosius@127.0.0[1].txt.

Insufficient memory allocation errors (144882)

With an allocation of 512 MB RAM on Tomcat, and a test of 50 users for 2.5 days, the application
server crashes with an out of memory error.

Workaround: Use the Documentum System Sizing Guide to calculate system requirements.

WebSphere: Forms cannot be created or edited
(145067)

Forms cannot be displayed by an application on WebSphere. One of the following pop-up errors is
displayed:
invokeMethod() failed while calling: onNext
Class org/w3c/dom/document violates loader constraints
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java.lang.VerifyError:
com/documentum/tools/xforms/ResourceUtility.converKeyValuePairsToDOM(
Ljava/util/Map;)Lorg/w3c/dom/Document;

Workaround: Perform the following steps.
1. Download the file Hotfix_for_bug_145067.zip on the Forms Builder download site and extract

the files..

2. Extract the archive Bug145067_HotFix_Docapp.zip and use DAI 5.3 SP5.5 to install it to the
global repository.

3. Place XFormsCommon.jar into WEB-INF/lib under the application root directory, overwriting
the existing jar file.

4. Solaris only: Remove xml-apis.jar and xmlrpc-1.2-b1.jar from the Webtop or Records Manager
WAR file. These jar files are located in WEB-INF/lib under the application root directory.
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Chapter 4
Environment and System
Requirements

This chapter lists the hardware (machine) requirements and software versions supported with this
release. Machine resources, non-Documentum software components (Operating System, Java
Runtime Environment, and so forth), and other EMC Documentum products determine the unique
environment for each EMC Documentum product. Hardware requirements, page 65, addresses basic
machine resource requirements. Software requirements, page 66, addresses specific software versions
that are required for the installation platform.

Webtop operates on a browser client and on a web application server. When the supported
environments for the browser client and web application server are the same, they can be on the same
machine. Otherwise, they need to be on different machines.

Documentum Application Connectors (DAC) operates on a client machine and Microsoft Office
support that accesses a WDK application running on a web application server.

Hardware requirements
This section lists nominal machine resources required for product installation and use. Your
individual machine requirements vary depending on factors such as the number of products
installed, size of your deployment, number of users, and network latency. The Documentum System
Sizing Tool dynamically generates estimates of your hardware resource requirements based on your
user and hardware profile.

You can download the Documentum System Sizing Tool from the Powerlink website
(http://powerlink.emc.com) by navigating to: Home > Support > Technical Documentation and
Advisories > Software ~ D ~ Documentation > Documentum System > Systems Sizing.

Browser machine requirements

For WDK-based client applications, you need a client machine capable of running the supported
software configurations listed in Browser environment, page 67, plus whatever disk space, RAM, or
CPU requirements that may be specified by third-party products such as Microsoft Office.
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WDK-based client applications may install applets and a JRE on the client machine. This requires
approximately 100 MB of free hard disk space. Additionally, you need sufficient free disk space
to handle checked-out and cached documents.

Web application server machine requirements

The Table 1, page 66 provides nominal resource requirements for Webtop on a web application
server machine. Webtop on an application server machine is used by both the Webtop client and the
Documentum Application Connectors clients.

Table 1. Web application server machine requirements

Hard disk space [1] RAM [2] CPU

Minimum:

600 MB for one application

1 GB for two applications

Recommended:

800 MB for one application

1.2 GB for two applications

2 GB 800 Mhz (minimum), 1 GHz or
greater (recommended)

Note: The following specific notes apply to the web application server machine requirements table:

[1] You must also have sufficient free disk space to handle temporary content transfer files, which
can vary substantially from one enterprise to another.
[2] The amount of RAM that is available after taking into consideration all other RAM utilization
requirements.

Software requirements
This section provides information on supported software environments.

The tables in this section reflect the latest versions of third-party products, upon which the EMC
Documentum product depends, that are supported at the time of this release. EMC Documentum
recommends that you upgrade third-party products to the version listed for this release. If you
cannot upgrade your third-party products to the version listed for this release, EMC Documentum
continues to support all third-party product versions supported for EMC Documentum product
versions 6.x and 5.3x, with the following caveats:
• the third-party product is not of the same or earlier version than those versions listed in Table
2, page 67

• the third-party product version is still supported by the third-party vendor

• the third-party product version is forward compatible with the version supported in this release.
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For information on currently supported environments and future updates, refer to the Product
Information System on the Powerlink website: http://powerlink.emc.com.

Table 2. Third-party product versions not supported in this release

Product Category Third-party product Version

Windows 2000 SP2 Update Rollup 1

Mac OS X 10.2.8, 10.3.9

Solaris 8

AIX 5.2

HP-UX HP-UX 11

Operating System

Red Hat Enterprise Linux 3.x

Oracle 9i 9.2.0.8, 10.1.0.5

SQL Server 2000 SP4Database

DB2 UDB 8.1 FixPak 14, 8.2 FixPak 7

BEA WebLogic Server 8.1 SP6

Tomcat 5.0.28

IBM WebSphere AS 5.1.1.13, 6.0.2.17
Application Server

Oracle AS 10g 9.0.4.3, 10.1.2

Mozilla 1.7.13

Netscape 7.2Browser

Safari 1.3.2

Sun JRE 1.4.2_13

Microsoft JVM 5.0.0.3810JRE (Client)

Apple Java 1.3.1 Release 2

Java (Server) Java 1.4.x

BEA WebLogic Portal 8.1 SP6
Portal Server

IBM WebSphere Portal 5.1.0.4

Browser environment

Users access Webtop through web browsers. The software environment consists of a specific
combination of operating system, browser, and JRE. The browser environment table for Webtop
(Table 3, page 68) lists the JRE version in only those cells for a supported operating system/browser
configuration.

Note: Users access Documentum Application Connectors through Microsoft Office applications but
do require the supported browser and JRE listed in the following table.
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Table 3. Browser environment for Webtop

Browser & Java Plug-In for Webtop

Oper-
ating
Sys-
tem

Pro-
cessor

IE6
for
Win-
dows
XP
SP3
(6.00.
2900.
3311)

IE6
SP2
for
Win-
dows
Server
2003
SP1
(6.00.
3790.
3959)

IE7
for
Win-
dows
XP,
Win-
dows
Server
2003
(7.00.
5730.
1300)

IE7
for
Win-
dows
Vista
SP1
(7.00.
6001.
1800)

IE7
for
Win-
dows
Server
2008
(7.00.
6001.
1800)

IE8
for
Win-
dows
XP,
Win-
dows
Vista
(8.00.
6001.
18702)

IE8
for
Win-
dows
Server
2003
(8.00.
6001.
18702)

IE8
for
Win-
dows
Server
2008
(8.00.
6001.
18702)

IE8
for
Win-
dows
7

Fire-
fox
2.0.
0.20
[1]

Fire-
fox
3.0.
11,
3.5.5
[1]

Sa-
fari
2.0.4
[1]

Sa-
fari
3.2.3
[1]

Sa-
fari
4.0.3
[1]

Win-
dows
XP SP3
(32-bit
ver-
sion)

IA-32,
x64

Sun
JRE
1.4.
2_19

Sun
JRE
1.4.
2_19

Sun
JRE
1.4.
2_19

Sun
JRE
1.4.
2_19

Sun
JRE
1.4.
2_19

Sun
JRE
1.4.
2_19

Sun
JRE
1.4.
2_19

Win-
dows
XP SP3
(32-bit
ver-
sion)

IA-32,
x64

Sun
JRE
5.0
Up-
date
22

Sun
JRE
5.0
Up-
date
22

Sun
JRE
5.0
Up-
date
22

Sun
JRE
5.0
Up-
date
22

Sun
JRE
5.0
Up-
date
22

Sun
JRE
5.0
Up-
date
22

Sun
JRE
5.0
Up-
date
22
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Browser & Java Plug-In for Webtop

Oper-
ating
Sys-
tem

Pro-
cessor

IE6
for
Win-
dows
XP
SP3
(6.00.
2900.
3311)

IE6
SP2
for
Win-
dows
Server
2003
SP1
(6.00.
3790.
3959)

IE7
for
Win-
dows
XP,
Win-
dows
Server
2003
(7.00.
5730.
1300)

IE7
for
Win-
dows
Vista
SP1
(7.00.
6001.
1800)

IE7
for
Win-
dows
Server
2008
(7.00.
6001.
1800)

IE8
for
Win-
dows
XP,
Win-
dows
Vista
(8.00.
6001.
18702)

IE8
for
Win-
dows
Server
2003
(8.00.
6001.
18702)

IE8
for
Win-
dows
Server
2008
(8.00.
6001.
18702)

IE8
for
Win-
dows
7

Fire-
fox
2.0.
0.20
[1]

Fire-
fox
3.0.
11,
3.5.5
[1]

Sa-
fari
2.0.4
[1]

Sa-
fari
3.2.3
[1]

Sa-
fari
4.0.3
[1]

Win-
dows
XP SP3
(32-bit
ver-
sion)

IA-32,
x64

Sun
JRE
6.0
Up-
date
17

Sun
JRE
6.0
Up-
date
17

Sun
JRE
6.0
Up-
date
17

Sun
JRE
6.0
Up-
date
17

Sun
JRE
6.0
Up-
date
17

Sun
JRE
6.0
Up-
date
17

Sun
JRE
6.0
Up-
date
17

Win-
dows
Vista
SP2
(32-bit
ver-
sion)

IA-32,
x64

Sun
JRE
1.4.
2_19

Sun
JRE
1.4.
2_19

Sun
JRE
1.4.
2_19

Sun
JRE
1.4.
2_19

Sun
JRE
1.4.
2_19

Sun
JRE
1.4.
2_19
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Browser & Java Plug-In for Webtop

Oper-
ating
Sys-
tem

Pro-
cessor

IE6
for
Win-
dows
XP
SP3
(6.00.
2900.
3311)

IE6
SP2
for
Win-
dows
Server
2003
SP1
(6.00.
3790.
3959)

IE7
for
Win-
dows
XP,
Win-
dows
Server
2003
(7.00.
5730.
1300)

IE7
for
Win-
dows
Vista
SP1
(7.00.
6001.
1800)

IE7
for
Win-
dows
Server
2008
(7.00.
6001.
1800)

IE8
for
Win-
dows
XP,
Win-
dows
Vista
(8.00.
6001.
18702)

IE8
for
Win-
dows
Server
2003
(8.00.
6001.
18702)

IE8
for
Win-
dows
Server
2008
(8.00.
6001.
18702)

IE8
for
Win-
dows
7

Fire-
fox
2.0.
0.20
[1]

Fire-
fox
3.0.
11,
3.5.5
[1]

Sa-
fari
2.0.4
[1]

Sa-
fari
3.2.3
[1]

Sa-
fari
4.0.3
[1]

Win-
dows
Vista
SP2
(32-bit
ver-
sion)

IA-32,
x64

Sun
JRE
5.0
Up-
date
22

Sun
JRE
5.0
Up-
date
22

Sun
JRE
5.0
Up-
date
22

Sun
JRE
5.0
Up-
date
22

Sun
JRE
5.0
Up-
date
22

Sun
JRE
5.0
Up-
date
22

Win-
dows
Vista
SP2
(32-bit
ver-
sion)

IA-32,
x64

Sun
JRE
6.0
Up-
date
17

Sun
JRE
6.0
Up-
date
17

Sun
JRE
6.0
Up-
date
17

Sun
JRE
6.0
Up-
date
17

Sun
JRE
6.0
Up-
date
17

Sun
JRE
6.0
Up-
date
17
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Browser & Java Plug-In for Webtop

Oper-
ating
Sys-
tem

Pro-
cessor

IE6
for
Win-
dows
XP
SP3
(6.00.
2900.
3311)

IE6
SP2
for
Win-
dows
Server
2003
SP1
(6.00.
3790.
3959)

IE7
for
Win-
dows
XP,
Win-
dows
Server
2003
(7.00.
5730.
1300)

IE7
for
Win-
dows
Vista
SP1
(7.00.
6001.
1800)

IE7
for
Win-
dows
Server
2008
(7.00.
6001.
1800)

IE8
for
Win-
dows
XP,
Win-
dows
Vista
(8.00.
6001.
18702)

IE8
for
Win-
dows
Server
2003
(8.00.
6001.
18702)

IE8
for
Win-
dows
Server
2008
(8.00.
6001.
18702)

IE8
for
Win-
dows
7

Fire-
fox
2.0.
0.20
[1]

Fire-
fox
3.0.
11,
3.5.5
[1]

Sa-
fari
2.0.4
[1]

Sa-
fari
3.2.3
[1]

Sa-
fari
4.0.3
[1]

Win-
dows 7
(32-bit
ver-
sion)

IA-32,
x64

Sun
JRE
5.0
Up-
date
22

Sun
JRE
5.0
Up-
date
22

Sun
JRE
5.0
Up-
date
22

Sun
JRE
5.0
Up-
date
22

Sun
JRE
5.0
Up-
date
22

Sun
JRE
5.0
Up-
date
22

Sun
JRE
5.0
Up-
date
22

Win-
dows 7
(32-bit
ver-
sion)

IA-32,
x64

Sun
JRE
6.0
Up-
date
17

Sun
JRE
6.0
Up-
date
17

Sun
JRE
6.0
Up-
date
17

Sun
JRE
6.0
Up-
date
17

Sun
JRE
6.0
Up-
date
17

Sun
JRE
6.0
Up-
date
17

Sun
JRE
6.0
Up-
date
17
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Browser & Java Plug-In for Webtop

Oper-
ating
Sys-
tem

Pro-
cessor

IE6
for
Win-
dows
XP
SP3
(6.00.
2900.
3311)

IE6
SP2
for
Win-
dows
Server
2003
SP1
(6.00.
3790.
3959)

IE7
for
Win-
dows
XP,
Win-
dows
Server
2003
(7.00.
5730.
1300)

IE7
for
Win-
dows
Vista
SP1
(7.00.
6001.
1800)

IE7
for
Win-
dows
Server
2008
(7.00.
6001.
1800)

IE8
for
Win-
dows
XP,
Win-
dows
Vista
(8.00.
6001.
18702)

IE8
for
Win-
dows
Server
2003
(8.00.
6001.
18702)

IE8
for
Win-
dows
Server
2008
(8.00.
6001.
18702)

IE8
for
Win-
dows
7

Fire-
fox
2.0.
0.20
[1]

Fire-
fox
3.0.
11,
3.5.5
[1]

Sa-
fari
2.0.4
[1]

Sa-
fari
3.2.3
[1]

Sa-
fari
4.0.3
[1]

Win-
dows
Server
2003
R2
with
SP2
(32-bit
ver-
sion)

IA-32,
x64

Sun
JRE
1.4.
2_19

Sun
JRE
1.4.
2_19

Sun
JRE
1.4.
2_19

Sun
JRE
1.4.
2_19

Sun
JRE
1.4.
2_19

Sun
JRE
1.4.
2_19

Sun
JRE
1.4.
2_19
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Browser & Java Plug-In for Webtop

Oper-
ating
Sys-
tem

Pro-
cessor

IE6
for
Win-
dows
XP
SP3
(6.00.
2900.
3311)

IE6
SP2
for
Win-
dows
Server
2003
SP1
(6.00.
3790.
3959)

IE7
for
Win-
dows
XP,
Win-
dows
Server
2003
(7.00.
5730.
1300)

IE7
for
Win-
dows
Vista
SP1
(7.00.
6001.
1800)

IE7
for
Win-
dows
Server
2008
(7.00.
6001.
1800)

IE8
for
Win-
dows
XP,
Win-
dows
Vista
(8.00.
6001.
18702)

IE8
for
Win-
dows
Server
2003
(8.00.
6001.
18702)

IE8
for
Win-
dows
Server
2008
(8.00.
6001.
18702)

IE8
for
Win-
dows
7

Fire-
fox
2.0.
0.20
[1]

Fire-
fox
3.0.
11,
3.5.5
[1]

Sa-
fari
2.0.4
[1]

Sa-
fari
3.2.3
[1]

Sa-
fari
4.0.3
[1]

Win-
dows
Server
2003
R2
with
SP2
(32-bit
ver-
sion)

IA-32,
x64

Sun
JRE
5.0
Up-
date
22

Sun
JRE
5.0
Up-
date
22

Sun
JRE
5.0
Up-
date
22

Sun
JRE
5.0
Up-
date
22

Sun
JRE
5.0
Up-
date
22

Sun
JRE
5.0
Up-
date
22

Sun
JRE
5.0
Up-
date
22
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Browser & Java Plug-In for Webtop

Oper-
ating
Sys-
tem

Pro-
cessor

IE6
for
Win-
dows
XP
SP3
(6.00.
2900.
3311)

IE6
SP2
for
Win-
dows
Server
2003
SP1
(6.00.
3790.
3959)

IE7
for
Win-
dows
XP,
Win-
dows
Server
2003
(7.00.
5730.
1300)

IE7
for
Win-
dows
Vista
SP1
(7.00.
6001.
1800)

IE7
for
Win-
dows
Server
2008
(7.00.
6001.
1800)

IE8
for
Win-
dows
XP,
Win-
dows
Vista
(8.00.
6001.
18702)

IE8
for
Win-
dows
Server
2003
(8.00.
6001.
18702)

IE8
for
Win-
dows
Server
2008
(8.00.
6001.
18702)

IE8
for
Win-
dows
7

Fire-
fox
2.0.
0.20
[1]

Fire-
fox
3.0.
11,
3.5.5
[1]

Sa-
fari
2.0.4
[1]

Sa-
fari
3.2.3
[1]

Sa-
fari
4.0.3
[1]

Win-
dows
Server
2003
R2
with
SP2
(32-bit
ver-
sion)

IA-32,
x64

Sun
JRE
6.0
Up-
date
17

Sun
JRE
6.0
Up-
date
17

Sun
JRE
6.0
Up-
date
17

Sun
JRE
6.0
Up-
date
17

Sun
JRE
6.0
Up-
date
17

Sun
JRE
6.0
Up-
date
17

Sun
JRE
6.0
Up-
date
17
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Browser & Java Plug-In for Webtop

Oper-
ating
Sys-
tem

Pro-
cessor

IE6
for
Win-
dows
XP
SP3
(6.00.
2900.
3311)

IE6
SP2
for
Win-
dows
Server
2003
SP1
(6.00.
3790.
3959)

IE7
for
Win-
dows
XP,
Win-
dows
Server
2003
(7.00.
5730.
1300)

IE7
for
Win-
dows
Vista
SP1
(7.00.
6001.
1800)

IE7
for
Win-
dows
Server
2008
(7.00.
6001.
1800)

IE8
for
Win-
dows
XP,
Win-
dows
Vista
(8.00.
6001.
18702)

IE8
for
Win-
dows
Server
2003
(8.00.
6001.
18702)

IE8
for
Win-
dows
Server
2008
(8.00.
6001.
18702)

IE8
for
Win-
dows
7

Fire-
fox
2.0.
0.20
[1]

Fire-
fox
3.0.
11,
3.5.5
[1]

Sa-
fari
2.0.4
[1]

Sa-
fari
3.2.3
[1]

Sa-
fari
4.0.3
[1]

Win-
dows
Server
2003
SP2
(32-bit
ver-
sion)

IA-32,
x64

Sun
JRE
1.4.
2_19

Sun
JRE
1.4.
2_19

Sun
JRE
1.4.
2_19

Sun
JRE
1.4.
2_19

Sun
JRE
1.4.
2_19

Sun
JRE
1.4.
2_19

Sun
JRE
1.4.
2_19

Win-
dows
Server
2003
SP2
(32-bit
ver-
sion)

IA-32,
x64

Sun
JRE
5.0
Up-
date
22

Sun
JRE
5.0
Up-
date
22

Sun
JRE
5.0
Up-
date
22

Sun
JRE
5.0
Up-
date
22

Sun
JRE
5.0
Up-
date
22

Sun
JRE
5.0
Up-
date
22

Sun
JRE
5.0
Up-
date
22
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Browser & Java Plug-In for Webtop

Oper-
ating
Sys-
tem

Pro-
cessor

IE6
for
Win-
dows
XP
SP3
(6.00.
2900.
3311)

IE6
SP2
for
Win-
dows
Server
2003
SP1
(6.00.
3790.
3959)

IE7
for
Win-
dows
XP,
Win-
dows
Server
2003
(7.00.
5730.
1300)

IE7
for
Win-
dows
Vista
SP1
(7.00.
6001.
1800)

IE7
for
Win-
dows
Server
2008
(7.00.
6001.
1800)

IE8
for
Win-
dows
XP,
Win-
dows
Vista
(8.00.
6001.
18702)

IE8
for
Win-
dows
Server
2003
(8.00.
6001.
18702)

IE8
for
Win-
dows
Server
2008
(8.00.
6001.
18702)

IE8
for
Win-
dows
7

Fire-
fox
2.0.
0.20
[1]

Fire-
fox
3.0.
11,
3.5.5
[1]

Sa-
fari
2.0.4
[1]

Sa-
fari
3.2.3
[1]

Sa-
fari
4.0.3
[1]

Win-
dows
Server
2003
SP2
(32-bit
ver-
sion)

IA-32,
x64

Sun
JRE
6.0
Up-
date
17

Sun
JRE
6.0
Up-
date
17

Sun
JRE
6.0
Up-
date
17

Sun
JRE
6.0
Up-
date
17

Sun
JRE
6.0
Up-
date
17

Sun
JRE
6.0
Up-
date
17

Sun
JRE
6.0
Up-
date
17

Win-
dows
Server
2008
R2 (32-
bit ver-
sion)

IA-32,
x64

Sun
JRE
5.0
Up-
date
22

Sun
JRE
5.0
Up-
date
22

Sun
JRE
5.0
Up-
date
22

Sun
JRE
5.0
Up-
date
22

Sun
JRE
5.0
Up-
date
22

Sun
JRE
5.0
Up-
date
22
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Browser & Java Plug-In for Webtop

Oper-
ating
Sys-
tem

Pro-
cessor

IE6
for
Win-
dows
XP
SP3
(6.00.
2900.
3311)

IE6
SP2
for
Win-
dows
Server
2003
SP1
(6.00.
3790.
3959)

IE7
for
Win-
dows
XP,
Win-
dows
Server
2003
(7.00.
5730.
1300)

IE7
for
Win-
dows
Vista
SP1
(7.00.
6001.
1800)

IE7
for
Win-
dows
Server
2008
(7.00.
6001.
1800)

IE8
for
Win-
dows
XP,
Win-
dows
Vista
(8.00.
6001.
18702)

IE8
for
Win-
dows
Server
2003
(8.00.
6001.
18702)

IE8
for
Win-
dows
Server
2008
(8.00.
6001.
18702)

IE8
for
Win-
dows
7

Fire-
fox
2.0.
0.20
[1]

Fire-
fox
3.0.
11,
3.5.5
[1]

Sa-
fari
2.0.4
[1]

Sa-
fari
3.2.3
[1]

Sa-
fari
4.0.3
[1]

Win-
dows
Server
2008
R2 (32-
bit ver-
sion)

IA-32,
x64

Sun
JRE
6.0
Up-
date
17

Sun
JRE
6.0
Up-
date
17

Sun
JRE
6.0
Up-
date
17

Sun
JRE
6.0
Up-
date
17

Sun
JRE
6.0
Up-
date
17

Sun
JRE
6.0
Up-
date
17

Mac
OS X
10.4.11

Pow-
erPC,
IA-32,
x64

Java
for
Mac
OS X
10.4
Re-
lease
9 (1.4.
2_21)

Java
for
Mac
OS X
10.4
Re-
lease
9
(1.4.
2_21)

Java
for
Mac
OS X
10.4
Re-
lease
9
(1.4.
2_21)

Java
for
Mac
OS X
10.4
Re-
lease
9 (1.4.
2_21)
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Browser & Java Plug-In for Webtop

Oper-
ating
Sys-
tem

Pro-
cessor

IE6
for
Win-
dows
XP
SP3
(6.00.
2900.
3311)

IE6
SP2
for
Win-
dows
Server
2003
SP1
(6.00.
3790.
3959)

IE7
for
Win-
dows
XP,
Win-
dows
Server
2003
(7.00.
5730.
1300)

IE7
for
Win-
dows
Vista
SP1
(7.00.
6001.
1800)

IE7
for
Win-
dows
Server
2008
(7.00.
6001.
1800)

IE8
for
Win-
dows
XP,
Win-
dows
Vista
(8.00.
6001.
18702)

IE8
for
Win-
dows
Server
2003
(8.00.
6001.
18702)

IE8
for
Win-
dows
Server
2008
(8.00.
6001.
18702)

IE8
for
Win-
dows
7

Fire-
fox
2.0.
0.20
[1]

Fire-
fox
3.0.
11,
3.5.5
[1]

Sa-
fari
2.0.4
[1]

Sa-
fari
3.2.3
[1]

Sa-
fari
4.0.3
[1]

Mac
OS X
10.4.11

Pow-
erPC,
IA-32,
x64

Java
for
Mac
OS X
10.4
Re-
lease
9 (1.5.
0_19)

Java
for
Mac
OS X
10.4
Re-
lease
9
(1.5.
0_19)

Java
for
Mac
OS X
10.4
Re-
lease
9
(1.5.
0_19)

Java
for
Mac
OS X
10.4
Re-
lease
9 (1.5.
0_19)
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Browser & Java Plug-In for Webtop

Oper-
ating
Sys-
tem

Pro-
cessor

IE6
for
Win-
dows
XP
SP3
(6.00.
2900.
3311)

IE6
SP2
for
Win-
dows
Server
2003
SP1
(6.00.
3790.
3959)

IE7
for
Win-
dows
XP,
Win-
dows
Server
2003
(7.00.
5730.
1300)

IE7
for
Win-
dows
Vista
SP1
(7.00.
6001.
1800)

IE7
for
Win-
dows
Server
2008
(7.00.
6001.
1800)

IE8
for
Win-
dows
XP,
Win-
dows
Vista
(8.00.
6001.
18702)

IE8
for
Win-
dows
Server
2003
(8.00.
6001.
18702)

IE8
for
Win-
dows
Server
2008
(8.00.
6001.
18702)

IE8
for
Win-
dows
7

Fire-
fox
2.0.
0.20
[1]

Fire-
fox
3.0.
11,
3.5.5
[1]

Sa-
fari
2.0.4
[1]

Sa-
fari
3.2.3
[1]

Sa-
fari
4.0.3
[1]

Mac
OS X
10.5.8
Up-
date
v1.1

Pow-
erPC,
IA-32,
x64

Java
for
Mac
OS X
10.5
Up-
date
5 (1.4.
2_22)

Java
for
Mac
OS X
10.5
Up-
date
5
(1.4.
2_22)

Java
for
Mac
OS X
10.5
Up-
date
5 (1.4.
2_22)
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Browser & Java Plug-In for Webtop

Oper-
ating
Sys-
tem

Pro-
cessor

IE6
for
Win-
dows
XP
SP3
(6.00.
2900.
3311)

IE6
SP2
for
Win-
dows
Server
2003
SP1
(6.00.
3790.
3959)

IE7
for
Win-
dows
XP,
Win-
dows
Server
2003
(7.00.
5730.
1300)

IE7
for
Win-
dows
Vista
SP1
(7.00.
6001.
1800)

IE7
for
Win-
dows
Server
2008
(7.00.
6001.
1800)

IE8
for
Win-
dows
XP,
Win-
dows
Vista
(8.00.
6001.
18702)

IE8
for
Win-
dows
Server
2003
(8.00.
6001.
18702)

IE8
for
Win-
dows
Server
2008
(8.00.
6001.
18702)

IE8
for
Win-
dows
7

Fire-
fox
2.0.
0.20
[1]

Fire-
fox
3.0.
11,
3.5.5
[1]

Sa-
fari
2.0.4
[1]

Sa-
fari
3.2.3
[1]

Sa-
fari
4.0.3
[1]

Mac
OS X
10.5.8
Up-
date
v1.1

Pow-
erPC,
IA-32,
x64

Java
for
Mac
OS X
10.5
Up-
date
5 (1.5.
0_20)

Java
for
Mac
OS X
10.5
Up-
date
5
(1.5.
0_20)

Java
for
Mac
OS X
10.5
Up-
date
5 (1.5.
0_20)

Java
for
Mac
OS X
10.5
Up-
date
5 (1.5.
0_20)
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Browser & Java Plug-In for Webtop

Oper-
ating
Sys-
tem

Pro-
cessor

IE6
for
Win-
dows
XP
SP3
(6.00.
2900.
3311)

IE6
SP2
for
Win-
dows
Server
2003
SP1
(6.00.
3790.
3959)

IE7
for
Win-
dows
XP,
Win-
dows
Server
2003
(7.00.
5730.
1300)

IE7
for
Win-
dows
Vista
SP1
(7.00.
6001.
1800)

IE7
for
Win-
dows
Server
2008
(7.00.
6001.
1800)

IE8
for
Win-
dows
XP,
Win-
dows
Vista
(8.00.
6001.
18702)

IE8
for
Win-
dows
Server
2003
(8.00.
6001.
18702)

IE8
for
Win-
dows
Server
2008
(8.00.
6001.
18702)

IE8
for
Win-
dows
7

Fire-
fox
2.0.
0.20
[1]

Fire-
fox
3.0.
11,
3.5.5
[1]

Sa-
fari
2.0.4
[1]

Sa-
fari
3.2.3
[1]

Sa-
fari
4.0.3
[1]

Mac
OS X
10.5.8
Up-
date
v1.1

x64

Java
for
Mac
OS X
10.5
Up-
date
5 (1.6.
0_15)

Java
for
Mac
OS X
10.5
Up-
date
5
(1.6.
0_15)

Java
for
Mac
OS X
10.5
Up-
date
5 (1.6.
0_15)

Java
for
Mac
OS X
10.5
Up-
date
5 (1.6.
0_15)
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Browser & Java Plug-In for Webtop

Oper-
ating
Sys-
tem

Pro-
cessor

IE6
for
Win-
dows
XP
SP3
(6.00.
2900.
3311)

IE6
SP2
for
Win-
dows
Server
2003
SP1
(6.00.
3790.
3959)

IE7
for
Win-
dows
XP,
Win-
dows
Server
2003
(7.00.
5730.
1300)

IE7
for
Win-
dows
Vista
SP1
(7.00.
6001.
1800)

IE7
for
Win-
dows
Server
2008
(7.00.
6001.
1800)

IE8
for
Win-
dows
XP,
Win-
dows
Vista
(8.00.
6001.
18702)

IE8
for
Win-
dows
Server
2003
(8.00.
6001.
18702)

IE8
for
Win-
dows
Server
2008
(8.00.
6001.
18702)

IE8
for
Win-
dows
7

Fire-
fox
2.0.
0.20
[1]

Fire-
fox
3.0.
11,
3.5.5
[1]

Sa-
fari
2.0.4
[1]

Sa-
fari
3.2.3
[1]

Sa-
fari
4.0.3
[1]

Mac
OS X
10.6.1

Pow-
erPC,
IA-32,
x64

Java
for
Mac
OS X
10.5
Up-
date
5 (1.4.
2_22)

Java
for
Mac
OS X
10.5
Up-
date
5
(1.4.
2_22)

82 EMC Documentum Webtop Version 6.5 SP3 Release Notes
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Browser & Java Plug-In for Webtop

Oper-
ating
Sys-
tem

Pro-
cessor

IE6
for
Win-
dows
XP
SP3
(6.00.
2900.
3311)

IE6
SP2
for
Win-
dows
Server
2003
SP1
(6.00.
3790.
3959)

IE7
for
Win-
dows
XP,
Win-
dows
Server
2003
(7.00.
5730.
1300)

IE7
for
Win-
dows
Vista
SP1
(7.00.
6001.
1800)

IE7
for
Win-
dows
Server
2008
(7.00.
6001.
1800)

IE8
for
Win-
dows
XP,
Win-
dows
Vista
(8.00.
6001.
18702)

IE8
for
Win-
dows
Server
2003
(8.00.
6001.
18702)

IE8
for
Win-
dows
Server
2008
(8.00.
6001.
18702)

IE8
for
Win-
dows
7

Fire-
fox
2.0.
0.20
[1]

Fire-
fox
3.0.
11,
3.5.5
[1]

Sa-
fari
2.0.4
[1]

Sa-
fari
3.2.3
[1]

Sa-
fari
4.0.3
[1]

Mac
OS X
10.6.1

Pow-
erPC,
IA-32,
x64

Java
for
Mac
OS X
10.5
Up-
date
5 (1.5.
0_20)

Java
for
Mac
OS X
10.5
Up-
date
5
(1.5.
0_20)

Java
for
Mac
OS X
10.5
Up-
date
5 (1.5.
0_20)
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Browser & Java Plug-In for Webtop

Oper-
ating
Sys-
tem

Pro-
cessor

IE6
for
Win-
dows
XP
SP3
(6.00.
2900.
3311)

IE6
SP2
for
Win-
dows
Server
2003
SP1
(6.00.
3790.
3959)

IE7
for
Win-
dows
XP,
Win-
dows
Server
2003
(7.00.
5730.
1300)

IE7
for
Win-
dows
Vista
SP1
(7.00.
6001.
1800)

IE7
for
Win-
dows
Server
2008
(7.00.
6001.
1800)

IE8
for
Win-
dows
XP,
Win-
dows
Vista
(8.00.
6001.
18702)

IE8
for
Win-
dows
Server
2003
(8.00.
6001.
18702)

IE8
for
Win-
dows
Server
2008
(8.00.
6001.
18702)

IE8
for
Win-
dows
7

Fire-
fox
2.0.
0.20
[1]

Fire-
fox
3.0.
11,
3.5.5
[1]

Sa-
fari
2.0.4
[1]

Sa-
fari
3.2.3
[1]

Sa-
fari
4.0.3
[1]

Mac
OS X
10.6.1

x64

Java
for
Mac
OS X
10.5
Up-
date
5 (1.6.
0_15)

Java
for
Mac
OS X
10.5
Up-
date
5
(1.6.
0_15)

Java
for
Mac
OS X
10.5
Up-
date
5 (1.6.
0_15)

Solaris
10

Ultra-
SPARC

Sun
JRE
1.4.
2_19

Sun
JRE
1.4.
2_19
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Browser & Java Plug-In for Webtop

Oper-
ating
Sys-
tem

Pro-
cessor

IE6
for
Win-
dows
XP
SP3
(6.00.
2900.
3311)

IE6
SP2
for
Win-
dows
Server
2003
SP1
(6.00.
3790.
3959)

IE7
for
Win-
dows
XP,
Win-
dows
Server
2003
(7.00.
5730.
1300)

IE7
for
Win-
dows
Vista
SP1
(7.00.
6001.
1800)

IE7
for
Win-
dows
Server
2008
(7.00.
6001.
1800)

IE8
for
Win-
dows
XP,
Win-
dows
Vista
(8.00.
6001.
18702)

IE8
for
Win-
dows
Server
2003
(8.00.
6001.
18702)

IE8
for
Win-
dows
Server
2008
(8.00.
6001.
18702)

IE8
for
Win-
dows
7

Fire-
fox
2.0.
0.20
[1]

Fire-
fox
3.0.
11,
3.5.5
[1]

Sa-
fari
2.0.4
[1]

Sa-
fari
3.2.3
[1]

Sa-
fari
4.0.3
[1]

Solaris
10

Ultra-
SPARC

Sun
JRE
5.0
Up-
date
22

Sun
JRE
5.0
Up-
date
22

Solaris
10

Ultra-
SPARC

Sun
JRE
6.0
Up-
date
17

Sun
JRE
6.0
Up-
date
17

RHEL
4.8

IA-32,
x64

Sun
JRE
1.4.
2_19

Sun
JRE
1.4.
2_19
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Browser & Java Plug-In for Webtop

Oper-
ating
Sys-
tem

Pro-
cessor

IE6
for
Win-
dows
XP
SP3
(6.00.
2900.
3311)

IE6
SP2
for
Win-
dows
Server
2003
SP1
(6.00.
3790.
3959)

IE7
for
Win-
dows
XP,
Win-
dows
Server
2003
(7.00.
5730.
1300)

IE7
for
Win-
dows
Vista
SP1
(7.00.
6001.
1800)

IE7
for
Win-
dows
Server
2008
(7.00.
6001.
1800)

IE8
for
Win-
dows
XP,
Win-
dows
Vista
(8.00.
6001.
18702)

IE8
for
Win-
dows
Server
2003
(8.00.
6001.
18702)

IE8
for
Win-
dows
Server
2008
(8.00.
6001.
18702)

IE8
for
Win-
dows
7

Fire-
fox
2.0.
0.20
[1]

Fire-
fox
3.0.
11,
3.5.5
[1]

Sa-
fari
2.0.4
[1]

Sa-
fari
3.2.3
[1]

Sa-
fari
4.0.3
[1]

RHEL
4.8

IA-32,
x64

Sun
JRE
5.0
Up-
date
22

Sun
JRE
5.0
Up-
date
22

RHEL
4.8

IA-32,
x64

Sun
JRE
6.0
Up-
date
17

Sun
JRE
6.0
Up-
date
17

RHEL
5.4

IA-32,
x64

Sun
JRE
1.4.
2_19

Sun
JRE
1.4.
2_19
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Browser & Java Plug-In for Webtop

Oper-
ating
Sys-
tem

Pro-
cessor

IE6
for
Win-
dows
XP
SP3
(6.00.
2900.
3311)

IE6
SP2
for
Win-
dows
Server
2003
SP1
(6.00.
3790.
3959)

IE7
for
Win-
dows
XP,
Win-
dows
Server
2003
(7.00.
5730.
1300)

IE7
for
Win-
dows
Vista
SP1
(7.00.
6001.
1800)

IE7
for
Win-
dows
Server
2008
(7.00.
6001.
1800)

IE8
for
Win-
dows
XP,
Win-
dows
Vista
(8.00.
6001.
18702)

IE8
for
Win-
dows
Server
2003
(8.00.
6001.
18702)

IE8
for
Win-
dows
Server
2008
(8.00.
6001.
18702)

IE8
for
Win-
dows
7

Fire-
fox
2.0.
0.20
[1]

Fire-
fox
3.0.
11,
3.5.5
[1]

Sa-
fari
2.0.4
[1]

Sa-
fari
3.2.3
[1]

Sa-
fari
4.0.3
[1]

RHEL
5.4

IA-32,
x64

Sun
JRE
5.0
Up-
date
22

Sun
JRE
5.0
Up-
date
22

RHEL
5.4

IA-32,
x64

Sun
JRE
6.0
Up-
date
17

Sun
JRE
6.0
Up-
date
17
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Browser & Java Plug-In for Webtop

Oper-
ating
Sys-
tem

Pro-
cessor

IE6
for
Win-
dows
XP
SP3
(6.00.
2900.
3311)

IE6
SP2
for
Win-
dows
Server
2003
SP1
(6.00.
3790.
3959)

IE7
for
Win-
dows
XP,
Win-
dows
Server
2003
(7.00.
5730.
1300)

IE7
for
Win-
dows
Vista
SP1
(7.00.
6001.
1800)

IE7
for
Win-
dows
Server
2008
(7.00.
6001.
1800)

IE8
for
Win-
dows
XP,
Win-
dows
Vista
(8.00.
6001.
18702)

IE8
for
Win-
dows
Server
2003
(8.00.
6001.
18702)

IE8
for
Win-
dows
Server
2008
(8.00.
6001.
18702)

IE8
for
Win-
dows
7

Fire-
fox
2.0.
0.20
[1]

Fire-
fox
3.0.
11,
3.5.5
[1]

Sa-
fari
2.0.4
[1]

Sa-
fari
3.2.3
[1]

Sa-
fari
4.0.3
[1]

SUSE
Linux
Enter-
prise
Desk-
top 10
SP3

IA-32,
x64

Sun
JRE
1.4.
2_19

Sun
JRE
1.4.
2_19

SUSE
Linux
Enter-
prise
Desk-
top 10
SP3

IA-32,
x64

Sun
JRE
5.0
Up-
date
22

Sun
JRE
5.0
Up-
date
22
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Browser & Java Plug-In for Webtop

Oper-
ating
Sys-
tem

Pro-
cessor

IE6
for
Win-
dows
XP
SP3
(6.00.
2900.
3311)

IE6
SP2
for
Win-
dows
Server
2003
SP1
(6.00.
3790.
3959)

IE7
for
Win-
dows
XP,
Win-
dows
Server
2003
(7.00.
5730.
1300)

IE7
for
Win-
dows
Vista
SP1
(7.00.
6001.
1800)

IE7
for
Win-
dows
Server
2008
(7.00.
6001.
1800)

IE8
for
Win-
dows
XP,
Win-
dows
Vista
(8.00.
6001.
18702)

IE8
for
Win-
dows
Server
2003
(8.00.
6001.
18702)

IE8
for
Win-
dows
Server
2008
(8.00.
6001.
18702)

IE8
for
Win-
dows
7

Fire-
fox
2.0.
0.20
[1]

Fire-
fox
3.0.
11,
3.5.5
[1]

Sa-
fari
2.0.4
[1]

Sa-
fari
3.2.3
[1]

Sa-
fari
4.0.3
[1]

SUSE
Linux
Enter-
prise
Desk-
top 10
SP3

IA-32,
x64

Sun
JRE
6.0
Up-
date
17

Sun
JRE
6.0
Up-
date
17

SUSE
Linux
Enter-
prise
Desk-
top 11

IA-32,
x64

Sun
JRE
5.0
Up-
date
22

Sun
JRE
5.0
Up-
date
22
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Browser & Java Plug-In for Webtop

Oper-
ating
Sys-
tem

Pro-
cessor

IE6
for
Win-
dows
XP
SP3
(6.00.
2900.
3311)

IE6
SP2
for
Win-
dows
Server
2003
SP1
(6.00.
3790.
3959)

IE7
for
Win-
dows
XP,
Win-
dows
Server
2003
(7.00.
5730.
1300)

IE7
for
Win-
dows
Vista
SP1
(7.00.
6001.
1800)

IE7
for
Win-
dows
Server
2008
(7.00.
6001.
1800)

IE8
for
Win-
dows
XP,
Win-
dows
Vista
(8.00.
6001.
18702)

IE8
for
Win-
dows
Server
2003
(8.00.
6001.
18702)

IE8
for
Win-
dows
Server
2008
(8.00.
6001.
18702)

IE8
for
Win-
dows
7

Fire-
fox
2.0.
0.20
[1]

Fire-
fox
3.0.
11,
3.5.5
[1]

Sa-
fari
2.0.4
[1]

Sa-
fari
3.2.3
[1]

Sa-
fari
4.0.3
[1]

SUSE
Linux
Enter-
prise
Desk-
top 11

IA-32,
x64

Sun
JRE
6.0
Up-
date
17

Sun
JRE
6.0
Up-
date
17

SUSE
Linux
Enter-
prise
Server
10 SP3

IA-32,
x64

Sun
JRE
1.4.
2_19

Sun
JRE
1.4.
2_19
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Browser & Java Plug-In for Webtop

Oper-
ating
Sys-
tem

Pro-
cessor

IE6
for
Win-
dows
XP
SP3
(6.00.
2900.
3311)

IE6
SP2
for
Win-
dows
Server
2003
SP1
(6.00.
3790.
3959)

IE7
for
Win-
dows
XP,
Win-
dows
Server
2003
(7.00.
5730.
1300)

IE7
for
Win-
dows
Vista
SP1
(7.00.
6001.
1800)

IE7
for
Win-
dows
Server
2008
(7.00.
6001.
1800)

IE8
for
Win-
dows
XP,
Win-
dows
Vista
(8.00.
6001.
18702)

IE8
for
Win-
dows
Server
2003
(8.00.
6001.
18702)

IE8
for
Win-
dows
Server
2008
(8.00.
6001.
18702)

IE8
for
Win-
dows
7

Fire-
fox
2.0.
0.20
[1]

Fire-
fox
3.0.
11,
3.5.5
[1]

Sa-
fari
2.0.4
[1]

Sa-
fari
3.2.3
[1]

Sa-
fari
4.0.3
[1]

SUSE
Linux
Enter-
prise
Server
10 SP3

IA-32,
x64

Sun
JRE
5.0
Up-
date
22

Sun
JRE
5.0
Up-
date
22

SUSE
Linux
Enter-
prise
Server
10 SP3

IA-32,
x64

Sun
JRE
6.0
Up-
date
17

Sun
JRE
6.0
Up-
date
17
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Browser & Java Plug-In for Webtop

Oper-
ating
Sys-
tem

Pro-
cessor

IE6
for
Win-
dows
XP
SP3
(6.00.
2900.
3311)

IE6
SP2
for
Win-
dows
Server
2003
SP1
(6.00.
3790.
3959)

IE7
for
Win-
dows
XP,
Win-
dows
Server
2003
(7.00.
5730.
1300)

IE7
for
Win-
dows
Vista
SP1
(7.00.
6001.
1800)

IE7
for
Win-
dows
Server
2008
(7.00.
6001.
1800)

IE8
for
Win-
dows
XP,
Win-
dows
Vista
(8.00.
6001.
18702)

IE8
for
Win-
dows
Server
2003
(8.00.
6001.
18702)

IE8
for
Win-
dows
Server
2008
(8.00.
6001.
18702)

IE8
for
Win-
dows
7

Fire-
fox
2.0.
0.20
[1]

Fire-
fox
3.0.
11,
3.5.5
[1]

Sa-
fari
2.0.4
[1]

Sa-
fari
3.2.3
[1]

Sa-
fari
4.0.3
[1]

SUSE
Linux
Enter-
prise
Server
11

IA-32,
x64

Sun
JRE
5.0
Up-
date
22

Sun
JRE
5.0
Up-
date
22

SUSE
Linux
Enter-
prise
Server
11

IA-32,
x64

Sun
JRE
6.0
Up-
date
17

Sun
JRE
6.0
Up-
date
17
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Environment and System Requirements

The browser environment table for Documentum Application Connectors (Table 4, page 94) lists the
JRE version in only those cells for a supported operating system/browser configuration.

Note: Users access Documentum Application Connectors through Microsoft Office applications but
do require the supported browser and JRE listed in the following table.
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Environment and System Requirements

Table 4. Browser environment for Documentum Application Connectors

Browser & Java Plug-In for Documentum Application Connectors

Oper-
ating
Sys-
tem

Pro-
cessor

IE6
for
Win-
dows
XP
SP3
(6.00.
2900.
3311)

IE6
SP2
for
Win-
dows
Server
2003
SP1
(6.00.
3790.
3959)

IE7
for
Win-
dows
XP,
Win-
dows
Server
2003
(7.00.
5730.
1300)

IE7
for
Win-
dows
Vista
SP1
(7.00.
6001.
1800)

IE7
for
Win-
dows
Server
2008
(7.00.
6001.
1800)

IE8
for
Win-
dows
XP,
Win-
dows
Vista
(8.00.
6001.
18702)

IE8
for
Win-
dows
Server
2003
(8.00.
6001.
18702)

IE8
for
Win-
dows
Server
2008
(8.00.
6001.
18702)

IE8
for
Win-
dows
7

Fire-
fox
2.0.
0.20
[1]

Fire-
fox
3.0.
11,
3.5.5
[1]

Sa-
fari
2.0.4
[1]

Sa-
fari
3.2.3
[1]

Sa-
fari
4.0.3
[1]

Win-
dows
XP SP3
(32-bit
ver-
sion)

IA-32,
x64

Sun
JRE
1.4.
2_19

Sun
JRE
1.4.
2_19

Sun
JRE
1.4.
2_19

Sun
JRE
1.4.
2_19

Sun
JRE
1.4.
2_19

Sun
JRE
1.4.
2_19

Sun
JRE
1.4.
2_19

Win-
dows
XP SP3
(32-bit
ver-
sion)

IA-32,
x64

Sun
JRE
5.0
Up-
date
22

Sun
JRE
5.0
Up-
date
22

Sun
JRE
5.0
Up-
date
22

Sun
JRE
5.0
Up-
date
22

Sun
JRE
5.0
Up-
date
22

Sun
JRE
5.0
Up-
date
22

Sun
JRE
5.0
Up-
date
22
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Browser & Java Plug-In for Documentum Application Connectors

Oper-
ating
Sys-
tem

Pro-
cessor

IE6
for
Win-
dows
XP
SP3
(6.00.
2900.
3311)

IE6
SP2
for
Win-
dows
Server
2003
SP1
(6.00.
3790.
3959)

IE7
for
Win-
dows
XP,
Win-
dows
Server
2003
(7.00.
5730.
1300)

IE7
for
Win-
dows
Vista
SP1
(7.00.
6001.
1800)

IE7
for
Win-
dows
Server
2008
(7.00.
6001.
1800)

IE8
for
Win-
dows
XP,
Win-
dows
Vista
(8.00.
6001.
18702)

IE8
for
Win-
dows
Server
2003
(8.00.
6001.
18702)

IE8
for
Win-
dows
Server
2008
(8.00.
6001.
18702)

IE8
for
Win-
dows
7

Fire-
fox
2.0.
0.20
[1]

Fire-
fox
3.0.
11,
3.5.5
[1]

Sa-
fari
2.0.4
[1]

Sa-
fari
3.2.3
[1]

Sa-
fari
4.0.3
[1]

Win-
dows
XP SP3
(32-bit
ver-
sion)

IA-32,
x64

Sun
JRE
6.0
Up-
date
17

Sun
JRE
6.0
Up-
date
17

Sun
JRE
6.0
Up-
date
17

Sun
JRE
6.0
Up-
date
17

Sun
JRE
6.0
Up-
date
17

Sun
JRE
6.0
Up-
date
17

Sun
JRE
6.0
Up-
date
17

Win-
dows
Vista
SP2
(32-bit
ver-
sion)

IA-32,
x64

Sun
JRE
1.4.
2_19

Sun
JRE
1.4.
2_19

Sun
JRE
1.4.
2_19

Sun
JRE
1.4.
2_19

Sun
JRE
1.4.
2_19

Sun
JRE
1.4.
2_19
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Environment and System Requirements

Browser & Java Plug-In for Documentum Application Connectors

Oper-
ating
Sys-
tem

Pro-
cessor

IE6
for
Win-
dows
XP
SP3
(6.00.
2900.
3311)

IE6
SP2
for
Win-
dows
Server
2003
SP1
(6.00.
3790.
3959)

IE7
for
Win-
dows
XP,
Win-
dows
Server
2003
(7.00.
5730.
1300)

IE7
for
Win-
dows
Vista
SP1
(7.00.
6001.
1800)

IE7
for
Win-
dows
Server
2008
(7.00.
6001.
1800)

IE8
for
Win-
dows
XP,
Win-
dows
Vista
(8.00.
6001.
18702)

IE8
for
Win-
dows
Server
2003
(8.00.
6001.
18702)

IE8
for
Win-
dows
Server
2008
(8.00.
6001.
18702)

IE8
for
Win-
dows
7

Fire-
fox
2.0.
0.20
[1]

Fire-
fox
3.0.
11,
3.5.5
[1]

Sa-
fari
2.0.4
[1]

Sa-
fari
3.2.3
[1]

Sa-
fari
4.0.3
[1]

Win-
dows
Vista
SP2
(32-bit
ver-
sion)

IA-32,
x64

Sun
JRE
5.0
Up-
date
22

Sun
JRE
5.0
Up-
date
22

Sun
JRE
5.0
Up-
date
22

Sun
JRE
5.0
Up-
date
22

Sun
JRE
5.0
Up-
date
22

Sun
JRE
5.0
Up-
date
22

Win-
dows
Vista
SP2
(32-bit
ver-
sion)

IA-32,
x64

Sun
JRE
6.0
Up-
date
17

Sun
JRE
6.0
Up-
date
17

Sun
JRE
6.0
Up-
date
17

Sun
JRE
6.0
Up-
date
17

Sun
JRE
6.0
Up-
date
17

Sun
JRE
6.0
Up-
date
17
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Environment and System Requirements

Browser & Java Plug-In for Documentum Application Connectors

Oper-
ating
Sys-
tem

Pro-
cessor

IE6
for
Win-
dows
XP
SP3
(6.00.
2900.
3311)

IE6
SP2
for
Win-
dows
Server
2003
SP1
(6.00.
3790.
3959)

IE7
for
Win-
dows
XP,
Win-
dows
Server
2003
(7.00.
5730.
1300)

IE7
for
Win-
dows
Vista
SP1
(7.00.
6001.
1800)

IE7
for
Win-
dows
Server
2008
(7.00.
6001.
1800)

IE8
for
Win-
dows
XP,
Win-
dows
Vista
(8.00.
6001.
18702)

IE8
for
Win-
dows
Server
2003
(8.00.
6001.
18702)

IE8
for
Win-
dows
Server
2008
(8.00.
6001.
18702)

IE8
for
Win-
dows
7

Fire-
fox
2.0.
0.20
[1]

Fire-
fox
3.0.
11,
3.5.5
[1]

Sa-
fari
2.0.4
[1]

Sa-
fari
3.2.3
[1]

Sa-
fari
4.0.3
[1]

Win-
dows 7
(32-bit
ver-
sion)

IA-32,
x64

Sun
JRE
5.0
Up-
date
22

Sun
JRE
5.0
Up-
date
22

Sun
JRE
5.0
Up-
date
22

Sun
JRE
5.0
Up-
date
22

Sun
JRE
5.0
Up-
date
22

Sun
JRE
5.0
Up-
date
22

Sun
JRE
5.0
Up-
date
22

Win-
dows 7
(32-bit
ver-
sion)

IA-32,
x64

Sun
JRE
6.0
Up-
date
17

Sun
JRE
6.0
Up-
date
17

Sun
JRE
6.0
Up-
date
17

Sun
JRE
6.0
Up-
date
17

Sun
JRE
6.0
Up-
date
17

Sun
JRE
6.0
Up-
date
17

Sun
JRE
6.0
Up-
date
17
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Environment and System Requirements

Browser & Java Plug-In for Documentum Application Connectors

Oper-
ating
Sys-
tem

Pro-
cessor

IE6
for
Win-
dows
XP
SP3
(6.00.
2900.
3311)

IE6
SP2
for
Win-
dows
Server
2003
SP1
(6.00.
3790.
3959)

IE7
for
Win-
dows
XP,
Win-
dows
Server
2003
(7.00.
5730.
1300)

IE7
for
Win-
dows
Vista
SP1
(7.00.
6001.
1800)

IE7
for
Win-
dows
Server
2008
(7.00.
6001.
1800)

IE8
for
Win-
dows
XP,
Win-
dows
Vista
(8.00.
6001.
18702)

IE8
for
Win-
dows
Server
2003
(8.00.
6001.
18702)

IE8
for
Win-
dows
Server
2008
(8.00.
6001.
18702)

IE8
for
Win-
dows
7

Fire-
fox
2.0.
0.20
[1]

Fire-
fox
3.0.
11,
3.5.5
[1]

Sa-
fari
2.0.4
[1]

Sa-
fari
3.2.3
[1]

Sa-
fari
4.0.3
[1]

Win-
dows
Server
2003
R2
with
SP2
(32-bit
ver-
sion)

IA-32,
x64

Sun
JRE
1.4.
2_19

Sun
JRE
1.4.
2_19

Sun
JRE
1.4.
2_19

Sun
JRE
1.4.
2_19

Sun
JRE
1.4.
2_19

Sun
JRE
1.4.
2_19

Sun
JRE
1.4.
2_19
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Environment and System Requirements

Browser & Java Plug-In for Documentum Application Connectors

Oper-
ating
Sys-
tem

Pro-
cessor

IE6
for
Win-
dows
XP
SP3
(6.00.
2900.
3311)

IE6
SP2
for
Win-
dows
Server
2003
SP1
(6.00.
3790.
3959)

IE7
for
Win-
dows
XP,
Win-
dows
Server
2003
(7.00.
5730.
1300)

IE7
for
Win-
dows
Vista
SP1
(7.00.
6001.
1800)

IE7
for
Win-
dows
Server
2008
(7.00.
6001.
1800)

IE8
for
Win-
dows
XP,
Win-
dows
Vista
(8.00.
6001.
18702)

IE8
for
Win-
dows
Server
2003
(8.00.
6001.
18702)

IE8
for
Win-
dows
Server
2008
(8.00.
6001.
18702)

IE8
for
Win-
dows
7

Fire-
fox
2.0.
0.20
[1]

Fire-
fox
3.0.
11,
3.5.5
[1]

Sa-
fari
2.0.4
[1]

Sa-
fari
3.2.3
[1]

Sa-
fari
4.0.3
[1]

Win-
dows
Server
2003
R2
with
SP2
(32-bit
ver-
sion)

IA-32,
x64

Sun
JRE
5.0
Up-
date
22

Sun
JRE
5.0
Up-
date
22

Sun
JRE
5.0
Up-
date
22

Sun
JRE
5.0
Up-
date
22

Sun
JRE
5.0
Up-
date
22

Sun
JRE
5.0
Up-
date
22

Sun
JRE
5.0
Up-
date
22
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Environment and System Requirements

Browser & Java Plug-In for Documentum Application Connectors

Oper-
ating
Sys-
tem

Pro-
cessor

IE6
for
Win-
dows
XP
SP3
(6.00.
2900.
3311)

IE6
SP2
for
Win-
dows
Server
2003
SP1
(6.00.
3790.
3959)

IE7
for
Win-
dows
XP,
Win-
dows
Server
2003
(7.00.
5730.
1300)

IE7
for
Win-
dows
Vista
SP1
(7.00.
6001.
1800)

IE7
for
Win-
dows
Server
2008
(7.00.
6001.
1800)

IE8
for
Win-
dows
XP,
Win-
dows
Vista
(8.00.
6001.
18702)

IE8
for
Win-
dows
Server
2003
(8.00.
6001.
18702)

IE8
for
Win-
dows
Server
2008
(8.00.
6001.
18702)

IE8
for
Win-
dows
7

Fire-
fox
2.0.
0.20
[1]

Fire-
fox
3.0.
11,
3.5.5
[1]

Sa-
fari
2.0.4
[1]

Sa-
fari
3.2.3
[1]

Sa-
fari
4.0.3
[1]

Win-
dows
Server
2003
R2
with
SP2
(32-bit
ver-
sion)

IA-32,
x64

Sun
JRE
6.0
Up-
date
17

Sun
JRE
6.0
Up-
date
17

Sun
JRE
6.0
Up-
date
17

Sun
JRE
6.0
Up-
date
17

Sun
JRE
6.0
Up-
date
17

Sun
JRE
6.0
Up-
date
17

Sun
JRE
6.0
Up-
date
17
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Environment and System Requirements

Browser & Java Plug-In for Documentum Application Connectors

Oper-
ating
Sys-
tem

Pro-
cessor

IE6
for
Win-
dows
XP
SP3
(6.00.
2900.
3311)

IE6
SP2
for
Win-
dows
Server
2003
SP1
(6.00.
3790.
3959)

IE7
for
Win-
dows
XP,
Win-
dows
Server
2003
(7.00.
5730.
1300)

IE7
for
Win-
dows
Vista
SP1
(7.00.
6001.
1800)

IE7
for
Win-
dows
Server
2008
(7.00.
6001.
1800)

IE8
for
Win-
dows
XP,
Win-
dows
Vista
(8.00.
6001.
18702)

IE8
for
Win-
dows
Server
2003
(8.00.
6001.
18702)

IE8
for
Win-
dows
Server
2008
(8.00.
6001.
18702)

IE8
for
Win-
dows
7

Fire-
fox
2.0.
0.20
[1]

Fire-
fox
3.0.
11,
3.5.5
[1]

Sa-
fari
2.0.4
[1]

Sa-
fari
3.2.3
[1]

Sa-
fari
4.0.3
[1]

Win-
dows
Server
2003
SP2
(32-bit
ver-
sion)

IA-32,
x64

Sun
JRE
1.4.
2_19

Sun
JRE
1.4.
2_19

Sun
JRE
1.4.
2_19

Sun
JRE
1.4.
2_19

Sun
JRE
1.4.
2_19

Sun
JRE
1.4.
2_19

Sun
JRE
1.4.
2_19

Win-
dows
Server
2003
SP2
(32-bit
ver-
sion)

IA-32,
x64

Sun
JRE
5.0
Up-
date
22

Sun
JRE
5.0
Up-
date
22

Sun
JRE
5.0
Up-
date
22

Sun
JRE
5.0
Up-
date
22

Sun
JRE
5.0
Up-
date
22

Sun
JRE
5.0
Up-
date
22

Sun
JRE
5.0
Up-
date
22
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Environment and System Requirements

Browser & Java Plug-In for Documentum Application Connectors

Oper-
ating
Sys-
tem

Pro-
cessor

IE6
for
Win-
dows
XP
SP3
(6.00.
2900.
3311)

IE6
SP2
for
Win-
dows
Server
2003
SP1
(6.00.
3790.
3959)

IE7
for
Win-
dows
XP,
Win-
dows
Server
2003
(7.00.
5730.
1300)

IE7
for
Win-
dows
Vista
SP1
(7.00.
6001.
1800)

IE7
for
Win-
dows
Server
2008
(7.00.
6001.
1800)

IE8
for
Win-
dows
XP,
Win-
dows
Vista
(8.00.
6001.
18702)

IE8
for
Win-
dows
Server
2003
(8.00.
6001.
18702)

IE8
for
Win-
dows
Server
2008
(8.00.
6001.
18702)

IE8
for
Win-
dows
7

Fire-
fox
2.0.
0.20
[1]

Fire-
fox
3.0.
11,
3.5.5
[1]

Sa-
fari
2.0.4
[1]

Sa-
fari
3.2.3
[1]

Sa-
fari
4.0.3
[1]

Win-
dows
Server
2003
SP2
(32-bit
ver-
sion)

IA-32,
x64

Sun
JRE
6.0
Up-
date
17

Sun
JRE
6.0
Up-
date
17

Sun
JRE
6.0
Up-
date
17

Sun
JRE
6.0
Up-
date
17

Sun
JRE
6.0
Up-
date
17

Sun
JRE
6.0
Up-
date
17

Sun
JRE
6.0
Up-
date
17

Win-
dows
Server
2008
R2 (32-
bit ver-
sion)

IA-32,
x64

Sun
JRE
5.0
Up-
date
22

Sun
JRE
5.0
Up-
date
22

Sun
JRE
5.0
Up-
date
22

Sun
JRE
5.0
Up-
date
22

Sun
JRE
5.0
Up-
date
22

Sun
JRE
5.0
Up-
date
22
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Environment and System Requirements

Browser & Java Plug-In for Documentum Application Connectors

Oper-
ating
Sys-
tem

Pro-
cessor

IE6
for
Win-
dows
XP
SP3
(6.00.
2900.
3311)

IE6
SP2
for
Win-
dows
Server
2003
SP1
(6.00.
3790.
3959)

IE7
for
Win-
dows
XP,
Win-
dows
Server
2003
(7.00.
5730.
1300)

IE7
for
Win-
dows
Vista
SP1
(7.00.
6001.
1800)

IE7
for
Win-
dows
Server
2008
(7.00.
6001.
1800)

IE8
for
Win-
dows
XP,
Win-
dows
Vista
(8.00.
6001.
18702)

IE8
for
Win-
dows
Server
2003
(8.00.
6001.
18702)

IE8
for
Win-
dows
Server
2008
(8.00.
6001.
18702)

IE8
for
Win-
dows
7

Fire-
fox
2.0.
0.20
[1]

Fire-
fox
3.0.
11,
3.5.5
[1]

Sa-
fari
2.0.4
[1]

Sa-
fari
3.2.3
[1]

Sa-
fari
4.0.3
[1]

Win-
dows
Server
2008
R2 (32-
bit ver-
sion)

IA-32,
x64

Sun
JRE
6.0
Up-
date
17

Sun
JRE
6.0
Up-
date
17

Sun
JRE
6.0
Up-
date
17

Sun
JRE
6.0
Up-
date
17

Sun
JRE
6.0
Up-
date
17

Sun
JRE
6.0
Up-
date
17

Mac
OS X
10.4.11

Pow-
erPC,
IA-32,
x64

Java
for
Mac
OS X
10.4
Re-
lease
9 (1.4.
2_21)

Java
for
Mac
OS X
10.4
Re-
lease
9
(1.4.
2_21)

Java
for
Mac
OS X
10.4
Re-
lease
9
(1.4.
2_21)

Java
for
Mac
OS X
10.4
Re-
lease
9 (1.4.
2_21)
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Environment and System Requirements

Browser & Java Plug-In for Documentum Application Connectors

Oper-
ating
Sys-
tem

Pro-
cessor

IE6
for
Win-
dows
XP
SP3
(6.00.
2900.
3311)

IE6
SP2
for
Win-
dows
Server
2003
SP1
(6.00.
3790.
3959)

IE7
for
Win-
dows
XP,
Win-
dows
Server
2003
(7.00.
5730.
1300)

IE7
for
Win-
dows
Vista
SP1
(7.00.
6001.
1800)

IE7
for
Win-
dows
Server
2008
(7.00.
6001.
1800)

IE8
for
Win-
dows
XP,
Win-
dows
Vista
(8.00.
6001.
18702)

IE8
for
Win-
dows
Server
2003
(8.00.
6001.
18702)

IE8
for
Win-
dows
Server
2008
(8.00.
6001.
18702)

IE8
for
Win-
dows
7

Fire-
fox
2.0.
0.20
[1]

Fire-
fox
3.0.
11,
3.5.5
[1]

Sa-
fari
2.0.4
[1]

Sa-
fari
3.2.3
[1]

Sa-
fari
4.0.3
[1]

Mac
OS X
10.4.11

Pow-
erPC,
IA-32,
x64

Java
for
Mac
OS X
10.4
Re-
lease
9 (1.5.
0_19)

Java
for
Mac
OS X
10.4
Re-
lease
9
(1.5.
0_19)

Java
for
Mac
OS X
10.4
Re-
lease
9
(1.5.
0_19)

Java
for
Mac
OS X
10.4
Re-
lease
9 (1.5.
0_19)
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Environment and System Requirements

Browser & Java Plug-In for Documentum Application Connectors

Oper-
ating
Sys-
tem

Pro-
cessor

IE6
for
Win-
dows
XP
SP3
(6.00.
2900.
3311)

IE6
SP2
for
Win-
dows
Server
2003
SP1
(6.00.
3790.
3959)

IE7
for
Win-
dows
XP,
Win-
dows
Server
2003
(7.00.
5730.
1300)

IE7
for
Win-
dows
Vista
SP1
(7.00.
6001.
1800)

IE7
for
Win-
dows
Server
2008
(7.00.
6001.
1800)

IE8
for
Win-
dows
XP,
Win-
dows
Vista
(8.00.
6001.
18702)

IE8
for
Win-
dows
Server
2003
(8.00.
6001.
18702)

IE8
for
Win-
dows
Server
2008
(8.00.
6001.
18702)

IE8
for
Win-
dows
7

Fire-
fox
2.0.
0.20
[1]

Fire-
fox
3.0.
11,
3.5.5
[1]

Sa-
fari
2.0.4
[1]

Sa-
fari
3.2.3
[1]

Sa-
fari
4.0.3
[1]

Mac
OS X
10.5.8
Up-
date
v1.1

Pow-
erPC,
IA-32,
x64

Java
for
Mac
OS X
10.5
Up-
date
5 (1.4.
2_22)

Java
for
Mac
OS X
10.5
Up-
date
5
(1.4.
2_22)

Java
for
Mac
OS X
10.5
Up-
date
5 (1.4.
2_22)
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Environment and System Requirements

Browser & Java Plug-In for Documentum Application Connectors

Oper-
ating
Sys-
tem

Pro-
cessor

IE6
for
Win-
dows
XP
SP3
(6.00.
2900.
3311)

IE6
SP2
for
Win-
dows
Server
2003
SP1
(6.00.
3790.
3959)

IE7
for
Win-
dows
XP,
Win-
dows
Server
2003
(7.00.
5730.
1300)

IE7
for
Win-
dows
Vista
SP1
(7.00.
6001.
1800)

IE7
for
Win-
dows
Server
2008
(7.00.
6001.
1800)

IE8
for
Win-
dows
XP,
Win-
dows
Vista
(8.00.
6001.
18702)

IE8
for
Win-
dows
Server
2003
(8.00.
6001.
18702)

IE8
for
Win-
dows
Server
2008
(8.00.
6001.
18702)

IE8
for
Win-
dows
7

Fire-
fox
2.0.
0.20
[1]

Fire-
fox
3.0.
11,
3.5.5
[1]

Sa-
fari
2.0.4
[1]

Sa-
fari
3.2.3
[1]

Sa-
fari
4.0.3
[1]

Mac
OS X
10.5.8
Up-
date
v1.1

Pow-
erPC,
IA-32,
x64

Java
for
Mac
OS X
10.5
Up-
date
5 (1.5.
0_20)

Java
for
Mac
OS X
10.5
Up-
date
5
(1.5.
0_20)

Java
for
Mac
OS X
10.5
Up-
date
5 (1.5.
0_20)

Java
for
Mac
OS X
10.5
Up-
date
5 (1.5.
0_20)
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Environment and System Requirements

Browser & Java Plug-In for Documentum Application Connectors

Oper-
ating
Sys-
tem

Pro-
cessor

IE6
for
Win-
dows
XP
SP3
(6.00.
2900.
3311)

IE6
SP2
for
Win-
dows
Server
2003
SP1
(6.00.
3790.
3959)

IE7
for
Win-
dows
XP,
Win-
dows
Server
2003
(7.00.
5730.
1300)

IE7
for
Win-
dows
Vista
SP1
(7.00.
6001.
1800)

IE7
for
Win-
dows
Server
2008
(7.00.
6001.
1800)

IE8
for
Win-
dows
XP,
Win-
dows
Vista
(8.00.
6001.
18702)

IE8
for
Win-
dows
Server
2003
(8.00.
6001.
18702)

IE8
for
Win-
dows
Server
2008
(8.00.
6001.
18702)

IE8
for
Win-
dows
7

Fire-
fox
2.0.
0.20
[1]

Fire-
fox
3.0.
11,
3.5.5
[1]

Sa-
fari
2.0.4
[1]

Sa-
fari
3.2.3
[1]

Sa-
fari
4.0.3
[1]

Mac
OS X
10.5.8
Up-
date
v1.1

x64

Java
for
Mac
OS X
10.5
Up-
date
5 (1.6.
0_15)

Java
for
Mac
OS X
10.5
Up-
date
5
(1.6.
0_15)

Java
for
Mac
OS X
10.5
Up-
date
5 (1.6.
0_15)

Java
for
Mac
OS X
10.5
Up-
date
5 (1.6.
0_15)
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Browser & Java Plug-In for Documentum Application Connectors

Oper-
ating
Sys-
tem

Pro-
cessor

IE6
for
Win-
dows
XP
SP3
(6.00.
2900.
3311)

IE6
SP2
for
Win-
dows
Server
2003
SP1
(6.00.
3790.
3959)

IE7
for
Win-
dows
XP,
Win-
dows
Server
2003
(7.00.
5730.
1300)

IE7
for
Win-
dows
Vista
SP1
(7.00.
6001.
1800)

IE7
for
Win-
dows
Server
2008
(7.00.
6001.
1800)

IE8
for
Win-
dows
XP,
Win-
dows
Vista
(8.00.
6001.
18702)

IE8
for
Win-
dows
Server
2003
(8.00.
6001.
18702)

IE8
for
Win-
dows
Server
2008
(8.00.
6001.
18702)

IE8
for
Win-
dows
7

Fire-
fox
2.0.
0.20
[1]

Fire-
fox
3.0.
11,
3.5.5
[1]

Sa-
fari
2.0.4
[1]

Sa-
fari
3.2.3
[1]

Sa-
fari
4.0.3
[1]

Mac
OS X
10.6.1

Pow-
erPC,
IA-32,
x64

Java
for
Mac
OS X
10.5
Up-
date
5 (1.4.
2_22)

Java
for
Mac
OS X
10.5
Up-
date
5
(1.4.
2_22)
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Browser & Java Plug-In for Documentum Application Connectors

Oper-
ating
Sys-
tem

Pro-
cessor

IE6
for
Win-
dows
XP
SP3
(6.00.
2900.
3311)

IE6
SP2
for
Win-
dows
Server
2003
SP1
(6.00.
3790.
3959)

IE7
for
Win-
dows
XP,
Win-
dows
Server
2003
(7.00.
5730.
1300)

IE7
for
Win-
dows
Vista
SP1
(7.00.
6001.
1800)

IE7
for
Win-
dows
Server
2008
(7.00.
6001.
1800)

IE8
for
Win-
dows
XP,
Win-
dows
Vista
(8.00.
6001.
18702)

IE8
for
Win-
dows
Server
2003
(8.00.
6001.
18702)

IE8
for
Win-
dows
Server
2008
(8.00.
6001.
18702)

IE8
for
Win-
dows
7

Fire-
fox
2.0.
0.20
[1]

Fire-
fox
3.0.
11,
3.5.5
[1]

Sa-
fari
2.0.4
[1]

Sa-
fari
3.2.3
[1]

Sa-
fari
4.0.3
[1]

Mac
OS X
10.6.1

Pow-
erPC,
IA-32,
x64

Java
for
Mac
OS X
10.5
Up-
date
5 (1.5.
0_20)

Java
for
Mac
OS X
10.5
Up-
date
5
(1.5.
0_20)

Java
for
Mac
OS X
10.5
Up-
date
5 (1.5.
0_20)
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Browser & Java Plug-In for Documentum Application Connectors

Oper-
ating
Sys-
tem

Pro-
cessor

IE6
for
Win-
dows
XP
SP3
(6.00.
2900.
3311)

IE6
SP2
for
Win-
dows
Server
2003
SP1
(6.00.
3790.
3959)

IE7
for
Win-
dows
XP,
Win-
dows
Server
2003
(7.00.
5730.
1300)

IE7
for
Win-
dows
Vista
SP1
(7.00.
6001.
1800)

IE7
for
Win-
dows
Server
2008
(7.00.
6001.
1800)

IE8
for
Win-
dows
XP,
Win-
dows
Vista
(8.00.
6001.
18702)

IE8
for
Win-
dows
Server
2003
(8.00.
6001.
18702)

IE8
for
Win-
dows
Server
2008
(8.00.
6001.
18702)

IE8
for
Win-
dows
7

Fire-
fox
2.0.
0.20
[1]

Fire-
fox
3.0.
11,
3.5.5
[1]

Sa-
fari
2.0.4
[1]

Sa-
fari
3.2.3
[1]

Sa-
fari
4.0.3
[1]

Mac
OS X
10.6.1

x64

Java
for
Mac
OS X
10.5
Up-
date
5 (1.6.
0_15)

Java
for
Mac
OS X
10.5
Up-
date
5
(1.6.
0_15)

Java
for
Mac
OS X
10.5
Up-
date
5 (1.6.
0_15)

Solaris
10

Ultra-
SPARC

Sun
JRE
1.4.
2_19

Sun
JRE
1.4.
2_19
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Browser & Java Plug-In for Documentum Application Connectors

Oper-
ating
Sys-
tem

Pro-
cessor

IE6
for
Win-
dows
XP
SP3
(6.00.
2900.
3311)

IE6
SP2
for
Win-
dows
Server
2003
SP1
(6.00.
3790.
3959)

IE7
for
Win-
dows
XP,
Win-
dows
Server
2003
(7.00.
5730.
1300)

IE7
for
Win-
dows
Vista
SP1
(7.00.
6001.
1800)

IE7
for
Win-
dows
Server
2008
(7.00.
6001.
1800)

IE8
for
Win-
dows
XP,
Win-
dows
Vista
(8.00.
6001.
18702)

IE8
for
Win-
dows
Server
2003
(8.00.
6001.
18702)

IE8
for
Win-
dows
Server
2008
(8.00.
6001.
18702)

IE8
for
Win-
dows
7

Fire-
fox
2.0.
0.20
[1]

Fire-
fox
3.0.
11,
3.5.5
[1]

Sa-
fari
2.0.4
[1]

Sa-
fari
3.2.3
[1]

Sa-
fari
4.0.3
[1]

Solaris
10

Ultra-
SPARC

Sun
JRE
5.0
Up-
date
22

Sun
JRE
5.0
Up-
date
22

Solaris
10

Ultra-
SPARC

Sun
JRE
6.0
Up-
date
17

Sun
JRE
6.0
Up-
date
17

RHEL
4.8

IA-32,
x64

Sun
JRE
1.4.
2_19

Sun
JRE
1.4.
2_19
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Browser & Java Plug-In for Documentum Application Connectors

Oper-
ating
Sys-
tem

Pro-
cessor

IE6
for
Win-
dows
XP
SP3
(6.00.
2900.
3311)

IE6
SP2
for
Win-
dows
Server
2003
SP1
(6.00.
3790.
3959)

IE7
for
Win-
dows
XP,
Win-
dows
Server
2003
(7.00.
5730.
1300)

IE7
for
Win-
dows
Vista
SP1
(7.00.
6001.
1800)

IE7
for
Win-
dows
Server
2008
(7.00.
6001.
1800)

IE8
for
Win-
dows
XP,
Win-
dows
Vista
(8.00.
6001.
18702)

IE8
for
Win-
dows
Server
2003
(8.00.
6001.
18702)

IE8
for
Win-
dows
Server
2008
(8.00.
6001.
18702)

IE8
for
Win-
dows
7

Fire-
fox
2.0.
0.20
[1]

Fire-
fox
3.0.
11,
3.5.5
[1]

Sa-
fari
2.0.4
[1]

Sa-
fari
3.2.3
[1]

Sa-
fari
4.0.3
[1]

RHEL
4.8

IA-32,
x64

Sun
JRE
5.0
Up-
date
22

Sun
JRE
5.0
Up-
date
22

RHEL
4.8

IA-32,
x64

Sun
JRE
6.0
Up-
date
17

Sun
JRE
6.0
Up-
date
17

RHEL
5.4

IA-32,
x64

Sun
JRE
1.4.
2_19

Sun
JRE
1.4.
2_19
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Browser & Java Plug-In for Documentum Application Connectors

Oper-
ating
Sys-
tem

Pro-
cessor

IE6
for
Win-
dows
XP
SP3
(6.00.
2900.
3311)

IE6
SP2
for
Win-
dows
Server
2003
SP1
(6.00.
3790.
3959)

IE7
for
Win-
dows
XP,
Win-
dows
Server
2003
(7.00.
5730.
1300)

IE7
for
Win-
dows
Vista
SP1
(7.00.
6001.
1800)

IE7
for
Win-
dows
Server
2008
(7.00.
6001.
1800)

IE8
for
Win-
dows
XP,
Win-
dows
Vista
(8.00.
6001.
18702)

IE8
for
Win-
dows
Server
2003
(8.00.
6001.
18702)

IE8
for
Win-
dows
Server
2008
(8.00.
6001.
18702)

IE8
for
Win-
dows
7

Fire-
fox
2.0.
0.20
[1]

Fire-
fox
3.0.
11,
3.5.5
[1]

Sa-
fari
2.0.4
[1]

Sa-
fari
3.2.3
[1]

Sa-
fari
4.0.3
[1]

RHEL
5.4

IA-32,
x64

Sun
JRE
5.0
Up-
date
22

Sun
JRE
5.0
Up-
date
22

RHEL
5.4

IA-32,
x64

Sun
JRE
6.0
Up-
date
17

Sun
JRE
6.0
Up-
date
17
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Browser & Java Plug-In for Documentum Application Connectors

Oper-
ating
Sys-
tem

Pro-
cessor

IE6
for
Win-
dows
XP
SP3
(6.00.
2900.
3311)

IE6
SP2
for
Win-
dows
Server
2003
SP1
(6.00.
3790.
3959)

IE7
for
Win-
dows
XP,
Win-
dows
Server
2003
(7.00.
5730.
1300)

IE7
for
Win-
dows
Vista
SP1
(7.00.
6001.
1800)

IE7
for
Win-
dows
Server
2008
(7.00.
6001.
1800)

IE8
for
Win-
dows
XP,
Win-
dows
Vista
(8.00.
6001.
18702)

IE8
for
Win-
dows
Server
2003
(8.00.
6001.
18702)

IE8
for
Win-
dows
Server
2008
(8.00.
6001.
18702)

IE8
for
Win-
dows
7

Fire-
fox
2.0.
0.20
[1]

Fire-
fox
3.0.
11,
3.5.5
[1]

Sa-
fari
2.0.4
[1]

Sa-
fari
3.2.3
[1]

Sa-
fari
4.0.3
[1]

SUSE
Linux
Enter-
prise
Desk-
top 10
SP3

IA-32,
x64

Sun
JRE
1.4.
2_19

Sun
JRE
1.4.
2_19

SUSE
Linux
Enter-
prise
Desk-
top 10
SP3

IA-32,
x64

Sun
JRE
5.0
Up-
date
22

Sun
JRE
5.0
Up-
date
22
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Browser & Java Plug-In for Documentum Application Connectors

Oper-
ating
Sys-
tem

Pro-
cessor

IE6
for
Win-
dows
XP
SP3
(6.00.
2900.
3311)

IE6
SP2
for
Win-
dows
Server
2003
SP1
(6.00.
3790.
3959)

IE7
for
Win-
dows
XP,
Win-
dows
Server
2003
(7.00.
5730.
1300)

IE7
for
Win-
dows
Vista
SP1
(7.00.
6001.
1800)

IE7
for
Win-
dows
Server
2008
(7.00.
6001.
1800)

IE8
for
Win-
dows
XP,
Win-
dows
Vista
(8.00.
6001.
18702)

IE8
for
Win-
dows
Server
2003
(8.00.
6001.
18702)

IE8
for
Win-
dows
Server
2008
(8.00.
6001.
18702)

IE8
for
Win-
dows
7

Fire-
fox
2.0.
0.20
[1]

Fire-
fox
3.0.
11,
3.5.5
[1]

Sa-
fari
2.0.4
[1]

Sa-
fari
3.2.3
[1]

Sa-
fari
4.0.3
[1]

SUSE
Linux
Enter-
prise
Desk-
top 10
SP3

IA-32,
x64

Sun
JRE
6.0
Up-
date
17

Sun
JRE
6.0
Up-
date
17

SUSE
Linux
Enter-
prise
Desk-
top 11

IA-32,
x64

Sun
JRE
5.0
Up-
date
22

Sun
JRE
5.0
Up-
date
22
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Browser & Java Plug-In for Documentum Application Connectors

Oper-
ating
Sys-
tem

Pro-
cessor

IE6
for
Win-
dows
XP
SP3
(6.00.
2900.
3311)

IE6
SP2
for
Win-
dows
Server
2003
SP1
(6.00.
3790.
3959)

IE7
for
Win-
dows
XP,
Win-
dows
Server
2003
(7.00.
5730.
1300)

IE7
for
Win-
dows
Vista
SP1
(7.00.
6001.
1800)

IE7
for
Win-
dows
Server
2008
(7.00.
6001.
1800)

IE8
for
Win-
dows
XP,
Win-
dows
Vista
(8.00.
6001.
18702)

IE8
for
Win-
dows
Server
2003
(8.00.
6001.
18702)

IE8
for
Win-
dows
Server
2008
(8.00.
6001.
18702)

IE8
for
Win-
dows
7

Fire-
fox
2.0.
0.20
[1]

Fire-
fox
3.0.
11,
3.5.5
[1]

Sa-
fari
2.0.4
[1]

Sa-
fari
3.2.3
[1]

Sa-
fari
4.0.3
[1]

SUSE
Linux
Enter-
prise
Desk-
top 11

IA-32,
x64

Sun
JRE
6.0
Up-
date
17

Sun
JRE
6.0
Up-
date
17

SUSE
Linux
Enter-
prise
Server
10 SP3

IA-32,
x64

Sun
JRE
1.4.
2_19

Sun
JRE
1.4.
2_19
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Browser & Java Plug-In for Documentum Application Connectors

Oper-
ating
Sys-
tem

Pro-
cessor

IE6
for
Win-
dows
XP
SP3
(6.00.
2900.
3311)

IE6
SP2
for
Win-
dows
Server
2003
SP1
(6.00.
3790.
3959)

IE7
for
Win-
dows
XP,
Win-
dows
Server
2003
(7.00.
5730.
1300)

IE7
for
Win-
dows
Vista
SP1
(7.00.
6001.
1800)

IE7
for
Win-
dows
Server
2008
(7.00.
6001.
1800)

IE8
for
Win-
dows
XP,
Win-
dows
Vista
(8.00.
6001.
18702)

IE8
for
Win-
dows
Server
2003
(8.00.
6001.
18702)

IE8
for
Win-
dows
Server
2008
(8.00.
6001.
18702)

IE8
for
Win-
dows
7

Fire-
fox
2.0.
0.20
[1]

Fire-
fox
3.0.
11,
3.5.5
[1]

Sa-
fari
2.0.4
[1]

Sa-
fari
3.2.3
[1]

Sa-
fari
4.0.3
[1]

SUSE
Linux
Enter-
prise
Server
10 SP3

IA-32,
x64

Sun
JRE
5.0
Up-
date
22

Sun
JRE
5.0
Up-
date
22

SUSE
Linux
Enter-
prise
Server
10 SP3

IA-32,
x64

Sun
JRE
6.0
Up-
date
17

Sun
JRE
6.0
Up-
date
17
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Browser & Java Plug-In for Documentum Application Connectors

Oper-
ating
Sys-
tem

Pro-
cessor

IE6
for
Win-
dows
XP
SP3
(6.00.
2900.
3311)

IE6
SP2
for
Win-
dows
Server
2003
SP1
(6.00.
3790.
3959)

IE7
for
Win-
dows
XP,
Win-
dows
Server
2003
(7.00.
5730.
1300)

IE7
for
Win-
dows
Vista
SP1
(7.00.
6001.
1800)

IE7
for
Win-
dows
Server
2008
(7.00.
6001.
1800)

IE8
for
Win-
dows
XP,
Win-
dows
Vista
(8.00.
6001.
18702)

IE8
for
Win-
dows
Server
2003
(8.00.
6001.
18702)

IE8
for
Win-
dows
Server
2008
(8.00.
6001.
18702)

IE8
for
Win-
dows
7

Fire-
fox
2.0.
0.20
[1]

Fire-
fox
3.0.
11,
3.5.5
[1]

Sa-
fari
2.0.4
[1]

Sa-
fari
3.2.3
[1]

Sa-
fari
4.0.3
[1]

SUSE
Linux
Enter-
prise
Server
11

IA-32,
x64

Sun
JRE
5.0
Up-
date
22

Sun
JRE
5.0
Up-
date
22

SUSE
Linux
Enter-
prise
Server
11

IA-32,
x64

Sun
JRE
6.0
Up-
date
17

Sun
JRE
6.0
Up-
date
17
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Note: The following specific notes indicated by [ ] apply to the browser environment table:

[1] Not supported for Documentum Application Connectors.

Note: The following general notes apply to the browser environment table:
• The following Windows Server 2003 editions are supported: Standard, Enterprise, Data Center.

• IA-32 = Intel Architecture 32-bit

• x64 = 64-bit Architecture which includes AMD64 and Intel 64

• For Windows XP SP3, you must either disable its built-in popup-blocker, or you must add the web
application server as a trusted site.

• Cookies must be enabled in the browser.

• In order for UCF content transfer related operations such as import, export, view, checkout,
checkin, preferences to work under the Windows Vista operating system, you must choose one
of the following: turn off User Account Control (UAC) for each user, or in the browser add the
site to the list of Trusted Sites in IE7 and in the application set the UCF client configuration
registry.mode value to file instead of windows.

• The following drag and drop features are only supported on Internet Explorer 6.0 or higher
browsers running on Windows operating systems:
— dragging files from the Windows file system into the Webtop browser

— dragging files from the Webtop browser to the Windows file system

• The following Red Hat Enterprise Linux editions are supported: AS, ES, WS, and Desktop.

• For Documentum Collaborative Services and viewing forms in Webtop:
— The Rich Text Editor’s spell-check feature is only supported on Windows. It also requires
Microsoft Word on the client machine.

— The Rich Text Editor is not supported for Safari browsers. The Rich Text Editor (RTE), which
is used for creating and editing Rich Text associated with some of the collaboration features
(such as Notes, Folders with Descriptions, Rooms, Comment Threads), does not support the
creation of rich text for Safari versions 1.2.3 and 1.3. Safari users can create or edit plain text in
the RTE, and they can view rich text which has been created via other browsers, but will not
be able to create or edit rich text in the RTE.

• D6.x Documentum Administrator, Webtop, Digital Asset Manager, My Documentum for
Microsoft Outlook (formerly Documentum Client for Outlook) and custom Web Development
Kit/Documentum Foundation Classes applications are backward compatible with 5.3.x Content
Servers.

• Tier 1 language versions of the operating system and browser are supported. Tier 1 languages are
French, Italian, German, Spanish, Swedish, Brazilian-Portuguese, Simplified Chinese, Japanese,
Korean, Russian, and Arabic.

Web application server environment

Webtop runs in a web application server environment. The web application server environment
consists of a specific combination of operating system, web application server, and JDK. The
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web application server environment table for Webtop (Table 5, page 121) lists the supported web
application server environments.
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Table 5. Web application server environment for Webtop

Web application server for Webtop

Oper-
ating
system

Proces-
sor

Apache
Tomcat
5.5.28

Apache
Tomcat
6.0.20

BEA
We-
bLogic
Server
9.2 MP3
[2]

Ora-
cle We-
bLogic
Server
11g R1
(10.3.1)
[2] [5]

IBM
Web-
Sphere
Appli-
cation
Server
V6.1 Fix
Pack 27
(6.1.0.27)

IBM
Web-
Sphere
Appli-
cation
Server
V7.0 Fix
Pack 5
(7.0.0.5)

Oracle
AS 10g
R3 (10.
1.3.3.0)

Red
Hat
JBoss
EAP
4.3.0

Sun
Java
System
Appli-
cation
Server
8.2

Sun
Glass-
Fish
Enter-
prise
Server
v2.1 [4]

Win-
dows
Server
2003 R2
with
SP2 (32-
bit ver-
sion)

IA-32,
x64 X X X [1] X [1] X [1] X [1] X X

Win-
dows
Server
2003
SP2 (32-
bit ver-
sion)

IA-32,
x64 X X X [1] X [1] X [1] X [1] X X
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Web application server for Webtop

Oper-
ating
system

Proces-
sor

Apache
Tomcat
5.5.28

Apache
Tomcat
6.0.20

BEA
We-
bLogic
Server
9.2 MP3
[2]

Ora-
cle We-
bLogic
Server
11g R1
(10.3.1)
[2] [5]

IBM
Web-
Sphere
Appli-
cation
Server
V6.1 Fix
Pack 27
(6.1.0.27)

IBM
Web-
Sphere
Appli-
cation
Server
V7.0 Fix
Pack 5
(7.0.0.5)

Oracle
AS 10g
R3 (10.
1.3.3.0)

Red
Hat
JBoss
EAP
4.3.0

Sun
Java
System
Appli-
cation
Server
8.2

Sun
Glass-
Fish
Enter-
prise
Server
v2.1 [4]

Win-
dows
Server
2008
(32-bit
version)

IA-32,
x64 X X X [1] X [1]

Win-
dows
Server
2003 R2
with
SP2 x64
Edition

x64 [3] X X X [1] X [1] X [1] X [1] X X

Win-
dows
Server
2003
SP2 x64
Edition

x64 [3] X X X [1] X [1] X [1] X [1] X X

122 EMC Documentum Webtop Version 6.5 SP3 Release Notes



Environment and System Requirements

Web application server for Webtop

Oper-
ating
system

Proces-
sor

Apache
Tomcat
5.5.28

Apache
Tomcat
6.0.20

BEA
We-
bLogic
Server
9.2 MP3
[2]

Ora-
cle We-
bLogic
Server
11g R1
(10.3.1)
[2] [5]

IBM
Web-
Sphere
Appli-
cation
Server
V6.1 Fix
Pack 27
(6.1.0.27)

IBM
Web-
Sphere
Appli-
cation
Server
V7.0 Fix
Pack 5
(7.0.0.5)

Oracle
AS 10g
R3 (10.
1.3.3.0)

Red
Hat
JBoss
EAP
4.3.0

Sun
Java
System
Appli-
cation
Server
8.2

Sun
Glass-
Fish
Enter-
prise
Server
v2.1 [4]

Win-
dows
Server
2008 R2
x64 Edi-
tion

x64 [3] X X X [1] X [1]

Solaris
10

Ultra-
SPARC
[3]

X X X [1] X [1] X [1] X [1] X X X X

AIX 5L
V5.3
TL10

Power
[3] X X X X X [1] X [1] X

AIX
V6.1
TL3

Power
[3] X X X X X [1] X [1] X
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Web application server for Webtop

Oper-
ating
system

Proces-
sor

Apache
Tomcat
5.5.28

Apache
Tomcat
6.0.20

BEA
We-
bLogic
Server
9.2 MP3
[2]

Ora-
cle We-
bLogic
Server
11g R1
(10.3.1)
[2] [5]

IBM
Web-
Sphere
Appli-
cation
Server
V6.1 Fix
Pack 27
(6.1.0.27)

IBM
Web-
Sphere
Appli-
cation
Server
V7.0 Fix
Pack 5
(7.0.0.5)

Oracle
AS 10g
R3 (10.
1.3.3.0)

Red
Hat
JBoss
EAP
4.3.0

Sun
Java
System
Appli-
cation
Server
8.2

Sun
Glass-
Fish
Enter-
prise
Server
v2.1 [4]

HP-UX
11i v2
Update
2 (B.11.
23)

PA-RISC
2.0 [3] X X X X X

HP-UX
11i v2
Update
2 (B.11.
23)

Itanium
2 [3] X X X X X [1] X [1] X

HP-UX
11i v3
Update
5 (B.11.
31)

PA-RISC
2.0 [3] X X X X X

HP-UX
11i v3
Update
5 (B.11.
31)

Itanium
2 [3] X X X X X [1] X [1] X
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Web application server for Webtop

Oper-
ating
system

Proces-
sor

Apache
Tomcat
5.5.28

Apache
Tomcat
6.0.20

BEA
We-
bLogic
Server
9.2 MP3
[2]

Ora-
cle We-
bLogic
Server
11g R1
(10.3.1)
[2] [5]

IBM
Web-
Sphere
Appli-
cation
Server
V6.1 Fix
Pack 27
(6.1.0.27)

IBM
Web-
Sphere
Appli-
cation
Server
V7.0 Fix
Pack 5
(7.0.0.5)

Oracle
AS 10g
R3 (10.
1.3.3.0)

Red
Hat
JBoss
EAP
4.3.0

Sun
Java
System
Appli-
cation
Server
8.2

Sun
Glass-
Fish
Enter-
prise
Server
v2.1 [4]

RHEL
4.8 IA-32 X X X X X [1] X [1] X [1] X

RHEL
4.8 x64 [3] X X X X X [1] X [1] X [1] X

RHEL
5.4 IA-32 X X X X X [1] X [1] X [1] X

RHEL
5.4 x64 [3] X X X X X [1] X [1] X [1] X

SUSE
Linux
Enter-
prise
Server
10 SP3

IA-32 X X X X X [1] X [1] X [1] X
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Web application server for Webtop

Oper-
ating
system

Proces-
sor

Apache
Tomcat
5.5.28

Apache
Tomcat
6.0.20

BEA
We-
bLogic
Server
9.2 MP3
[2]

Ora-
cle We-
bLogic
Server
11g R1
(10.3.1)
[2] [5]

IBM
Web-
Sphere
Appli-
cation
Server
V6.1 Fix
Pack 27
(6.1.0.27)

IBM
Web-
Sphere
Appli-
cation
Server
V7.0 Fix
Pack 5
(7.0.0.5)

Oracle
AS 10g
R3 (10.
1.3.3.0)

Red
Hat
JBoss
EAP
4.3.0

Sun
Java
System
Appli-
cation
Server
8.2

Sun
Glass-
Fish
Enter-
prise
Server
v2.1 [4]

SUSE
Linux
Enter-
prise
Server
10 SP3

x64 [3] X X X X X [1] X [1] X [1] X

SUSE
Linux
Enter-
prise
Server
11

IA-32 X X X X X [1] X [1] X [1] X

SUSE
Linux
Enter-
prise
Server
11

x64 [3] X X X X X [1] X [1] X [1] X

Note: The X symbol denotes the supported combination of operating system and web application server.
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The web application server environment consists of a specific combination of operating system,
web application server, and JDK. The web application server environment table for Documentum
Application Connectors (Table 6, page 128) lists the supported web application server environments
for Documentum Application Connectors.
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Table 6. Web application server environment for Documentum Application Connectors

Web application server for Documentum Application Connectors

Oper-
ating
system

Proces-
sor

Apache
Tomcat
5.5.28

Apache
Tomcat
6.0.20

BEA
We-
bLogic
Server
9.2 MP3
[2]

Ora-
cle We-
bLogic
Server
11g R1
(10.3.1)
[2] [5]

IBM
Web-
Sphere
Appli-
cation
Server
V6.1 Fix
Pack 27
(6.1.0.27)

IBM
Web-
Sphere
Appli-
cation
Server
V7.0 Fix
Pack 5
(7.0.0.5)

Oracle
AS 10g
R3 (10.
1.3.3.0)

Red
Hat
JBoss
EAP
4.3.0

Sun
Java
System
Appli-
cation
Server
8.2

Sun
Glass-
Fish
Enter-
prise
Server
v2.1 [4]

Win-
dows
Server
2003 R2
with
SP2 (32-
bit ver-
sion)

IA-32,
x64 X X X [1] X [1] X [1] X [1] X X

Win-
dows
Server
2003
SP2 (32-
bit ver-
sion)

IA-32,
x64 X X X [1] X [1] X [1] X [1] X X
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Web application server for Documentum Application Connectors

Oper-
ating
system

Proces-
sor

Apache
Tomcat
5.5.28

Apache
Tomcat
6.0.20

BEA
We-
bLogic
Server
9.2 MP3
[2]

Ora-
cle We-
bLogic
Server
11g R1
(10.3.1)
[2] [5]

IBM
Web-
Sphere
Appli-
cation
Server
V6.1 Fix
Pack 27
(6.1.0.27)

IBM
Web-
Sphere
Appli-
cation
Server
V7.0 Fix
Pack 5
(7.0.0.5)

Oracle
AS 10g
R3 (10.
1.3.3.0)

Red
Hat
JBoss
EAP
4.3.0

Sun
Java
System
Appli-
cation
Server
8.2

Sun
Glass-
Fish
Enter-
prise
Server
v2.1 [4]

Win-
dows
Server
2008
(32-bit
version)

IA-32,
x64 X X X [1] X [1]

Win-
dows
Server
2003 R2
with
SP2 x64
Edition

x64 [3] X X X [1] X [1] X [1] X [1] X X

Win-
dows
Server
2003
SP2 x64
Edition

x64 [3] X X X [1] X [1] X [1] X [1] X X
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Web application server for Documentum Application Connectors

Oper-
ating
system

Proces-
sor

Apache
Tomcat
5.5.28

Apache
Tomcat
6.0.20

BEA
We-
bLogic
Server
9.2 MP3
[2]

Ora-
cle We-
bLogic
Server
11g R1
(10.3.1)
[2] [5]

IBM
Web-
Sphere
Appli-
cation
Server
V6.1 Fix
Pack 27
(6.1.0.27)

IBM
Web-
Sphere
Appli-
cation
Server
V7.0 Fix
Pack 5
(7.0.0.5)

Oracle
AS 10g
R3 (10.
1.3.3.0)

Red
Hat
JBoss
EAP
4.3.0

Sun
Java
System
Appli-
cation
Server
8.2

Sun
Glass-
Fish
Enter-
prise
Server
v2.1 [4]

Win-
dows
Server
2008 R2
x64 Edi-
tion

x64 [3] X X X [1] X [1]

Solaris
10

Ultra-
SPARC
[3]

X X X [1] X [1] X [1] X [1] X X X X

AIX 5L
V5.3
TL10

Power
[3] X X X X X [1] X [1] X

AIX
V6.1
TL3

Power
[3] X X X X X [1] X [1] X
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Web application server for Documentum Application Connectors

Oper-
ating
system

Proces-
sor

Apache
Tomcat
5.5.28

Apache
Tomcat
6.0.20

BEA
We-
bLogic
Server
9.2 MP3
[2]

Ora-
cle We-
bLogic
Server
11g R1
(10.3.1)
[2] [5]

IBM
Web-
Sphere
Appli-
cation
Server
V6.1 Fix
Pack 27
(6.1.0.27)

IBM
Web-
Sphere
Appli-
cation
Server
V7.0 Fix
Pack 5
(7.0.0.5)

Oracle
AS 10g
R3 (10.
1.3.3.0)

Red
Hat
JBoss
EAP
4.3.0

Sun
Java
System
Appli-
cation
Server
8.2

Sun
Glass-
Fish
Enter-
prise
Server
v2.1 [4]

HP-UX
11i v2
Update
2 (B.11.
23)

PA-RISC
2.0 [3] X X X X X

HP-UX
11i v2
Update
2 (B.11.
23)

Itanium
2 [3] X X X X X

HP-UX
11i v3
Update
5 (B.11.
31)

PA-RISC
2.0 [3] X X X X X

HP-UX
11i v3
Update
5 (B.11.
31)

Itanium
2 [3] X X X X X
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Web application server for Documentum Application Connectors

Oper-
ating
system

Proces-
sor

Apache
Tomcat
5.5.28

Apache
Tomcat
6.0.20

BEA
We-
bLogic
Server
9.2 MP3
[2]

Ora-
cle We-
bLogic
Server
11g R1
(10.3.1)
[2] [5]

IBM
Web-
Sphere
Appli-
cation
Server
V6.1 Fix
Pack 27
(6.1.0.27)

IBM
Web-
Sphere
Appli-
cation
Server
V7.0 Fix
Pack 5
(7.0.0.5)

Oracle
AS 10g
R3 (10.
1.3.3.0)

Red
Hat
JBoss
EAP
4.3.0

Sun
Java
System
Appli-
cation
Server
8.2

Sun
Glass-
Fish
Enter-
prise
Server
v2.1 [4]

RHEL
4.8 IA-32 X X X X X [1] X [1] X [1] X

RHEL
4.8 x64 [3] X X X X X [1] X [1] X [1] X

RHEL
5.4 IA-32 X X X X X [1] X [1] X [1] X

RHEL
5.4 x64 [3] X X X X X [1] X [1] X [1] X

SUSE
Linux
Enter-
prise
Server
10 SP3

IA-32 X X X X X [1] X [1] X [1] X
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Web application server for Documentum Application Connectors

Oper-
ating
system

Proces-
sor

Apache
Tomcat
5.5.28

Apache
Tomcat
6.0.20

BEA
We-
bLogic
Server
9.2 MP3
[2]

Ora-
cle We-
bLogic
Server
11g R1
(10.3.1)
[2] [5]

IBM
Web-
Sphere
Appli-
cation
Server
V6.1 Fix
Pack 27
(6.1.0.27)

IBM
Web-
Sphere
Appli-
cation
Server
V7.0 Fix
Pack 5
(7.0.0.5)

Oracle
AS 10g
R3 (10.
1.3.3.0)

Red
Hat
JBoss
EAP
4.3.0

Sun
Java
System
Appli-
cation
Server
8.2

Sun
Glass-
Fish
Enter-
prise
Server
v2.1 [4]

SUSE
Linux
Enter-
prise
Server
10 SP3

x64 [3] X X X X X [1] X [1] X [1] X

SUSE
Linux
Enter-
prise
Server
11

IA-32 X X X X X [1] X [1] X [1] X

SUSE
Linux
Enter-
prise
Server
11

x64 [3] X X X X X [1] X [1] X [1] X

Note: The X symbol denotes the supported combination of operating system and web application server.
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Note: The following specific notes indicated by [ ] apply to the web application server environment
table:

[1] Clustering (failover) support. See general notes for exceptions below.
[2] WebLogic web application server clustering support requires external load balancer or Web
Server acting as a load balancer.
[3] Support 64-bit version of operating system in native mode.
[4] Sun Java System Application Server 9.1.1 is renamed to Sun GlassFish Enterprise Server v2.1.
[5] Support both WebLogic 10.3 and WebLogic 10.3.1 in 6.5 SP3. From Oracle point of view,
WebLogic 10.3 is 10g and WebLogic 10.3.1 is 11g are different generations of servers.

Note: The following general notes apply to the web application server environment table:
• The following Windows Server 2003 editions are supported: Standard, Enterprise, Data Center.

• IA-32 = Intel Architecture 32-bit

• x64 = 64-bit Architecture which includes AMD64 and Intel 64

• Support all the Java 5.0.x and 6.0.x version supported by each web application server. No support
for JDK 1.4.x.

• Support 32-bit version and 64-bit version of web application server.

• Web servers internal to the supported web application servers are supported.

• The Web server associated with a web application server, whether internal or external, must also
support chunked requests. This means that Web servers forward HTTP requests using chunked
transfer encoding (as described in the HTTP/1.1 protocol) to the back-end web application server.
If chunked requests are not supported then the client should use "UCF Alternative Chunking”
mode. For details on configuring and using "UCF Alternative Chunking” mode, refer to the
Web Development Kit Development Guide.

• Only the following forward proxy configurations are supported:
— Auto configuration script

— Explicitly specifying the proxy server (for example, the host and port)

— Auto detect settings, configured using ProxyCfg.exe (proxy configuration tool)

• Document linking (OLE linking) will only be supported for Microsoft Office 2003 and 2007 but not
for Office XP (2002).

• Linked PowerPoint 2007 documents are not supported when those documents are opened using
PowerPoint 2003 with the Microsoft 2003-2007 compatibility pack installed.

• English, Simplified Chinese, Japanese, Korean, Russian (English with regional setting set to
Russian), and Arabic (English with regional setting set to Russian) versions of the operating
system are supported.

Java version support

The Java version support table consists of a specific combination of Java version, and web application
server.
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Table 7. Java version support

Web application server

Java

Apache
Tomcat
5.5.28

Apache
Tomcat
6.0.20

BEA
WebLogic
Server 9.2
MP3

Oracle
WebLogic
Server 11g
R1 (10.3.1)

IBM
WebSphere
Application
Server V6.1
Fix Pack 27
(6.1.0.27)

IBM
WebSphere
Application
Server V7.0
Fix Pack 5
(7.0.0.5)

Oracle
AS 10g
R3 (10.
1.3.3.0)

Red
Hat
JBoss
EAP
4.3.0

Sun
Java
System
Appli-
cation
Server
8.2

Sun
Glass-
Fish
Enter-
prise
Server
v2.1

5.0.x X X X X X X X X

6.0.x X X X X X X
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External web server environments

This section describes supported web server configurations for web application servers used with
WDK-based products. You may wish to utilize the security benefits associated with a web server. You
can also setup a forward or reverse proxy to the web application server using one of the supported
configurations listed in the following table.

Table 8. External web server environments

External web server Clustering support
Apache 2.0.63 No

Apache 2.2.14 No

IBM HTTP Server 6.1.0 Fix Pack 27 (6.1.0.27) No

IBM HTTP Server 7.0.0.0 No

Microsoft Internet Information Server (IIS) 6.0 No

Microsoft Internet Information Server (IIS) 7.0 No

Microsoft Internet Information Server (IIS) 7.5 No

Sun Java System Web Server 6.1 SP10 Failover, LoadBalancing

Sun Java System Web Server 7.0 Update 4 Failover, LoadBalancing

Note: The following general notes applies to the external web server environment table:
• We support the above listed external Web servers only when the Web server is available on the
same operating system version as the associated application server.

• We support the above listed Web servers used with single sign-on products listed in the Operating
environment table if it is supported by the single sign-on products.

Microsoft Office support for Documentum Application
Connectors

The client environment consists of a specific combination of operating system, processor, and
Microsoft Office product. The following table lists the client environments for Documentum
Application Connectors.

Table 9. Microsoft Office support for Documentum Application Connectors

Microsoft Office

Operating system Processor
Microsoft
Office XP SP3

Microsoft Office
2003 SP3

Microsoft Office
2007 SP2

Windows XP SP3
(32-bit version) IA-32, x64 X X X

Windows Vista SP2
(32-bit version) IA-32, x64 X X X

136 EMC Documentum Webtop Version 6.5 SP3 Release Notes



Environment and System Requirements

Microsoft Office

Operating system Processor
Microsoft
Office XP SP3

Microsoft Office
2003 SP3

Microsoft Office
2007 SP2

Windows Server 2003
R2 with SP2 (32-bit
version)

IA-32, x64 X X X

Windows Server 2003
SP2 (32-bit version) IA-32, x64 X X X

Windows Server 2008
(32-bit version) IA-32, x64 X X X

Note: The X symbol denotes the supported combination of operating system andMicrosoft Office.

Note: The following general notes apply to the Microsoft Office support for Documentum
Application Connectors table:
• The following Windows Server 2003 editions are supported: Standard, Enterprise, Data Center.

• For integration with Office, .NET Framework 1.1 SP1, 2.0, 3.0, and 3.5 are supported. If no .NET
Framework is installed on the client machine, .NET Framework 1.1 SP1 will be installed. If both
.NET Framework 1.1 SP1 and 2.0 are installed on client machine, version 1.1 SP1 will be used.

• D6 Application Connector for Outlook requires a Webtop D6. We recommend always use the
same version of Application Connector as Webtop, all other D6 Application Connectors can
work with Webtop 5.3 SP2 or higher.

• Support is not available for using mixed versions of Microsoft Office applications with
Documentum Application Connectors. We recommend that you always use the same version of
all Microsoft Office applications with Documentum Application Connectors. For example, you
cannot use Documentum Application Connectors for Word, Excel, and PowerPoint in Microsoft
Office 2002 (XP) SP3 with Documentum Application Connectors for Outlook in Microsoft Office
2007.

• Only supports Word, Excel, PowerPoint, and Outlook from the Office Suite.

Webtop Federated Search environment

The Webtop Federated Search environment consists of a specific combination of operating system
and processor. The following table lists the supported environments for Webtop Federated Search.

Table 10. Webtop Federated Search environment

Operating system Processor

Windows XP SP3 (32-bit version) IA-32, x64

Windows Vista SP2 (32-bit version) IA-32, x64

Windows Server 2003 R2 with SP2 (32-bit
version)

IA-32, x64

Windows Server 2003 SP2 (32-bit version) IA-32, x64
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Operating system Processor

Windows Server 2008 (32-bit version) IA-32, x64

Windows Server 2003 R2 with SP2 x64 Edition x64 [1]

Windows Server 2003 SP2 x64 Edition x64 [1]

Windows Server 2008 R2 x64 Edition x64 [1]

Red Hat Enterprise Linux 4.8 IA-32, x64

Red Hat Enterprise Linux 5.4 IA-32, x64

SUSE Linux Enterprise Server 10 SP3 IA-32, x64

SUSE Linux Enterprise Server 11 IA-32, x64

Note: The following specific note indicated by [ ] applies to the Webtop Federated Search
environment table:

[1] Support 64-bit version of operating system in native mode.

Note: The following general notes apply to the Webtop Federated Search environment table:
• The following Windows Server 2003 editions are supported: Standard, Enterprise, Data Center.

• IA-32 = Intel Architecture 32-bit

• x64 = 64-bit Architecture which includes AMD64 and Intel 64

• Webtop Federated Search works with Webtop 6, 6 SP1 and 6.5.

• Despite the OS limitation of Webtop Federated Search DARs installer, the Webtop Federated
Search DARs can be installed remotely on any repository with Content Server 6, 6 SP1 and 6.5.

Additional operating environments

This section provides information on supported operating environments.

VMware support

The following table lists the VMware product versions supported on specific operating system(s).

Table 11. VMware support

Product Operating system Processor

VMware Server
Windows & Linux (See
VMware website for the specific
supported version)

IA-32, x64
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Product Operating system Processor

VMware Workstation
Windows & Linux (See
VMware website for the specific
supported version)

IA-32, x64

VMware ESX Server N/A IA-32, x64

Note: The following general notes apply to the VMware support table:

• IA-32 = Intel Architecture 32-bit

• x64 = 64-bit Architecture which includes AMD64 and Intel 64

• Documentum fully supports all of our products running on a guest operation system supported
by the version of VMware products listed as long as that same version of operating system
is supported by the appropriate EMC Documentum product. VMware supports only x86
microprocessor architecture.

IBM Logical Partitioning support

The following table lists the IBM Logical Partitioning (LPAR) product versions supported on specific
operating system(s).

Table 12. IBM Logical Partitioning support

Product versions Operating system Processor
IBM Logical Partitioning
(LPAR) [1] [2]

AIX 5L V5.3 TL10
AIX V6.1 TL3 Power

Note: The following specific note indicated by [ ] applies to the IBM Logical Partitioning support table:

[1] Only one LPAR is supported and multiple LPARs are not supported for Index Server.
[2] LPAR specific tuning, performance guidelines, recommendations, and specific setup issues
would be provided and communicated directly by IBM to the customer. We are currently not
aware of any Documentum specific LPAR setup issues. We expect the customer to perform
relevant use case scenario based pre-production testing on LPAR. This support assumes that
these tests with relevant configurations perform successfully prior to going into production. If
the issue is determined to be related to incompatibility of the LPAR environment, EMC and the
customer will jointly pursue with IBM for resolution.

Sun Microsystems support

The following table lists the Sun Microsystems product versions supported on specific operating
system(s).
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Table 13. Sun Microsystems support

Product Operating system Processor
Sun Microsystems Solaris
Zones [1] Solaris 10 UltraSPARC

Sun Microsystems Logical
Domains (LDOM) Solaris UltraSPARC

Note: The following specific note indicated by [ ] applies to the Sun Microsystems support table:

[1] Non-global zone is not supported for Index Server.

Citrix support

The following table lists the Citrix product versions supported on specific operating system(s).

Table 14. Citrix support

Product versions Operating system Processor

Citrix XenApp 5.0 Release 2 [1] Windows Server 2003 SP2
(32-bit version) IA-32, x64

Citrix XenApp 5.0 Release 2 [1] Windows Server 2008 R2 (32-bit
version) IA-32, x64

Note: The following specific note indicated by [ ] applies to the Sun Microsystems support table:

[1] Citrix Presentation Server 4.5 FP2 was renamed to XenApp 5.0.

Note: The following general notes apply to the Citrix support table:
• IA-32 = Intel Architecture 32-bit

• x64 = 64-bit Architecture which includes AMD64 and Intel 64

Siteminder support

eTrust Siteminder Policy Server 6.0 SP5 is supported for all supported web application servers and
operating systems, except there is no Firefox browser support. ’libstdc++-libc6.2-2.so.3’ package is
required to load netegrity plugin on SUSE Linux 11.

RSA support

RSA Access Manager 6.0.4 is supported for all supported web application servers and operating
systems.
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Native 64-bit support

Documentum 6.5x introduces native 64-bit support such that 64-bit Documentum applications can
run on 64-bit operating systems.

Prerequisites to run Documentum 6.5x products in the native 64-bit mode

You must ensure that your 64-bit environment comprises the following prerequisite components
before you run the Documentum 6.5x products:
• 64-bit processor

• 64-bit operating system

• 64-bit Java Virtual Machine

• 64-bit web application server (if needed). Ensure that the web application server is bundled with
64-bit Java Virtual Machine.

64-bit support in web application server environment

Documentum 6.5x continues to support 32-bit versions of the Microsoft Windows operating system.
In the 64-bit domain, Documentum 6.5x does not support 64-bit versions of the Microsoft Windows
operating system. However, as an exception, Documentum 6.5x provides native support of the
64-bit version of Microsoft Windows Server 2003 for web application server- and portal server-based
products.

Note: The following general notes apply to Native 64-bit support in Documentum 6.5x:
• Check your web application server documentation for information about configuration changes
you need to make to run Documentum 6.5x product on a 64-bit platform. For example, the IBM
WebSphere Application Server V6.1 Fix Pack 13 (6.1.0.13) ships with platform-specific 32-bit
and 64-bit installers.

• For information about tuning a 64-bit Java Virtual Machine and garbage collection parameters,
refer to the Java Virtual Machine documents of the relevant vendor.

• Porting the 32-bit Documentum 6.5x application to a 64-bit platform: Documentum 6.5x product
must install a 64-bit compatible Java Virtual Machine before porting the 32-bit Documentum
6.5x application to a 64-bit platform.

IPv6 support

Documentum 6.5x now supports dual-stack (IPv4 or IPv6) and native IPv4 operation. In addition
to this, Documentum 6.5x products which are Java based applications also support native IPv6
operation. Support for dual-stack operation enables Documentum 6.5x products to use the
appropriate protocol (IPv4 or IPv6) when communicating with third-party products and other
Documentum products.
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Documentum Foundation Classes determines the operating mode, and by default, DFC is configured
for dual-stack and native IPv6 operation. The Documentum Foundation Classes Installation Guide
provides information on how to configure DFC for native IPv4 operation.

Note: Information on protocol support for third-party products is provided in the third-party
product documentation.

Table 15. Webtop IPv6 compliance

Product Dual-Stack (IPv4 & IPv6) Native IPv6

Webtop X X

Web Publisher X X

Digital Asset Manager X X

Content Transformation
Services X X

Documentum Application
Connectors X X

Documentum Administrator X X

Advanced Documentum
Transformation Services X X

Documentum Collaborative
Services X X

Federated Search Services X X

Media Transformation Services X X

Interactive Delivery Services X X

Web Development Kit for
Portlets X X

PDF Annotation Services

Forms Builder X X

Document Image Services X X

Records Manager X X

Note: The X symbol denotes the support started with 6.5 release.

Applet certificates

This section lists the names of the Applets, its certification type, and the date of expiry that affects the
use of your product.
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Table 16. Applet certificates of Webtop

Applet name Certification type Expiry date
UCF Applets
ContentXfer Applets
File Selector Applets

Java
Microsoft 11/02/2012

Table 17. Applet certificates of Documentum Application Connectors

Applet name Certification type Expiry date
AppConnectors Installer Executable Microsoft 11/04/2011

Cross-product dependencies and
interoperability
This section lists Documentum products that are depended on in order to achieve a basic level of
functionality and lists related Documentum products that enhance overall functionality.

You may have to install some of the listed products on separate host or client machines due to
differences in the Documentum Foundation Classes versions included with those products. Before
installing a product, check the product’s Release Notes for supported configurations.

The 32-bit version of Documentum 6.5x products can run in the 32-bit native mode and the 64-bit
compatibility mode. However, the 64-bit version of Documentum 6.5x products can run only in
the 64-bit native mode.

Some services delivered with DFS depend on Service-based Business Objects (SBOs). Because SBOs
are downloaded to the service dynamically from the Global Registry, environments that use these
services must have a correctly configured global registry, and the global registry credentials must be
set in the DFS dfc.properties file when DFS is deployed. The following paragraphs provide details
about specific services.

One of the following product versions is a prerequisite for Webtop:
• Content Server 5.3, 5.3 SPx, 6, 6 SP1, 6.5, 6.5 SP1, 6.5 SP2, 6.5 SP3

One of the following product versions enhances overall functionality for Webtop:
• Documentum Administrator 5.3, 5.3 SPx, 6, 6 SP1, 6.5, 6.5 SP1, 6.5 SP2, 6.5 SP3

Note: Regardless of whether the Content Server version is 5.3, 5.3 SPx, 6, 6 SP1, 6.5, 6.5 SP1, 6.5 SP2 or
6.5 SP3, WDK-based applications require the presence of a Content Server 6, 6 SP1, 6.5, 6.5 SP1, 6.5
SP2 or 6.5 SP3 global registry repository in order to function properly.

Embedded products
Installing EMC Documentum products includes the following additional products.
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For Webtop:
• Documentum Foundation Classes 6.5 SP3
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Chapter 5
Known Problems and Limitations

This section identifies problems and limitations that may affect your use of the product.

Note: This section and the Technical Notes section may refer to platforms or features that are not
supported for this release of your product. Check Chapter 4, Environment and System Requirements
to verify requirements.

EMC Documentum makes the latest information about customer-reported issues and known
problems are posted on the Powerlink website (http://powerlink.EMC.com). You must have a
software support agreement to log in and access the list of issues.

Note: EMC Documentum has recently migrated to a new defect tracking system. As a result,
problems and limitations in this chapter may include the legacy tracking number (a numeric
reference), the new tracking number (an alphanumeric reference), or both references.

Known problems
This section describes known defects in EMC Documentum software that may affect your use
of the product.

Known problems common to all WDK applications

Connection to FS2 server fails when host name contains an
underscore (FSTWO-149, WEBTOP-9340)

When trying to connect a client such as Webtop to FS2 server using the RMI connection, the
connection fails if the hostname contains an underscore.

Workaround:

Specify the IP address instead of the host name for the following parameters:
• xtrim.server.rmi.registryHost in www/docs/conf/server.conf (on FS2 server machine)

• dfc.search.external_sources.host in dfc.properties (on the client machine)

EMC Documentum Webtop Version 6.5 SP3 Release Notes 145

http://powerlink.emc.com


Known Problems and Limitations

Multibyte characters in a form posted as an inline request are not
encoded correctly (WDK-2209)

Consider an HTML form containing multibyte characters in its text fields. If you post such a form
as an inline request, the multibyte characters appear incorrectly encoded when viewed in the
corresponding web page in the Webtop user interface using Firefox 3.0.1 or later. This issue occurs
because Firefox 3.0.1 and later versions use UTF-8 as the default character encoding format for
posting HTML forms as inline requests.

E-mail messaging ingestion fails on Sybase (COMPAR-368)

While using messagingApp on Sybase, message ingestion fails because the i_partition of
dm_message_archive_s table is not nullable.

Workaround: Using the iapi tool, execute the following command:
Execsql,c,alter table dm_message_archive modify i_partition null

Network locations in Portals login page (105111/WDK-1515)

The Portals login page displays a list of default network locations, but does not map automatically to
the client’s correct network location.

Unable to distinguish User and UserGroup values in the "Name"
column in the Choose a User/Group page (WDK-1630)

When you click the Historical Report > Process link in the Available Actions page for a selected user,
navigate to the General tab, navigate to theWorkflow Supervisor tab, click the Select link, and
view the Choose a User/Group page, you cannot distinguish the User value from the UserGroup
value in the Name column.

Default theme preference issue in different Webtop applications
using the same global repository (WEBTOP-5950, WEBTOP-6881)

While one Webtop application uses the out-of-the-box default theme preference, and you have
customized the default theme preference in another Webtop application, and both use the same
global repository, when you log in to the first instance of the Webtop application, log out of it, and
log in to the Webtop application with the customized theme, the customized default theme is lost
and the out-of-the-box Documentum theme is displayed instead. However, if you delete the user
preferences by logging in to Documentum Administrator, delete the web browser cookies, close and
re-open the browser, the custom theme appears again.
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Workaround: If there are two webtop applications webtop1 and webtop2 that refer to the same
Global Repository and if the requirement is to have two different preference settings for these two
applications, this can be achieved by setting the preference location value for repository_path in
wdk\app.xml. Use the following snippet of sample app.xml for setting the preferences repository:
<preferencesrepository>
<filter clientenv=’not portal’>
<!-- Repository folder for storing user preferences in App server environment-->

<repository_path>/Resources/Registry/Preferences/Webtop2</repository_path>
</filter>

Note: The default dmc_wdk_preferences_owner preference user must have the Write permission
on the /Resources/Registry/Preferences folder.

An error occurs when a user attempts to enable dmcl tracing from
within a 5.3 SP4 or 5.3 SP5 version of a WDK-based application
(WDK-1251)

An error occurs if a user whose name has been defined with a comma in the user_name field
of the dm_user object, logs into a 5.3 SP4 or 5.3 SP5 version of a WDK-based application
and then attempts to enable dmcl tracing. For example, if the user_name attribute ahs been
defined as Smith, John, and the user logs into a 5.3 SP4 or 5.3 SP5 version of a WDK-based
application as jsmith, and then enables dmcl tracing by opening a new browser session with the
http://<hostname>:<port>/webtop/wdk/dmclTrace.jsp=10 URL, the following error occurs:
[DM_API_E_FACILITY_UNKNOWN]error: "The specified facility
(John.opers-2007.06.19-1019h.21s.log) is not a valid trace facility."

List of performers displayed for subsequent activities is not
refreshed after performers are selected for the first activity
(152658/WDK-974)

If a workflow template is set up to allow a user to select performers for two or more subsequent
activities at workflow runtime, after the user selects the performers from different groups for the
first activity, starting from the second activity, only those performers who are already selected in the
previous activity are listed in the right pane. When the last performer is selected for the activity, the
right pane lists the names of all performers who are already selected who belong to groups or roles
from which it should not be possible to select performers for the relevant activity.

Unable to view a file after the owner of the ACL is changed
(148130/WDK-1168)

If non-superusers view a file after changing the owner of the ACL associated with the file, an error
message is displayed, and the file is not opened for viewing.
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An error occurs if a user approves a document after receiving
an error indicating that the task has been accepted by another
approver (WEBTOP-2447)

When two approvers view the same task item in the Inbox, and the Accept button is enabled for both
approvers, one of them accepts the task and approves the task. However, the Accept, Approve, and
Reject buttons continue to remain enabled for the second approver. If the second approver also
accepts the same task, the following error message is displayed: "Task has already been accepted by"
<approver name>. In addition, if the second user clicks the Approve button that continues to remain
enabled, the following error message is displayed: "DM_WORKFLOW_E_ACCESS_ERROR: This
user does not have permission to perform the current operation is displayed".

Import operation fails while locating and importing missing
graphics in an XML document being imported (WEBTOP-5039)

While importing an XML document into Webtop, the import operation fails when missing graphics
are located and imported.

Internet Explorer browser crashes when you enable and disable the
thumbnail view (WEBTOP-5881)

If the machine where the Webtop server is installed uses a thumbnail server and RPTS, and you
enable and then disable the thumbnail view, the Internet Explorer browser window crashes when
you use the drag-and-drop feature.

An error occurs while importing a custom type document
(WEBTOP-1365, WEBTOP-7341)

An error occurs if you reselect the object type while setting properties for a custom type document
you are importing.

Unable to access a subfolder that contains a space at the end of its
name (WEBTOP-529, WEBTOP-7415)

Unable to access a subfolder that contains a space at the end of its name.
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Unable to save a search query as a template (WEBTOP-6578)

The following error message is displayed when you save a search query for a document although the
OR operator is not used in the search condition:
"Sorry this search cannot be set as template. Please change your search criteria
(no OR between properties, neither search only on object type)."

The ucf.client.config.xml FileNotFound exception occurs when you
perform some UCF-based operations (WEBTOP-7495)

The ucf.client.config.xml FileNotFound exception occurs when you perform UCF-based
operations such as Viewing Preferences, Checking in files, Checking out files, and so on. In
addition, the ucf.client.config.xml file is missing in the client UCF folder (C:\Documents and
Settings\<logon-user-id>\Documentum\ucf-java\<HOSTNAME>\shared\config). Alternatively,
the ucf.client.config.template.xml file is available in the folder.

Workaround: Close the Webtop browser window, ensure that you terminate the UCF JRE runtime on
the client, and then open a new browser window and log in to Webtop.

In Firefox browser, the Login page has the text fields appear
extended beyond the modal popup (162768/WEBTOP-392)

When you launch Webtop in a Firefox browser, the Login page has the text fields appear extended for
Spanish locale.

In the rich text editor, Font and Size strings appear vertically
(162956/WEBTOP-423)

When you create a new folder in a Cabinet, the Font and Size strings appear vertically in the rich
text editor for Korean locale.

The UI stops responding and displays an error when an
export operation is already performed on a file and is repeated
(163432/WEBTOP-1989)

When you perform an export of a file after an export operation already performed, the UI stops
responding and displays a CME error.
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Problems reported in previous versions

The following problems were reported in previous versions of WDK-based applications and may be
present in the current version.

Uninstaller for 5.x does not clean up classpath (59321, 66001)

When WDK or a WDK application of version 5.x is uninstalled, the classpath is not cleaned up on the
application server to protect DFC or other WDK products that may be installed.

Application server leaves temporary files behind if content transfer is
terminated by the user (71092)

The application server leaves temporary files behind if content transfer is terminated by the user. For
example, if you view a file and close the browser while the progress bar is on the screen, whatever
files have been saved by the server to its temporary directory for this transfer will not be cleaned.

To clear these files, you can periodically delete them from the temporary location
on the application server machine. The temp directory is defined by the setting
<contentxfer>.<server>.<contentlocationwindows> or <contentlocationunix> in app.xml in each WDK
application. The files are typically in "send" or "receive" subdirectories, which may contain another
level of subdirectories whose names are only digits.

View properties for workflow file in a foreign repository brings up a login
dialog (97209)

Workflow tasks from multiple repositories are supported, but a view properties operation on a
foreign file will cause a login dialog to be presented.

Importing a large XML file of custom type with many chunks fails and throws
exception (98126/WDK-545)

Importing an XML file with many (1,0002,000) chunks fails and throws an exception if the document
type is a custom type.

Cannot delete a folder that contains non-current objects (98538/WEBTOP-552,
114934/DFC-74)

If the current version of an object has been moved to another folder, but the original folder contains
non-current versions, that original folder cannot be deleted.
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Copy and link from one SSO repository to another SSO repository is not
working (104062/WEBTOP-5410, 104959/DFC-84)

In order to copy or link from one single sign-on (SSO) repository to another, the user must have
identical login credentials for the source and destination repositories for doing multiple operations.
The SSO and user-principal authentication mechanism is not supported.

Oracle/Solaris: Preferences page will not display; cannot drag and drop an
email (104213/WDK-180)

User is unable to display the Preferences page or drag and drop an email containing a file in .msg
format to an Oracle application server on Solaris. During import, the user gets a stack trace indicating
a FileNotFoundException for a missing file under DCTM_UCF_ROOT_DIR.

Checking out a non-XML root virtual document with xml children throws an
error (10623/WEBTOP-41462, 106442/DFC-68)

When you check out a non-XML root virtual document with xml children, an error message is
displayed.

Link dragged to desktop does not get proper name (111348,
118349/WEBTOP-2966)

When the link of a document is dragged to desktop, the link should have the same name as document
name, but the name is "Drag to desktop, email or document to create link, or right click to Add to
Favorites".

User preferences override custom subtype columns view (115495/WDK-1492)

If a custom implementation of objectlist_component.xml includes several definitions of objectlist
components using different object types scopes, and the user changes the preferred columns to be
displayed for one of the sub types, then the user selections override the display for every scope. That
is, an attribute that should be visible for one of the sub types may not be displayed to that user.

Drag and drop onto a virtual document causes the source and target folder
structure to collapse (115850/WDK-1499)

When the user drags a document from the browser tree onto a virtual document, the screen refreshes
and the entire virtual document structure is collapsed. In addition, the source folder structure in the
browser tree frame is also collapsed when the virtual document is checked in.
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XML chunking of Word document in XML fails (119541/WEBTOP-4861,
130693/DFC-64)

AWord document saved as XML can be imported with a simple XML application that chunks at the
<w:sub-section> level. But when the user views the chunk, the following error is displayed:
xxorg.xml.sax.SAXException;
Additional msg - object name: Introductionxx org.xml.sax.SAXException;
Additional msg - object name: chunk name

Leading spaces added to password entry are ignored (126348/DC-42, DC-2304,
130938/CS-24)

If the user enters a valid login password with extra spaces at the beginning, the password validation
should fail but does not.

DTD cannot be found on network path during checkin (128592/WEBTOP-5350,
130944/DC-42, DC-2304)

The DTD for an XML document will not be found for users whose UCF user directory in on the
network.

Date constraint is not conserved when editing a search (137723/WEBTOP-3084)

When you define a search with a constraint on both the name and the modified date, the constraint
on the date is removed if you edit the search.

Sorting by rank disappears after leaving the results page (138193/WEBTOP-
3106)

If you sort search results by rank, then leave and return to the results page, the results are no longer
sorted by rank.

Quotes used in a simple search are removed when switching to advanced
search (138591/WEBTOP-3116)

If you perform a simple search that includes one or more sets of quotes, and if you then switch to an
advanced search, the first and last instances of quotation marks are removed.

For example, if you type this in a simple search:

"Web services" "best practices"

then run the search, and then click the advanced search button, the values in the text field become this:

Web services" "best practices
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dm_message_archive objects cannot be copied (145224/WEBTOP-2402)

It is not possible to copy an object of type dm_message_archive either by adding to clipboard or
using drag and drop.

WDK-based application allows special characters (145820/WEBTOP-2426)

WDK-based application (Webtop) should not allow the following special characters. Some special
characters are allowed in RPS. Per fix in bug 92759 opened in RPS 5.3, they should be disallowed. The
special characters allowed are: ! @ $ % ( )‘ (this character is below tilde) + _ - , .

User cannot delete later versions if previous owner deleted an earlier version
(145984/WEBTOP-2430)

If the root version is deleted, and the ownership of later versions is changed to another user, that user
cannot delete the later versions. A DM_SYSOBJECT_E_NO_BROWSE_ACCESS error is shown if
the user tries to delete all versions.

While performing a content transfer operation Webtop displays an error
message (147254/WEBTOP-1538)

Error message is displayed (compatible Java Run time environment is not installed) while trying to
perform a content transfer operation such as checkin, checkout, and cancel checkout.

Word document name appears junk in HTTP mode (148341/WEBTOP-1581)

In HTTP mode, the document name appears with junk characters when you open a Word document
that contains special characters in the name of the document during export.

Multiple renditions of same format cannot be deleted singly (148439/WDK-1170)

If there are multiple renditions of the same format for one object, and the user deletes one of the
renditions, all are deleted.

Scrolling arrows are not displayed when there are more tabs
(148498/WEBTOP-1883)

In a tabbed container, under certain conditions, scrolling arrows are not getting displayed even when
there are more tabs to be scrolled to.
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Popup error message (148546/WEBTOP-1888)

In the Webtop 6.0.0.111, popup error message is displayed when you try to click on Select button
in the search tab in preference page.

Work item does not reach work queue when Java Method Server has been
down (150912/BPM-166)

If the Java Method Server is not running when a task is created, the task will not appear in the work
queue even after the Java Method Server is restarted. To retrieve the tasks that were created while the
Java Method Server was down, you must run the following script on the Content Server:
cmd>dmbasic -f reprocess_workqueue_tasks.ebs -e
Install -- <docbase> <superuser> <password>

You can retrieve tasks that were created before a specific date by modifying the query in the script
as in the following example:
query = "select r_object_id from dmi_workitem where r_runtime_state = 0
and a_held_by = ’dm_system’ and r_creation_date < DATE(’06/11/2008 13:18:44’)"

UCF content transfer operation fails in Oracle 10.1.3.3.0 environment
(153823/WEBTOP-1057)

UCF content transfer operation fails with ucf session wait timeout error.

Workaround: Comment out the following lines in webtop\WEB-INF\web.xml:
<init-param>
<param-name>wdk_cache_control_redirect_includepages</param-name>
<!- ending with ($) certain file extensions ->
<param-value><![CDATA[(\.gif|\.css|\.js|\.jar)$]]></param-value>
</init-param>

UCF content transfer operation fails in WAS 6.1.0.13 environment (154525)

UCF content transfer operation fails with ’ucf session wait timeout’ error.

Workaround: Configure the application server with an additional webcontainer custom property
’com.ibm.ws.webcontainer.invokefilterscompatibility’, and set it to true.

You must add the webcontainer ’com.ibm.ws.webcontainer.invokefilterscompatibility’ custom
property and set it to true using the Websphere Admin console; otherwise, errors will occur when
you attempt to access the Webtop URL. For more information about setting webcontainer custom
properties, see Setting webcontainer custom properties.

Breadcrumb does not show properly if the folder path contains hidden folder
(155352/WEBTOP-5009)

Breadcrumb does not show properly for the parent folders, if the folder path contains hidden folder
after the user has navigated to the hidden folder.
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When you delete a document, WDK-based application does not send the delete
notification and the name of the document is not available when the delete
notification is sent (159830/WEBTOP-4817)

If you have enabled notifications and delete a document after a particular sequence of actions,
WDK-based application does not send a delete notification to the Inbox. If a document is deleted
directly, then WDK-based application sends a notification to the Inbox without the name of the
document in it.

Importing a .msg file fails using Safari 3.0.4/mac10411 (161074)

The conversion of .msg (Outlook Message format) to EMCMF is only supported on Windows-based
client environment.

EMCMF- Export of folder that contains EMCMF format file which has an
attachment, exports the hidden folder as well (161373/WEBTOP-3937)

If you have enabled the messageArchive-support in the <WebApp Root>/web/app.xml
file and removed the comment for the executable sections ExMRE.exe from the <WebApp
Root>/wdk/contentXfer/ucf.installer.config.xml file, then exporting a folder that contains EMCMF
format file which has an attachment also exports the hidden folder.

There is no option in the folder view to go back to the Task Manager
(161511/WEBTOP-3939)

When you open a folder attached to a task of the Inbox, there is no option in the folder view that
allows you to go back to the Task Manager.

Deep export of a folder stops responding and import operation displays an
error when you perform Deep export of a folder within the same browser
session (161652/WEBTOP-3947)

When you try to perform a Deep export of a folder in a browser session, and import any of the
hierarchical folder during the same session, Deep export stops responding and import fails with an
error instead of successful Deep export and import.

Two read notifications are received when documents are opened for viewing
(161920/WEBTOP-3982)

If the read notification for subscribed documents is enabled, two read notifications are received, when
documents are opened for viewing in the WDK-based application browser.
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Export to CSV - Special characters inappropriate and MS Excel file generated
is incorrect (162009/WEBTOP-3992)

When you perform Export to CSV on a file, the MS Excel file generated is incorrect that has content
inappropriately placed under columns and also the special characters in Spanish are inappropriate.

Drag and Drop does not work for Subscription during the same browser
session (162266/WEBTOP-344)

Open an IE session and disable Drag and Drop in Webtop Preferences. Close the IE session and
reopen an IE session. When you try to drag and drop multiple files and folders (for example, from
Home Cabinet node to Subscription node in a new window) during the same IE session, Drag and
Drop does not work.

Unable to navigate using Previous button during multiple check in operation
(162403/WEBTOP-361)

Ensure that <default-mechanism>and </default-mechanism> tags in wdk/app.xml is set to HTTP.
When you select multiple files to check in, the previous button does not work after you select a file,
and then click the Previous button to go back to the previous page.

In multiple repositories, when the owner of the object and the owner of the link
are separate, incorrect lock/key icons are shown (162685/WEBTOP-387)

If the owner of the object and the owner of the link are separate in multiple repositories, then the link
gets checked out but there is a lock icon instead of a key icon for the link in WDK-based application.
In the source folder, the source file has a key icon instead of a lock icon, when you as the owner of
the lock performs an edit operation on link of the object created.

If you log on in a separate browser session and perform an edit operation on the link, then
WDK-based application displays icons appropriately.

Saving a Form instance displays an IE script error (162771/WEBTOP-393)

When you open a Form instance for edit and save the changes, WDK-based application displays an
IE script error.

The path reflected in the breadcrumb area is incorrect for the linked folders in
multi - repositories (162786/WEBTOP-396)

If you have a folder A linked to a folder B in a repository and the same folder is also linked to another
folder C in a different repository, the path in the breadcrumb area shows the latest linked path instead
of the actual path. (for example, <Cabinets>/<User1>/B/A instead of <Cabinets>/<User1>/A
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The contents of a linked folder from another repository are not exported
(162802/WEBTOP-400)

The contents of a linked folder from another repository does not get exported if you have copied
the contents of a linked folder to a clipboard.

Clipboard operations should be disabled for a linked folder from another
repository (162828/WEBTOP-407)

For a linked folder from another repository, clipboard operations should not work. If they are
allowed, then they should be visible in the UI of the linked folder’s list or its original location.

In UCF mode, when you import a folder, WDK-based application does not
perform the check for the folder name field (162939/WEBTOP-419)

When you perform an import of a folder, WDK-based application does not perform a check for
the folder name field as done during the creation of a folder and the folder gets created with the
name Untitled.

View clipboard is not enabled (162941/WEBTOP-420)

The View Clipboard appears disabled after you select a file and click Add to Clipboard from Edit.

WDK-based application throws an error when you press the Enter key after
you manually type the path of the file (162973/WEBTOP-426)

When you perform a check in operation in WDK-based application, WDK-based application prompts
you to locate the file when the file is not available in the default Checkout folder. You can browse
to the location of the file using the Browse button or manually enter the path of the file in the
text box. When you press the Enter key after manually typing in the path of the file, WDK-based
application throws an error.

If you log on as another user, the menu control item allows you to perform
operations (163094/WEBTOP-1970)

Due to failure of the validation of file_cancelcheckout menu item control, you are able to select an
object, check out and perform cancel check out operations.
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In IE 7, viewing a document using a DRL in the same IE window in a new tab
throws an ucf session wait timeout (163210/WEBTOP-1978)

In IE 7, log on to Webtop and ensure that <default-mechanism>and </default-mechanism> tags in
wdk/app.xml is set to UCF. Select a document and perform Email as Weblink from the File menu.
From the MS Outlook mail opened, copy and paste the DRL link to the IE browser. If you try to view
the file, Webtop displays a ucf session wait timeout error. You have to close the window and press
the Refresh or Reload button on your browser to continue.

The checked in file gets deleted after Check in is successful
(163242/WEBTOP-1979)

When you check in a file from the Checkout directory, and the file is not available in the Checkout
directory, Webtop prompts you to manually locate the file. You can manually locale the file and
perform check in. The manually checked in file gets deleted after Check in is successful.

Unable to sort the child documents in a VDM Editor in WDK-based application
(163590/WEBTOP-1993)

Log on to WDK-based application and click to open a document in Virtual Document Manager
(VDM). You cannot sort the child documents of the parent document by Name, Size and so on using
the Column header. The links does not work in the Column header.

WDK-based application hangs while creating a new document to VDM
(163606/WEBTOP-1995)

Log on to WDK-based application and click to open a document in Virtual Document Manager
(VDM). Select Virtual Documents from the Tools menu and then Add Child. When you add a child to
VDM with the Using New Document option, and permission to the user, the new document gets
created but Webtop hangs.

Webtop displays the ’Operation failed: Message not found’ message when
you set the type to dm_message_archive manually during import of a .msg
file (163835/WEBTOP-2006)

When the messageArchive-support is disabled in WDK-based applications, on import of an Outlook
message (.msg) file gets imported as a dm_email_message object, the import of an Outlook message
(.msg) file fails, in case you set the type to dm_message_archive manually.
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Data tables displays ID instead of empty values for the newly created entries
(163968/WEBTOP-2014)

When you edit a data table, the existing records must retain the values and the value of the new
entries should be empty. Instead WDK-based application, displays ID of the newly created entries
instead of empty values.

Workaround: Click on the data table again to refresh or use the browser refresh and this shows
empty values.

An error message is thrown when you click on the Column headers in
the attachments table found in the properties page of an EMCMF file
(164039/WEBTOP-2018)

Log on to WDK-based application and import an email that has an attachment in Archive mode. An
error message is thrown when you click on the Column headers in the attachments table found in the
Properties page of an EMCMF file.

Drop down lists displayed on a page hides menus in Internet Explorer 6 (IE 6)
(166881/WEBTOP-2691)

The dropdown lists displayed on a page hides the submenu items making them unusable in IE 6 when
you resize the window. Some of the menu items gets hidden by the overlapping dropdown menu.
For example, the Show Files and Folders dropdown appears overlapping the Tools sub menu items.

Workaround: If you restore the window size, the dropdown disappears or you can upgrade to IE 7.

Internet Explorer 6 (IE 6) fails to display the title of a modal popup window
(167362/WEBTOP-2722)

The title of the new modal popup of WDK-based application does not appear in the title bar (e.g. for
the properties dialogue of an object) correct label in IE 6.

A Workflow component fails to open as a modal popup in WDK-based
application (167364/WEBTOP-2725)

Except the component for starting a workflow (Tools > Workflow > Start and Tools > Workflow >
Start Attachments) fails to open as a modal popup while all the other components of WDK-based
application open in a modal popup

Deep export of a folder having special characters are not supported (167444)

Deep export of a folder having special characters (for example, :, ?, <>, ", |, *) are not supported. If
you try to export a folder having such special characters, then the application throws an error.
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Single value custom attribute with VA which is dependent on other custom
attribute is not refreshed with proper value, instead default value is displayed
(170123/WEBTOP-1300)

A single valued attribute with (Value Assistance) VA which is dependent on other custom attribute.
The drop-down values are not refreshed, based on the value of the dependent variable.

Copying EMCMF file with an attachment to the same location fails even
after dropping the unique constraint on dm_message_archive object type
(170258/WEBTOP-2466)

If you copy an EMCMF file with an attachment to the same location fails even after dropping the
unique constraint on dm_message_archive object type.

Problems reported in version 6

The following problems were reported in the 6 version.

BOCS: Checkout sometimes displayed incorrectly (131504/WEBTOP-3804/
WEBTOP-7266, WEBTOP-2475)

If a user attempts to check out an object whose content is not available because it is parked on the
BOCS server, a warning is displayed; but when the user selects cancel checkout in the dialog, the
object is still shown as checked out.

Workaround: Perform a cancel checkout operation on the object.

Escape key does not dismiss context menu (135125/WDK-1135)

When the user displays a right-click context menu, it cannot be dismissed by the escape key.

Workaround: Dismiss the menu by clicking elsewhere in the page.

Mac/Safari: Shortcut for search not working (139089/WDK-1247)

The keyboard shortcut for search, Shift+s, does not work on Safari on the Mac.

Workaround: Select the titlebar frame where the advanced search UI widget is located, and then hit
the shortcut Shift+s.
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RSA: Web workflow manager hangs at RSA timeout (142160/WEBTOP-2753,
WEBTOP-7225)

When the RSA session times out, the user should be presented with a login screen. Instead, the
application page hangs.

Workaround: Close the browser window and reopen, then log in again to the application.

Role precedence does not take effect when preset applies to current repository
(144864/WEBTOP-2389)

Role precedence can be configured in app.xml as described in the technical notes chapter of these
release notes. If a user belongs to more than one role, the configuration service applies the role and
user’s access to role-defined presets and scopes based on the precedence tree in app.xml However,
if a preset is defined for a role in only one repository, the user is assigned that preset instead of
the preset for the role with higher precedence.

For example, user Jane Doe belongs to roles abc and def, and the role abc comes first in the precedence
tree of app.xml. One preset is defined for role abc and applies to all repositories. One preset for role
def applies only to a single repository named XUP. When the user is in repository XUP, the preset for
role abc should be used for her, but it is not. JaneDoe gets the preset for role def.

Cannot deselect items by clicking white space (146537/WDK-288)

When an object is selected in the datagrid, the user expects to be able to click on white space to
deselect. Instead, the user must click on the selected object to deselect.

XML application may rename graphic files (146597/WEBTOP-1498)

When documents are imported from the client host, sometimes every graphic is renamed with the
prefix of the import location. For example, my.gif becomes CDocumentummy.gif. Every graphic is
renamed, and every link to every graphic in the XML document is changed to the new name upon
import. This may not be noticed until a subsequent checkout.

Browser resize makes some menus inaccessible (149311/WEBTOP-1921)

When users resize the browser to make it smaller, some menus do not wrap and are no longer
accessible to the user.

Known problems specific to Webtop

The following known problems apply to Webtop.
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On some Windows XP SP3 machines where Internet Explorer 6
browser is used and the JAWS 9 software is running, IE crashes
when the accessibility preference is set (WEBTOP-10297)

On some Windows XP SP3 machines where IE 6 browser is used and the JAWS 9 software is running,
when you log in to Webtop 6.5 SP2 or Webtop 6.5 SP3, and select the Turn accessibility options on
option in the Preferences dialog box, the IE browser window crashes.

Workaround:

Perform one of the following steps:

When you log in toWebtop, ensure that you expand theMore Options area, and select theAdditional
Accessibility Options option, and then click Login.

OR

Use JAWS 7 or JAWS 10 instead of using JAWS 9.

Unable to import email messages with trailing spaces in the subject
line (WEBTOP-7963)

When importing messages in which the subject lines contain trailing spaces, an error occurs and
the import operation fails if Webtop is configured to support the EMCMF mail format and 5.3.x
DocApps are used.

The content pane in a Webtop-based application appears blank
although a node is selected in the navigation pane (WEBTOP-10043)

If you extend the browsertree component in a Webtop-based application version that is earlier than
version 6.5, the content pane appears blank occasionally although a node is selected in the navigation
pane.

Workaround:

Extend the new browsertreeex component to resolve this issue.

File Download dialog box and the multi-file download browser
window are not displayed when HTTP content transfer operations
are performed using IE or Firefox (WEBTOP-9207)

If you perform an HTTP content transfer operation on one or more files using Internet Explorer
(IE) 6 or later, a message indicating that the pop-up is blocked or that IE has blocked the site from
downloading files, is displayed in the Information bar of the browser. When you right-click the
information bar, and select the Temporarily Allow Pop-ups option (in IE 6) or the Download File
option (in IE 7), the File Download dialog box is displayed.
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Similarly, if you perform an HTTP content transfer operation on one or more files using Firefox, a
message indicating that Firefox has prevented the site from opening a pop-up window, is displayed
in the information bar of the browser. If you click the Options button in the information bar and
select the Allow pop-ups for <Webtop URL> option to view the Opening <File name> dialog box.

Perform the following workaround to change the security settings in IE or Firefox, permanently.

Workaround:

To define security settings for the Webtop URL in IE:

1. Select Tools > Internet Options in the IE browser.
The Internet Options dialog box is displayed.

2. Click the Security tab, and select the Trusted sites zone.
The Trusted sites dialog box is displayed.

3. Specify the Webtop URL in the Add this Website to the zone field.

4. Click Add.

5. Clear the selection of the Require server verification (https:) for all sites in this zone option.

6. Click OK twice to close the Trusted sites and Internet Options dialog boxes.

7. Refresh the IE browser.
When you perform the HTTP content transfer operation for one or more documents using IE, the File
Download dialog box or the multi-file download browser window is displayed, successfully.

To disable the pop-up blocker in Firefox:

1. Select Tools > Options in the Firefox browser.
The Options dialog box is displayed.

2. Click the Content panel.

3. Clear the selection of the Block pop-up windows option.

4. Click OK.
When you perform an HTTP content transfer operation for one or more documents using Firefox,
the Opening <File name> dialog box or the multi-file download browser window is displayed,
successfully.

Checkin operation fails when it is performed using Internet Explorer
(IE) 8 (WEBTOP-8972)

If you check out a document, delete the checked out copy in the Checkout folder, and attempt to
check in the deleted document, Webtop prompts you to specify the name of the file to check in. When
you specify the name of another file available on your local machine, Webtop replaces the path of
the file displayed in the Check in from file field with the string "fakepath" and tries to check in
the file. For example, if you upload file.txt from the C:\users\contoso\documents\ path on your
machine, this path is set to c:\fakepath\file.txt in the Check in from file field. As a result, the checkin
operation fails and the AbortCurrentProcessingException occurs.
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This issue occurs because of a security constraint that is set in IE 8.

Workaround: You can upload files successfully by removing the relevant security setting in IE 8.

To disable the security constraint for uploading files using IE 8:

1. Select Tools > Internet Options in the IE 8 browser.
The Internet options dialog box is displayed.

2. In the Security tab select the Internet zone.

3. Click Custom Level.
The Security Settings dialog box is displayed.

4. In theMiscellaneous list, select the Include local directory path when uploading files to a
server option.

5. Click OK twice to save the settings.

DRL is not generated with the hostname and IP of the web server in
a Webtop SSO clustering environment (WEBTOP-8957)

The DRL in a Webtop SSO clustering environment is not generated with the hostname and IP
of the web server. Alternatively, the DRL is created with the following content: <application
server>/<managed node>/<internal server hostname>/<IP address>. As a result, when a recipient
clicks the DRL, the recipient is redirected to the Webtop login page instead of the SSO login page.

Workaround: Set the appropriate proxy configuration for your application server.

For example, you can configure your copy of the Tomcat application server to include a special
<Connector> element, with the following settings:
<Connector

port="8081" ...
proxyName="www.mycompany.com"
proxyPort="80"/>

The proxyName value can also be assigned with the IP address of the web server.

The setting defined in the example causes servlets in the web application to consider that all proxied
requests are directed to www.mycompany.com on port 80.

The Webtop application stops responding when you log in to
Webtop on a Solaris or Linux machine (WEBTOP-7736)

The Webtop application stops responding if you log in to Webtop using the Firefox browser on
a Solaris or Linux machine.
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UCF fails to download on a MAC OS client with JRE 1.4.2.x
(WEBTOP-3415, DC-89)

UCF fails to download on a MAC OS client where JRE version 1.4.2.x is installed.

Solution: Ensure that you have installed at least JRE version 1.5 on the MAC OS client.

A java error occurs when you click the Finish button before the
Import dialog box user interface is refreshed (WEBTOP-6125)

While the modal dialog box that is opened from the Import dialog box is being closed, the Finish
button in the Import dialog box appears enabled. If you click Finishwhile the Import dialog box user
interface is being refreshed, a java error occurs.

In Choose a folder frame, Name and Cabinet graphic icons are not
linked together and they are showing as two different columns
(WEBTOP-6231)

When you import a user, the Choose a folder page the Name column is disassociated with the
Cabinet name. While the Cabinet icon is displayed in the Name column, the name of the Cabinet is
displayed in a separate column.

Users with the dce_user_manager role are unable to perform tasks
in the collaboration room (WDK-1608)

Users created with the dce_user_manager (a non-administrative user manager) role are unable to
participate in discussion threads, check out documents, and edit documents in the collaboration
room, or upload new content into the collaboration room. Such users can only view the contents
of the room. Alternatively, if the Client Capability setting of the dce_user_manager role is changed
from "Consumer" to "Contributor", users with this role are allowed to contribute content to the
room and participate in discussions in the room. However, if the Client Capability setting is set to
"Contributor", such user accounts can no longer be edited.

Unable to edit the Author field for a document you own
(168946/WEBTOP-1230)

Although you have the Browse and Change Ownership permissions for a document you own,
Webtop does not allow you to edit the Author field for the document. However, if you are granted the
WRITE permission for the document, Webtop allows you to edit the Author field for the document.
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Workflow report generation is slow (146812/WEBTOP-1514)

Workflow reports are generated very slowly.

The MSG_START_WORKFLOW_FROM_DOC property is not
translated to Japanese (144861/WEBTOP-2388)

The MSG_START_WORKFLOW_FROM_DOC property is not translated to Japanese in the
MenuBarNlsProp_ja_JP.properties and GenericActionNlsProp_ja_JP.properties files.

Translation of strings in the Japanese interface for Quickflow is
incomplete (144888/WEBTOP-2391)

When you view users in the Quickflow interface, text in the column heading do not appear in the
Japanese language.

Workflow report fails to list all running workflows sometimes
(145316/WEBTOP-2405)

When you view a Workflow report, the report displays blank rows occasionally. Webtop fails to list
the running workflows in the report.

Some strings in the Japanese Webtop User Guide are not
internationalized (160303/WEBTOP-5712)

Some words in the Japanese Webtop User Guide continue to appear as English words because they
are not internationalized.

Webtop stops responding after you close multiple new windows
(WEBTOP-6139)

If you open multiple new or additional windows using the Selection dialog box or the Tools > New
Window option, Webtop stops responding after all the additional windows are closed.
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You are prompted to restart the computer when the drag-and-drop
plugin is upgraded to a later version (WEBTOP-6571)

After enabling the drag-and-drop feature in Webtop 6.0 and logging out of Webtop, if you log in to
Webtop 6.5 using the same browser session and enable the drag-and-drop feature, the drag-and-drop
plug-in is upgraded and you are prompted to restart your computer instead of being prompted
to restart the browser.

Junk characters displayed in topic titles in the Table of Contents
pane of the online help

If a topic title contains ‘s (apostrophe + s), the Firefox browser will substitute that character with a
‘junk’ character. This issue does not occur in Internet Explorer.

Workaround: View the HTML help in Internet Explorer.

Unable to create a PDF for a file in the EMCMF format
(WEBTOP-2056)

Log in toWebtop that uses a repository enabled with CTS/ADTS.When you import an EMCMF format
file that contains a .msg file, and transform the EMCMF file to PDF, the PDF rendition is not created.

The File > About Webtop requires to be resized manually to view
the controls in the Internet Explorer 6 (154725/WEBTOP-1103)

In Internet Explore 6, the browser displays the status bar in the popup window that consumes space
and you have to manually resize the dialog box to view the controls. When the About dialog height
gets increased, the modal popup window layout appears improper in IE 7.

Opening an EMCMF format file that is attached to a workflow
template occupies the entire Webtop page (162691/WEBTOP-389)

Log on to Webtop and select Start Attachments from Workflow in Tools menu. Select a Workflow
template from Workflow template to an EMCMF format file. If you select an activity and open an
EMCMF format file from Inbox, the EMCMF format file that is attached to a Workflow template does
not open in a new window.
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The search results display the repository name instead of the
search text for Russian locale (162958/WEBTOP-424)

The search results display the repository name instead of the search text for Russian locale.

Drag and Drop operation failed during import message
appears during drag and drop from Desktop to Webtop
(163963/WEBTOP-2012)

When you perform a Drag and Drop operation on the Cabinet node, Webtop throws an error message.

Workaround: Navigate to the desired cabinet and perform the Drag and Drop import operation.

Unable to create a pdf for EMCMF format file (164503/WEBTOP-2056,
WEBTOP-7294)

Log on to Webtop that uses a repository enabled with MTS/ADTS. When you select the EMCMF
format file and transform to pdf format, the operation fails in Webtop.

Drag and Drop export of sub versions is not successful
(164748/WEBTOP-4481, WEBTOP-7115)

When you perform a drag and drop operation fromWebtop to your desktop on a document from the
Versions page, the operation is not successful while you are in the Versions page that has at least three
previous versions of documents from the View menu.

Unable to create a pdf for EMCMF format file that has an attachment
(164956/WEBTOP-4495)

Log on to Webtop that uses a repository enabled with MTS/ADTS, and import a .msg file that has
a dm_document as an attachment. When you select the EMCMF format file and transform to pdf
format, the operation fails in Webtop.

Drag and drop of multiple files from Webtop to desktop results in
the export of only a single document instead of all the selected
documents (170602/WEBTOP-2484)

Drag and drop of multiple files from Webtop to desktop results in the export of only the highlighted
single document instead of all the selected documents.
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EMCMF file gets corrupted when exported from Webtop to
Desktop through Drag and drop in 2008 server and Vista machine
(170890//WEBTOP-2515)

Drag and drop feature does not export a dm_message_archive object sporadically on Windows Vista
and 2008 OS. It is recommended to use the Export Action to export these files.

Importing an email message fails (170752/WEBTOP-2494)

The Operation failed: Conversion of mail message failed error message appears when you import an
email message. This happens as ES1_MRE does not get downloaded into the client machines with
application server and content server are set to Arabic regional settings.

Firefox crashes after you log on to Webtop in Sun JRE 1.4.2_18 and
Windows 2008 (167380)

When you log onto Webtop using the Firefox browser with JRE 1..4.2_18, and Windows 2008
environment, it throws an error.

Unable to create a pdf for EMCMF format file that has an attachment
(164956/WEBTOP-4495)

Log on to Webtop that uses a repository enabled with MTS/ADTS, and import a .msg file that has
a dm_document as an attachment. When you select the EMCMF format file and transform to pdf
format fails in Webtop.

Known problems specific to Webtop Federated Search

The following known problems apply to Webtop Federated Search in Documentum 6.5, which
include the following:

Sorting disappears when navigating clusters (137716)

If you sort search results by any criteria, then navigate search clusters, the results are no longer sorted.
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The search fails if you add quotes to a property value when
searching external sources (132942)

If you add quotes to a property value when searching external sources, the search fails.

Known problems specific to Documentum Collaborative
Services

This section describes known defects in EMC Documentum Collaborative Services (DCS) software
that may affect your use of the product.

Data table choice list options cannot be reordered (130179)

If you create a table with a choice list field, you cannot reorder the choices once you create them.

Properties dialog box has various broken appearances when
multiple calendar events are selected (135208)

Documentum 6 supports viewing and setting properties of multiple items, but the Properties dialog
box has various problems if you select multiple data table entries or calendar events.

Field names in New Table Entry may be displayed in wrong
language (136521)

Data tables are created in the default locale for the repository. If field names are then added in a
different locale, the actual attribute name will be used for display.

Image in rich-text folder description does not display when Webtop
is behind proxy firewall (136933)

When Webtop is behind a proxy firewall, viewing a folder with a rich-text image description does
not show the image.
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In Internet Explorer 7, cannot type characters in discussion titles
on containers (138648)

Using Internet Explorer 7, if you create a container (such as a folder or a room), and enable discussions
on the container, in a discussion comment you are unable to type the following characters into the
title: %, &, (, ], and ’

Missing options in advanced search dialog box for calendars
(141383)

In the Advanced Search dialog box, for object type Calendar Event, the following options should be
there but are not: the Properties list should contain Recurrence; the Date list should contain Start
time and End time; when Start or End is selected from the Date list, the characters "=", "<", and ">"
should be available; when Organizer is selected from the Properties list, the next list should have
more options such as "contains", "begins with", and so on. Also, the search operation should be
successful when searched on Organizer name and the Attendee name.

Rows do not inherit permission set on data tables in room (141647)

If a governed data table in a room has its permissions changed, new rows do not inherit the changed
permissions, but instead get the shared room ACL. This is correct for governed folders but not
for data tables.

Copy of subscribed room automatically added to the Subscriptions
list (142178)

When the copy of a room is accessed the first time, the subscription prompt should appear. However,
no subscription prompt appears yet the Subscriptions node shows both the original room and the
copy.

When discussion column is not visible in summary view of data
table, View > Discussion is grayed out (142193)

View > Discussion is grayed out when the discussion column is not visible. You should be able to
view the discussion whether or not the column is displayed in summary view.

EMC Documentum Webtop Version 6.5 SP3 Release Notes 171



Known Problems and Limitations

Name of imported calendar event is replaced by name of ics file
(142564)

When an ics file is renamed, the name of an imported event is replaced by the name of the ics file. It
should retain the name of the original event.

Backspace or Delete does not work when editing rich text in Firefox
(148721)

When editing rich text in Firefox, you cannot Backspace or Delete until you enter a character.

Audit trail for workitem not using business calendar (149042)

The audit trail for a workitem that uses a business calendar is not updated and shows the system
calendar time rather than the business calendar.

Special characters garbled in data table import from .csv file
(151619)

When you import into a data table from a .csv file that contains special characters (such as French) in a
plain text field, the import completes without error but the text is mangled in the new row of the table.

Error occurs when a non-current version of an object is made to
be governed by a room (157528)

When a non-current version of a governed object is removed and then added to the same room, the
non-current version should be governed by the room but it is not, and an error occurs.

Only the current version of a document is moved (159863)

If a folder containing a document with multiple versions is moved from a room to a new folder
and then the room is deleted, if the document is moved to another folder, only the current version
is moved.
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Comments not visible in Activity Template (162040)

Comments are not visible in the target location with selected activity of the type "Package Comments
for Discussion". All comments entered while processing workflow activities from your inbox should
be summarized in the comments to the folder. However, none are stored inside the target location.

Note that an alternative way to expose discussions is to leverage the Web Service.

Attachment field deleted by user with WRITE permission only
(163886)

Attachment field is deleted when user with only WRITE permission to an attached document edits
the schema of a data table.

Deleting data table with checked-out attachment deletes another
entry instead (164107)

If you attempt to delete a data table that has an entry with a checked-out attachment, the data table is
not deleted. Instead, an entry other than the one with the checked-out attachment is deleted.

Error occurs when importing a .csv with a blank member list field
into a data table with a member list field defined (164123)

In a data table with a schema that includes a member list field, importing a .csv file that contains a
blank member list field causes an error.

Unable to create a new object with an assigned ACL (167668)

An error message appears, when you attempt to create a new object, assign an ACL name and domain
to the object, and link the object to a room.

Unable to create a room using Webtop 5.3x with Content Server
6.5 (168936)

When you attempt to create a room using Webtop 5.3x with Content Server 6.5, an error message
appears.
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Unable to import a message to a room created in collaboration
mode (170846)

When you create a room by installing a collaboration DAR file and attempt to import a message to
the room, an error message appears.

Known problems specific to Application Connectors

The following known problems apply to Application Connectors.

An error occurs while installing Documentum Application
Connectors (DAC-505)

If you install Documentum Application Connectors on a machine where .NET is not installed,
the Application Connectors installer launches the .NET 1.1 installer automatically. However, the
following error message is displayed when the .NET installer is running:

"Only users with administrator privileges on the local system can run Microsoft .NET Framework
Setup. Setup will now close."

Solution: You must ensure that you install .NET as an administrator before you install Documentum
Application Connectors as a power user.

Documentum Application Connectors installer always attempts to
install .NET when a power user runs the installer (DAC-506)

Although .NET 1.1 or 2.0 is installed on the machine, if you install Documentum Application
Connectors as a power user, the Application Connectors installer attempts to install Microsoft .NET.
However, the installation fails and you are prompted to proceed or terminate the installation. If you
choose not to install .NET, the Documentum Application Connectors is installed successfully, and the
Documentum Application Connectors product functions properly.

An error occurs and the menu options of the application connector
appear disabled in Webtop (162416/DAC-496)

When you log in to Webtop for the first time on the Windows platform, and edit an MS Office
document, the application connector’s menu options in Webtop appear disabled, and an error occurs.
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Documentum Application Connector prevents the proper unloading
of the VBA code associated with automated workbooks (DAC-463)

If Documentum is integrated with MS Excel, and you open a workbook containing macros using
MS Excel, access the VB editor where the VBA project is listed, close the workbook, open it again,
and access the VB editor, the VBA project is listed twice. For example, you open a VBA-automated
workbook in Excel after enabling macros in the workbook, and access the VB editor, the
HelloWorldProject project is loaded into the memory. If you close the workbook, and open the
workbook again, the VB Editor displays two instances of the project, HelloWorldProject.

The Documentum Application Connectors menu in MS Word is
replaced by the Adobe Comments menu (DAC-467)

COM add-ins use Normal.dot template of MS Word to define and store menus. If Adobe Acrobat
version 7 or 8 (or a similar application) is used with DAC in MS Word, these add-ins may conflict
with the DAC COM add-in for MS Word, and may corrupt the DAC menu, or may prevent the DAC
menu from appearing in the toolbar.

Workaround: The recommended workaround is to upgrade to Adobe Acrobat 9. Alternatively,
you can delete the Normal.dot template (locate the file in the following path: ..\Documents and
Settings\<NT user name>\Application Data\Microsoft\Templates) every time this problem occurs.

Custom macros for MS Office Applications may conflict with DAC

When custom macros are present along with DAC for MS Office applications, these macros may
conflict with DAC and not function properly as the conflict may occur when Application events
such as close and save are triggered.

Problem uninstalling Documentum Application Connectors SDK
using Remove option (122592/DACSDK-23)

When both Documentum Application Connectors and Documentum Application Connector SDK are
installed in a machine and when you try to uninstall the Documentum Application Connector SDK
using the Remove option, the Documentum menu in the Documentum Application Connectors is
removed.

Workaround: Double-click Documentum-AppConnectors-Client.exe. A window opens up with
repair/modify and remove option. Select the repair option and click the finish button to repair the
Documentum Application Connectors. Now, the Documentum menu reappears in the Office
Application.
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Removal of the Documentum menu from the TextEditor of SDK
(131347/DAC-188)

When you install and uninstall Documentum Application Connectors on a machine which already
as Documentum Application Connectors SDK installed results in removal of the Documentum
menu from the TextEditor of SDK.

Workaround: Execute the SDK msi exe. This will open a window with the repair/modify and
remove option in the window. Select the repair option and click the finish button to repair the SDK
TextEditor. Now, the Documentum menu reappears.

Non-Admin user can run the installation of DocumentumApplication
Connectors without any error message (152978/DAC-56)

On a Windows machine, log on as a user without any administrator privileges and try to install DAC
6.5. The installation allows you to install Application Connectors without any error message. The
DAC 6.5 installation must display a warning message that you do not have administrative privileges
to install Application Connectors.

MS Office XP SP3 throws ’Conversion of mail message failed’ error
while importing a .msg mail format message to the repository as an
EMCMF format (165092/DAC-367)

Log on to a repository fromMS Outlook. Select a .msg format message and save as an EMCMF format
message from the Documentummenu. MS Outlook throws ’Conversion of mail message failed’ error.

’Do you want to overwrite the already existing files’ dialog appears
while viewing the EMCMF format message from the repository for
the Second time (165103/DAC-368)

When you try to open an EMCMF format message for the second time, ’Do you want to overwrite the
already existing files’ dialog appears instead of opening the mail.

Limitations
This section describes limits on the usability of current functionality. The limitations may be part of
the product design or may result from issues with associated third-party products.
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Limitations common to all WDK applications

This section describes limitations that are common to WDK and all WDK applications.

WDK-based applications encounter classloader-related problems
(WEBTOP-1986)

If WDK-based applications are deployed in a BEA WebLogic 9.2x or 10.0 MP1 Server environment,
the applications will encounter classloader-related problems.

Workaround:

Modify the BEA classloader behavior in one of the following ways:
• Using the prefer-web-inf-classes element

• Using Filtering ClassLoader

Note: If you encounter a similar issue using other versions of BEA WebLogic, apply the workaround
documented in this section.

Using the prefer-web-inf-classes element

You can change the BEA WebLogic system classloader behavior for the application by setting
the value of the prefer-web-inf-classes tag to true in the weblogic.xml file available in the
<WDK-based application>\WEB-INF folder, and adding the modified file into the WEB-INF folder of
the <WDK-based application>.war file.

To modify the BEA classloader behavior:

1. Add the following configuration in the weblogic.xml file that is available in the <WDK-based
application>\WEB-INF folder:
<!DOCTYPE weblogic-web-app PUBLIC "-//BEA Systems, Inc.//DTD Web Application
8.1//EN" "http://www.bea.com/servers/wls810/dtd/weblogic810-web-jar.dtd">
<weblogic-web-app>
<description>Weblogic Webapp</description>
<container-descriptor>
<prefer-web-inf-classes>true</prefer-web-inf-classes>
</container-descriptor>

</weblogic-web-app>

2. Add the modified file into <WDK-based application>.war

Using Filtering ClassLoader

You can use the Filtering ClassLoader mechanism to configure the WDK application classloader
deployment descriptors and explicitly specify that classes bundled in the WDK-based application.war
files must always be loaded from the relevant application, and not by the BEA WebLogic system
classloader. However, this method of changing the BEA class loading behavior for the WDK
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application requires configuring the application and weblogic-application XML files, and repackaging
the application .war file as a .ear file, and then deploying the .ear file on the BEA WebLogic Server.

To configure the Filtering ClassLoader:

1. Open the META-INF\application.xml file and define the name of the .war file for the relevant
application in the web-uri tag:
<"xml version="1.0" encoding="UTF-8"">
<application xmlns="http://java.sun.com/xml/ns/j2ee" xmlns:xsi="http://
www.w3.org/2001/XMLSchema-instance" version="1.4">
<module>
<web>
<web-uri><WDK-based application>.war</web-uri>
<context-root>/<WDK-based application></context-root>
</web>
</module>
</application>

Note: The application.xml file references the application in the web-uri element. Ensure that
the application war file name defined in this tag matches the .war file name that you deploy.

2. Open the META-INF\weblogic-application.xml file and add a prefer-application-packages
descriptor element as described below. This descriptor element details the list of packages to
load from the application.
<"xml version="1.0"">
<weblogic-application xmlns="http://www.bea.com/ns/weblogic/90"
xmlns:xsi="http://www.w3.org/2001/XMLSchema-instance">
<application-param>
<param-name>webapp.encoding.default</param-name>
<param-value>UTF-8</param-value>
</application-param>
<prefer-application-packages>
<package-name>org.apache.xerces.*</package-name>
<package-name>org.apache.xml.*</package-name>
</prefer-application-packages>
</weblogic-application>

3. Create a EAR file using Win Zip or WinRAR with the following content and relative directory
references:
• <WDK-based application>.war

• META-INF\application.xml

• META-INF\weblogic-application.xml

4. Deploy the application in the BEA WebLogic application server environment.

A stack overflow occurs when some content transfer operations
are performed (WEBTOP-8869)

When a user with only the Read permission on a specific document or cabinet checks out that
document or creates a folder or document in that cabinet on a computer where a JRockit version prior
to BEA JRockit 5.0 (R27.3.1) JDK is installed, a stack overflow occurs.
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Unable to create BOCS objects while running WDK-based version
5.3x applications (DC-1738)

If you are running WDK-based version 5.3x applications and you have configured the BOCS server to
serve Content Server 6.x, you will not be able to create BOCS objects. You can create BOCS objects for
WDK-based applications 5.3x only if the BOCS server serves a 5.3x Content Server. Therefore, it is
recommended that you use Documentum Administrator 5.3x to create BOCS config objects in the
BOCS server that serves a 5.3x Content Server.

Error messages appear in the WebLogic log file when a file transfer
operation is performed (WEBTOP-1896)

There is no response when an end user performs a file transfer operation, and the following error
messages are listed in the WebLogic log file:
• Caused by: DfException:: THREAD: ExecuteThread: ’23’ for queue: ’weblogic.kernel.Default’;
MSG: [DM_SESSION_E_AUTH_FAIL]error: "Authentication failed for user ts77714 with docbase
xxxxx."

• <Error><WebLogicServer><tktpcfcimap1><webtopj- server><weblogic.health.
CoreHealthMonitor><<WLS Kernel>><><BEA-000337> <ExecuteThread: ’4’ for queue:
’weblogic.kernel.Default’ has been busy for "1,657" seconds working on the request "Http Request:
/webtop/com/documentum/ucf/server/transport/impl/GAIRConnector", which is more than the
configured time (StuckThreadMaxTime) of "600" seconds.>

The error occurs because of a thread usage limitation in UCF design. This UCF design limitation
occurs on WebLogic implementations only. DocumentumWDK is designed to spend a larger number
of threads than the total number of concurrent users on the basis of the following formula:

Number of threads = (Number of users performing content transfer * 2) + Number of other active
users not performing content transfer operations + Threads required for other browser requests

While UCF works on its own thread using the WDK browser thread, it calls and launches another
thread to perform the task of transferring the file. As a result of this thread usage behavior, the
number of threads used, exceeds the ThreadCount setting, which in some cases, is the maximum
thread count value in the Execute Queue in WebLogic.

In addition, this limitation leaves a waiting thread in the thread queue if the value of the ThreadCount
setting in WebLogic is less than the required number. This is because of the thread-call design of
UCF where the UCF client launches the secondary function on a different thread although there are
no free idle threads. As a result, the status of the UCF client is wait-for-release, and the following
thread is noticed when a thread dump is collected:
"ExecuteThread: ’27’ for queue: ’weblogic.kernel.Default’" daemon prio=5
tid=0x00a38d88 nid=0x29 in Object.wait() [0xcf001000..0xcf0019c0]
at java.lang.Object.wait(Native Method)
at
com.documentum.ucf.server.transport.impl.ServerSession.waitReleaseStreams
(ServerSession.java:690) - locked <0xd6c5c3a0> (a java.lang.Object)
at
com.documentum.ucf.server.transport.impl.GAIRConnectorServlet.doPost
(GAIRConnectorServlet.java:80)
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Workaround:

WebLogic server diagnoses a thread as stuck if it is continually working (not idle) for a set period of
time.

You can fix the Stuck Thread problem by performing the following steps:

1. Modify the thread pool size.
The relation between the number of concurrent users and the number of threads must be on
the basis of the following formula:
Number of threads = (Number of users performing content transfer * 2) + Number of other active
users not performing content transfer operations + Threads required for other browser requests
The computed value must approximately be 2.5 to 3 times the number of active users.

2. If the problem persists, collect thread dumps and application server logs in the following manner:
1. Watch the application server log and trace the threads that are reported as stuck.

2. If threads are reported as stuck for more than 2 to 3 hours, you must collect thread dumps
at an interval of 4 to 5 minutes. Collect 8 to 9 thread dumps in the specified time intervals.
Collect a final thread dump after 20 minutes counting from the time you collected the 9th
thread dump.

3. Collect a final application server log and 4 to 5 thread dumps before shutting down the
application server.

The thread dumps and application server logs display the same threads that were listed in
the log collected in step 2.1.

Limitations reported in earlier versions

The following limitations were reported in previous versions of the product and may exist in the
current version.

Unable to select text in dialog boxes (166880/WDK-1824)

Webtop users are not allowed to select text in dialog boxes in Webtop. For example, you cannot
select text in the Properties dialog box.

This is an issue with Internet Explorer (IE), and it is not a Webtop issue.

Unable to copy text from any dialog box in Webtop to the clipboard (WDK-1452)

Unable to copy selected text from any dialog box in Webtop using version 6 of the Internet Explorer
(IE) browser. This is an issue with Internet Explorer (IE), and it is not a Webtop issue.
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Create New Folder button is not displayed in the Select Folder dialog box while
exporting files from Webtop (167523/WEBTOP-2730)

While exporting files from Webtop, the Create New Folder icon is not available in the Select Folder
dialog box.

This is a problem with the JFileChooser API. The Create New Folder button is disabled incorrectly.
For more information about this issue, click this URL: http://bugs.sun.com/bugdatabase/view_bug.
do?bug_id=4847375

Show All Properties may not work (64824, 65092/WEBTOP-5995)

When the application server locale does not match the locales in the repository, the Show All
Properties feature does not work. For example, if you have installed the application server on an
English machine locale (en) and the repository has only one installed locale, which is Japanese, the
query attempts to retrieve information for the repository locale.

Solution: Publish the data dictionary information for the application server locale in the repository.

One actionmultiselect control per page (62228)

If you are customizing a WDK application, do not use an actionmultiselect control in more than
more place in a frameset.

The import dialog is not populated with sent and receive dates
(105321/WEBTOP-4108)

The import dialog is not populated with Sent date and Receive Date. If the attribute type
is IDfTime and the attribute component is used, the value is not displayed. This is because
DocbaseAttributeValueTag.java does not support the attribute type IDfTime. The import dialog is
not populated with Sent date and Receive date.

Silent import does not apply preset ACL (131470/WEBTOP-3802)

A new object will get the default ACL from the Server Config unless the user explicitly goes to the
Permissions UI and selects the preset ACL value.

Errors from TBOs or aspects are not displayed in WDK applications
(139378/WDK-1248)

Aspects and TBOs do not have a mechanism to propagate error messages to their clients, in this
case, to the WDK application.
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Custom attributes cannot be handled by ScrollableResultSetDataHandler
(94837)

Custom attribute handling is by DFCQueryDataHandler and any other data handler class that
implements ICustomAttributeDataHandler. You need to use these classes to get this additional
functionality. ScollableResultSetDataHandler is not Documentum-aware, so it is not appropriate to
add custom attribute handling to it.

Unable to perform a case-sensitive search with full-text index

Search on properties against an indexed Content Server is case-insensitive.

Workaround: If you need to have case-sensitive search for properties, you must set the DisableFTDQL
hint in a DQL hints file for all attribute searches. This may impact the performance negatively on
most searches.

Backward compatibility

Running WDK 5.x applications in the same application server instance as WDK 6 applications is not
supported. Two or more WDK-based version 6 applications can share the same server instance.

Page not found errors if HTTP 1.1 not enabled in client browser

The browser reports Page not Found when the user clicks on a cabinet or folder. You must enable
HTTP 1.1 in the IE browser in the Tools > Internet Options > Advanced tab. In the HTTP 1.1 settings
section, check Use HTTP 1.1.

No template available for ASCII files

The Content Server does not install a template to create a new ASCII file (crtext). Workaround: You
can either create a file with format = none, or you can create an ASCII file template in your server
templates folder.

Bulk file import requires Import Manager

The capacity of the application to perform large numbers of file imports, or imports of very large
files, depends on several factors: user load, network bandwidth, server memory capacity, application
server memory settings, and the number of files or folders that users are attempting to import. The
number of files can be limited by configuring the <max-import-files-and-folders> element in the
import container component definition. The default value is 1000, but this can be set lower. The
product Import Manager is designed for bulk file import.
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ACS is not used to view HTTP content unless configured to break virtual links

ACS is not used to view HTTP content as shipped. In order to display HTTP content through ACS,
the <maintainvirtuallinks> parameter must be set to false. Setting <maintainvirtuallinks> to false will
mean that relative links in documents will not work, however. ACS can be used for HTTP Edit,
Checkout, and Export since these operations don’t display content within the browser.

Localized characters not supported with virtual links (69570)

Non-ASCII characters are not supported in virtual links because they are used in URLs, which are
limited to ASCII-only characters. A workaround is to use DRLs.

PDF opens in new browser window (71118, 96304)

The default setting for IE is to open a new window for each PDF file being viewed inline.

Workaround: Open IE Tools menu > Internet Options > Advanced > Browsing and check Reuse
windows for launching shortcuts.

Owner cannot delete document when group is deleted (71026)

This limitation is pending resolution of Content Server bug #71113

If a group to which a document owner belongs is deleted and that group was given Delete
permissions on a document, the document owner will not be able to delete the document.

Browser Back button causes problems with subsequent operations (73971,
74061)

Using the browser Back button can cause problems with refreshing the display. This may cause
problems if the user performs subsequent operations based on this display. For example, if a user
checks out an object, then uses the Back button on the browser, the lock is not displayed and the
user can check out the document again. A second example is if the user deletes a document on the
Versions page, then clicks the Back button on the browser, the deleted document is still displayed,
but if the user tries to perform an operation involving the deleted document on this page, a generic
error message appears.

Problems checking in a version as noncurrent (74112)

If the user checks in a document as a new version but chooses not to make that the CURRENT
version, then the CURRENT version becomes immutable. You cannot then attach a lifecycle to
the CURRENT version.
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Templates must be manually moved to Templates cabinet in order to share
them with other users (74114, 74296)

When the user checks the template box on the document’s PropertiesInfo page, the template must be
manually moved or copied to the Templates folder in the repository, or users will not have access to it.

Browser pop-up blocker prevents some application pages from opening
(84279, 104215/WDK-181)

Windows XP SP2 installs a pop-up blocker that is enabled by default. If you are using Windows XP
SP2 and Internet Explorer, the Windows pop-up blocker prevents some WDK-based application
pages from opening.

For example, the following pages are blocked:

• DQL and API Tester page

• Online help pages

• Error pop-up window

• PDFs for annotation by PDF Annotation Services

To solve this, add your WDK-based application server to the pop-up blocker’s Trusted Sites list.

PDF document does not open in HTTP content transfer (96072)

If the Adobe Comment Connector is enabled in app.xml and the document preferred format is PDF,
the document cannot be opened, viewed, or commented in HTTP content transfer mode. Adobe
Comment Connector requires UCF content transfer.

Some large documents cannot be streamed inline (97284)

If the user preference is set to stream a document type inline in the browser, some documents may
fail to stream. This is dependent on the limitation of the browser plugin for that document format.
For example, the Microsoft Word plugin does not support streaming. PDF byte-serving (streaming
page by page) is not supported by the Documentum platform.

Cannot check out a virtual document through its replica and check it in from
the source (101572/DFC-843)

Checking out a virtual document from replica repository, then checking in the virtual document to
the source repository, is not supported. You must check it out and back in from the same repository.
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Private JRE in UCF installation is large (103154/WDK-152, 126906/WEBTOP-
5292, 126912/DC-57)

The private JRE that is downloaded by UCF is larger than one megabyte. If there is no JRE on the
browser machine, there will be a new JRE downloaded and installed. To avoid the lengthy download,
the administrator can install the JRE prior to transferring content.

UCF content transfer operations fail on Windows Vista (132632/ DC-28 ,
134461/WEBTOP-957, 134478)

Content transfer operations such as import, export, view, checkout, check in, preferences, and so on
fail on Windows Vista operating system on IE7 with User Account Control (UAC) on.

Workaround: Choose one of the following
• Turn off UAC for each user

• In the browser, add the site to the list of Trusted Sites in IE7. In the application, set the UCF
client configuration registry.mode value to file instead of windows. For information on these
procedures, refer toWeb Development Kit and Webtop Deployment Guide.

No failover in components that call DFC or BOF classes using instance
variables (145202/WDK-266)

Instance variables cannot be used in components that support failover, because they cannot be
serialized. If the component calls a DFC class or business object that uses an instance variable, the
component cannot support failover.

Limitations reported in version 6

The following limitations have been reported for version 6.

Some functionality not available on 5.3.x Content Server

If a user connects to a 5.3.x Content Server, the following functionality will not be available. These
features require Content Server version 6 (in addition to the global registry version 6):
• Presets

• Accelerated Caching Services (ACS) and Branch Office Caching Services (BOCS) write operations

• Create relationships

• Lifecycle enhancements in the properties, checkin, import, and new document pages
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Presets not applied to search results

Presets that filter available objects based on location, object type, or user are not applied to search
queries or results.

"Search here" is not available in a context menu (129198/WEBTOP-3715)

If the user right-clicks on a folder, Search here is not one of the available actions.

Presets do not filter out columns (129637)

A column selector filter exists in the presets DocApp but has not been implemented in the presets
editor. If the user attempts to select columns in the preset editor

Group is still listed in the preset page after the group is deleted (137144)

Type, group, user, and role preset scopes are stored by reference to their name so that the preset
can apply to multiple repositories if it is configured to do so. If the user deletes a group from one
repository but not another, the preset should still contain the group name because it may apply to
other repositories. It is not feasible to check whether the group has been deleted from all repositories.

Cannot use ctrl-tab and ctrl-shift-tab to move within tabs (138522/WDK-1241)

The Windows navigation within tabs is ctrl-tab to move forward and ctrl-shift-tab to move backward.
These are not available.

Workaround: Use the tab and shift-tab shortcuts to move forward and backward through tabs.

Mac OS X upgrade to 1.4.11 breaks WDK applications

An upgrade from the certified Mac operating system of 10.4.10 to 10.4.11 installs Safari 3, which is
incompatible with the current version of WDK-based applications.

Drag and Drop of a folder from Webtop to Desktop is not supported
(163006/WEBTOP-431)

Drag and Drop of a folder from Webtop to Desktop is not supported.
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Drag and drop link operation across repositories is not supported
(163600/WEBTOP-1994)

Drag and drop link operation fails for the respective folder/document and a message is displayed
indicating that the link operation across repositories is not supported.

Workaround: Clipboard can hold multiple documents, and You can use the Clipboard for moving,
copying or linking to another location in the repository.

Limitations specific to Documentum Collaborative
Services

The following limitation applies to Documentum Collaborative Services.

In data table plain text and number fields, blanks appear
at beginning of ascending sort order instead of at the end
(132927/WEBTOP-2139)

In a data table view, sorting plain text and number field columns in ascending order places the
blanks at the beginning before the alphabetic entries. They should sort with alphabetic values first,
followed by blanks.

Limitations specific to Application Connectors

The following limitations apply to Application Connectors.

Busy cursor is displayed for a long time in the Security Alert dialog
(102362/DAC-101)

When you click ’No’ to cancel the Documentum operation in the ’Security Alert’ dialog box while
Application Connector is pointed to an SSL Webtop URL, a busy cursor is displayed for a long time
and you are not allowed to perform any other operations with Office applications.

With 2 instances of Outlook open, the second does not have
Documentum menu (123460/DAC-27/DAC-572)

If you open a second instance of Microsoft Outlook, the second instance does not have the
Documentum menu. This is a limitation of MS Outlook for all add-ins.
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Unable to verify the URL dialog in Application Connectors installer
(102200/DAC-100, DAC-565)

When you enter a valid SSL Webtop URL in the Enter Webtop URL dialog box of the Application
Connectors installer, the Unable to Verify URL dialog box is launched with the following message:
Setup could not connect to this URL. Would you like
to save the URL and continue anyway?

Click No to edit the URL and test it again. Click Yes only if you are sure the URL is correct.

Even though this message is displayed, you can connect to the URL and it does not prevent from
installing.

Limitations specific to Webtop

The following limitations apply to Webtop.

Although the Link Here action is excluded in the Edit menu and the
Context Menu while creating a Preset, users are allowed to link
documents using the drag-and-drop functionality (WEBTOP-6516)

Although the Link Here action is excluded in the Editmenu and the Context menu while creating a
Preset, the Context menu that is displayed when you right-click and drag a document to another
folder, continues to list the Link Here option. When you select this option, Webtop allows you to
link the selected document.

Drag-and-drop actions are not supported for Presets. As a result, the Context menu that is displayed
when you right-click and drag a document to another folder, will always list the Link Here option.

Unable to install ExMRE manually on the Windows 7 operating
system (WEBTOP-10210)

If you manually install the Email Xtender executable (ExMRE.exe) on the Windows 7 operating
system, an error occurs and ExMRE is not installed.

This error occurs because ExMRE does not support Windows 7 in 6.5 SP3 although Webtop 6.5 SP3
supports Windows 7 platform with Internet Explorer 32-bit browser.
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Unable to attach multiple files while starting a Workflow
(WEBTOP-5812)

When you select more than one file to attach to a workflow while starting the workflow, only one file
is attached and sent to the user’s Inbox. After the first file is attached an error message is displayed
indicating that the remaining files do not apply to the workflow template.

Limitation of associating multiple files with a workflow

The selected files must match the process or workflow template to which you are attaching them,
in the following ways:
• The number of files selected to attach with a workflow must be equal to the number of packages.
If the number of files exceeds the number of packages, only the first few files are used to start
the workflow.

• The object type of the files must match the type defined in the package.

• The object version label of the files must match the label defined in the package.

Search string option is unavailable in Webtop online help
(WEBTOP-8649)

When the Webtop online help is viewed using Firefox 3.5.2 or Firefox 3.5.5 the Search string text box
is not displayed in the navigation pane.

This behavior is a design limitation.

Workaround:

Click the Accessible Help Documentation.pdf link in the Webtop online help window to open the
help PDF and use the full capabilities of Acrobat search to locate the required content.

Preferences are not saved when the Webtop session times out or
the browser window is closed (170670/WEBTOP-2491)

User preferences and preferences set in the Preferences page are not saved when the Webtop session
times out or the browser window is closed. This issue occurs only if the Webtop application is
deployed on IBM WebSphere Application Server 7.0.

Users accessing the Webtop application that is deployed on IBMWebSphere Application Server 7.0,
are recommended to log out of the Webtop application using the Logout option or the Logout button
to save user preferences and the preferences set in the Preferences page.
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Unable to add favorite items using the Context menu in Internet
Explorer (IE) 8 (WEBTOP-9125)

When you select a document in Webtop, right-click the document, and select the Add to Favorites
option, the Add a Favorite dialog box is not displayed and the document cannot be bookmarked.
In addition, when you click the Add to Favorites icon and select the Add to Favorites option in the
Properties dialog box of a document, the Add a Favorite dialog box is not displayed.

Modal popup dialog boxes stop responding when the ucf resident
invoker is disabled (WEBTOP-6131)

After modifying app.xml to disable ucf resident invoker, if you log in to Webtop using Internet
Explorer 6 or 7 on a machine where JRE 1.6 update 12 or later is installed, any modal popup dialog
box stops responding when it is opened while performing operations such as export and checkout.

Linking a folder between rooms fails occasionally
(148719/WEBTOP-6526)

Linking a folder with contents from roomA to roomB occasionally fails the first time when using
newly created rooms.

The Files dialog box fails to display folders and files properly while
importing files to Webtop (WEBTOP-5998)

When you browse a folder containing a high volume of files to select a file to import into Webtop, the
Files dialog box does not display the folders and files properly.

This is a problem with the JFileChooser API. Poor performance is reported when there is a
large number of files in a subdirectory. For more information about this issue, click this URL:
http://bugs.sun.com/bugdatabase/view_bug.do?bug_id=6468222.

The status of a file changes to Checked Out when it is checked out
to a read-only folder (159291/WEBTOP-4794)

When you check out a file to a folder for which the Read-only attribute is set, Webtop displays an
error message but the status of the file is changed to Checked Out. The WDK-based application
displays an error message that the Checkout location folder does not have the Write permission and
the status has changed to Checked out.
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Graphics are not displayed when you view the Web Workflow
Manager online help using Firefox (WEBTOP-6567)

When you view theWeb Workflow Manager online help using the Firefox browser, graphics in the
online help are not displayed.

Slow script warning message appears when some operations are
performed in Webtop (WEBTOP-4474)

The slow script warning message may appear in the Webtop application when certain operations are
performed (export, breadcrumb navigation, and so on).

Workaround: To avoid this issue, you must unselect the Enable Runaway JavaScript Timer option in
the Debugmenu in Safari 3.0 or earlier, or select the Disable Runaway JavaScript Timer option in
theDevelopmenu in Safari 3.1 or later, prior to logging in to Webtop. For instructions on configuring
the Enable Runaway JavaScript Timer option or the Disable Runaway JavaScript Timer option, see
the WDK and Webtop Deployment Guide.

Webtop times out when you click a Webtop URL in an MS Office
document (WEBTOP-6746, WEBTOP-6211)

When you click a link to a Webtop URL in an MS Office document on a machine where Internet
Explorer (IE) 6 is installed, Webtop is opened. However, after you log in to Webtop, the Webtop
session times out and the login page is displayed.

This is a known issue from Microsoft. You can use the workaround suggested at the following URL:
http://support.microsoft.com/kb/899927/en-us

Limitations specific to accessibility

The following limitations apply to WDK-based applications specific to accessibility.

JAWS reader fails to read the label in the Available Actions page
(WDK-1656)

In the Memberships page that is displayed when you click the View Current User Memberships link
in the Available Actions page for a selected user, the Group icon is not associated with the "Name"
column, and the JAWS reader fails to read the label of the "Group” icon.
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Label of the Additional Accessibility Options checkbox is read
thrice (WEBTOP-6067)

When you log in to Webtop for the first time and select the Additional Accessibility Options
checkbox to enable accessibility features in Webtop, the JAWS application reads the label of the
Additional Accessibility Options checkbox thrice in the Login page.

Workaround: By default, accessibility must be enabled when the Webtop login page is launched. To
enable accessibility in the WDK layer, the app.xml file must be modified as follows:

<accessibility>
<alttextenabled></alttextenabled>
<keyboardnavigationenabled></keyboardnavigationenabled>
<shortcutnavigationenabled></shortcutnavigationenabled>

</accessibility>

With this change, the Additional Accessibility Options check box on the login page will always be
selected. You must unselect this option to disable accessibility.

Label for password field read twice

Label for password field is read twice. For example, JAWS reads as ’Password Password Edit’. You
can correct this by making the following changes in configuration:
Workaround: The accessibility mode to be ’enabled’ when the login page is launched. To enable the
accessibility mode in the WDK layer, the app.xml file needs to be modified as follows:

<accessibility>
<alttextenabled></alttextenabled>
<keyboardnavigationenabled></keyboardnavigationenabled>
<shortcutnavigationenabled></shortcutnavigationenabled>

</accessibility>

With this change, the Accessibility Checkbox on the login page will always be selected. For
non-accessibility mode, you need to deselect this.

Fields are not marked mandatory in the Login page

Fields that need to be marked as mandatory are not mentioned as mandatory. For example, the Login
name and password fields are mandatory fields of the form.

Workaround: The accessibility mode to be ’enabled’ when the login page is launched. This
workaround is required for the login page as there is no accessibility information available at the
time of first login.
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Autocomplete suggestions that appear as dropdown list are not
being read out by JAWS

The autocomplete suggestions that appear as a dropdown list are not read out by JAWS.

Workaround: Autocomplete feature has been disabled for the accessibility mode.

EMC Documentum Webtop Version 6.5 SP3 Release Notes 193



Known Problems and Limitations

194 EMC Documentum Webtop Version 6.5 SP3 Release Notes



Chapter 6
Technical Notes

This section provides configuration and usability notes for current product features.

Technical notes common to WDK applications
The following technical notes apply to all WDK-based applications.

Webtop does not automatically define a unique name
to a file while checking it out to the Checkout folder
(WEBTOP-10051)

When you check out a document in Webtop into the Checkout folder in which a read-only file with
the same name as the document you are checking out already exists, Webtop prompts you to provide
an alternate file name for the file you are checking out. Webtop does not implicitly create a new file
with a unique file name in the Checkout folder on your computer.

This behavior is by design.

Workaround:

You can change the behavior to ensure that Webtop does not prompt you to provide an alternate file
name while checking out a file in Webtop if a file by the same name already exists in the Checkout
folder. Alternatively, you can configure Webtop to download the content with a new file name, which
is similar to the original name of the file in the Checkout folder. For example, if the original file name
is a.xml, then the checked out version of the file is named as a_2.xml.

Add the following option to the virtual_root/wdk/contenXfer/ucf.installer.config.xml file available on
the application server:
<option name="prompt.file.overwrite">
<value>false</value>
</option>

To change the behavior for a specific user, add the specified option to ucf.client.config.xml
(available in {user.home}\Documentum\ucf\{hostname}\shared\config directory) on the user’s
computer. Restart the javaw process running on the client computer to ensure that the setting takes
effect. This setting is applicable to compound and simple documents.
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Configuring request input timeout value for DFC and
UCF events

Configure the <requestinput-timeout> configuration parameter in the wdk/app.xml file by specifying
an appropriate value, to ensure that stuck threads are released. The default value is zero. The value is
specified in seconds. This value is set for request input timeout for DFC and UCF events.

If you specify a non-zero (+ve) value for this parameter the JobAdapter thread waits for input from
the user until the specified duration is exceeded after which the thread is released. Alternatively, if
the parameter value is zero, the Job Adapter thread waits for user input for the duration specified in
the <session-timeout> parameter available in the <session-config> element in WEB-INF/web.xml.

Modify the value of the <requestinput-timeout> parameter that appears as follows in the
wdk/app.xml file:
<requestinput-timeout>0</requestinput-timeout>

Passing additional Virtual Machine parameters to the
UCF Client from the application server

You can pass additional VM parameters, such as debugging instructions, to UCF clients by
setting the relevant configuration in the application server. Add the following option to the
virtual_root/wdk/contenXfer/ucf.installer.config.xml file available on the application server:
<option name="java.startup.options">
<value>[Valid Java Parameter][Separator character that does not exist in any of the
listed java parameters] [Valid Java Parameter]…</value>
</option>
<option name="java.startup.options.separator">
<value>[Separator character]</value>
</option>

Example 6-1. Configuration to set the memory heap size

<option name="java.startup.options">
<value>-Xms100m; -Xmx500m</value>
</option>
<option name="java.startup.options.separator">
<value>;</value>
</option>

Example 6-2. Configuration to carry out remote debugging of a UCF client

<option name="java.startup.options">
<value>-Xdebug; -Xnoagent; -Xrunjdwp:transport=dt_socket,server=y,suspend=y,
address=5009</value>
</option>
<option name="java.startup.options.separator">
<value>;</value>
</option>
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Configuring Oracle WebLogic Server 11g R1 (10.3.1)
and later

For the Oracle WebLogic Server 11g R1 (10.3.1) and later, add the following configuration in
weblogic.xml that is available in the webtop\WEB-INF folder:
<session-descriptor>
<cookie-http-only>false</cookie-http-only>
</session-descriptor>

Converting existing EMCMF messages to the new
EMCMF format

You can configure the Webtop application to import email messages with the .msg extension as
dm_message_archive type objects that are stored in the repository with the .emcmf extension.
The msg to EMCMF message format conversion utility (ES1_MRE) is used to convert these email
messages in the msg format (.msg files) to the EMCMF format (.emcmf file). Besides importing the
converted messages into Webtop, the emfimport component extends the import component and sets
various email attributes on the imported email. The msg to EMCMF message format conversion
utility is also used to convert .emcmf files to .msg files while exporting EMCMF files.

Note: A separate migration utility is available to migrate existing messages of dm_email_message
type (and its subtypes) and the .msg format to the dm_message_archive type (EMCMF) or one
of its subtypes.

The msg to EMCMF message format conversion utility available in Webtop 6.5 SP1 has been modified
in Webtop 6.5 SP2. As a result, when you upgrade from Webtop 6.5 SP1 to Webtop 6.5 SP2, you are
recommended to convert all existing Webtop 6.5 SP1 EMCMF objects (dm_message_archive type) in
each repository, to the Webtop 6.5 SP2 EMCMF format using the latest version of the message_id
conversion utility.

For instructions on using the message_id conversion utility, seeWebtop 6.5 SP2 Email Migration Guide
posted on the Powerlink website (http://powerlink.EMC.com).

Note: If existing EMCMF messages are not converted to the latest EMCMF messages, and such
messages are imported into Webtop, the de-duplication check on the message_id of the messages will
fail and the same messages are imported. So the repository will contain two copies of the message,
each with a different message_id.

Enabling the wild-card CONTAINS operator for string
properties

The Content Server version 6 treats the CONTAINS operator as CONTAINS WORD to avoid
wild-card query timeouts against the full-text index. Following are two examples of CONTAINS and
CONTAINS WORD queries:
• If the user searches on a property string in the advanced search page, for example, CONTAINS
"wdk", this string is treated as a string " wdk ", so that the documents named "wdkindex or
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"search_wdk would not be returned but the documents named "wdk treats" or "About WDK"
will be returned.

• If the user searches on a property string "ran", CONTAINS "ran" in the old mode returns
"Restaurants.txt", "Insurance.pdf", "Warranty.xls", "Ran" by Kurosawa.doc and "On the Run.pdf".
(Note that the last one requires lemmatization on the index server.) In the new, default
CONTAINS WORD mode, only the last two examples are returned.

Most queries that users issue are for whole words, not parts of words. The query will return the
same results for string properties entered into the full-text search box or selecting a property with
the CONTAINS (WORD) operator. Whereas in past versions, lemmatization contributed to timeout
errors by multiplying the number of results, lemmatization becomes a helpful feature.

You can revert to the wild-card CONTAINS operator behavior by enabling a checkbox in the
advanced search JSP page. This checkbox will query the database rather than the full-text index for
property strings. Recently modified properties that have not yet been indexed will also be returned.

Note: The properties query against the database will be case-sensitive.

To enable the checkbox, remove the JSP comment tags around the <dmfxs:searchscopecheckbox> tag
in the JSP page.

Creating a roles precedence tree

When presets conflict, such as a user who belongs to two roles, each of which has different
available actions, the applicable preset is randomly applied. You must modify app.xml to specify
the precedence of roles. The role precedence is applied based on the order in which roles appear
within the <rolesprecedence> element. For example, if the user is member of both the consumer and
the administrator roles, and the consumer role is listed first, the user will not have administrator
presets applied. The following example, in a file appxml_modifications.xml in custom/config, sets
the administrator role to take precedence over the consumer role in repository A and the opposite
precedence in the staging repository B:
<application modifies="wdk/app.xml">
<insert path=rolemodel>
<rolesprecedence>
<filter docbase="A">
<role>administrator</role>
<role>coordinator</role>
<role>contributor</role>
<role>consumer</role>

</filter>
<filter docbase="B">

<role>consumer</role>
<role>contributor</role>
<role>coordinator</role>
<role>administrator</role>

</filter>
</rolesprecedence></insert></application>

When you configure rolemodel precedence in app.xml and refresh the configurations in memory,
the precedence may not be applied for up to ten minutes, because roles are cached for ten minutes
on the application server. You can stop and restart the application server to get an immediate
change in precedence.
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Note: After a filtered precedence is used, it cannot be refreshed by the configuration service. You
must stop and restart the application server to get a change in filtered precedence.

Enabling or disabling the ACS/BOCS write mode

The change in Webtop 6.5 SP1 is that the file <webapps-root>\webtop\wdk\app.xml that can be
modified to enable or disable ACS/BOCS write mode.

By default, sync write (and async write) are disabled in Webtop. For Webtop 6.5 SP1, sync write is
enabled by default. You can disable it by changing the appropriate setting in the XML file of the web
application (<webapps-root>\webtop\wdk\app.xml) as shown in the following example:
<accelerated-write>
<!--when set to be "true", enables ACS, and, when optimal, BOCS write operations-->
<enabled>true</enabled>
<!--when set to:
1. "prohibit-async" - application doesn’t allow BOCS write asynchronously
2. "default-sync" - application should see content written from BOCS to ACS

synchronously by default
3. "default-async" - application should see content written from BOCS to ACS

asynchronously by default-->
<bocs-write-mode>default-sync</bocs-write-mode>
<!--when set to "true” allows override of default BOCS write mode by users

(in general, it should be scoped with <filter> tag, e.g., role-based)-->
<allow-override-bocs-write-mode>false</allow-override-bocs-write-mode>

</accelerated-write>

The application server hangs when you click on the +
sign when the folder has a thousands of subfolders
(165687)

Webtop does not allow an user to expand a folder that has thousands of subfolders if the number of
folders exceeds a configurable parameter specified in the DocbaseFolderTreeMaxFolderToShow value.
When a folder has thousands of subfolders, and you click on the + sign from the browser tree, you can
only see a link that displays "2004 objects...". For example, if you click on this link, the browser tree
attempts to load all the 2004 objects that causes the application sever to run out of memory and hang.

When you deploy Webtop, a configurable parameter that allows the browser tree to render nodes
in the browser tree. If you exceed this configurable parameter, you cannot use the browser tree
node to expand the subfolders. You can only expand and view the desired folder from the parent
folder on the right pane.

If you want to tweak the configurable parameter to an optimal value, then you can arrive at a number
on a trial and error basis. The configurable parameter is "DocbaseFolderTreeMaxFolderToShow”,
and defined in the "DocbaseFolderTreeNlsProp.properties” file that can be found in the following
location: <context root>\wdk\strings\com\documentum\web\formext\control\docbase”.
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Technical notes specific to Webtop
The following technical notes apply to Webtop.

Choose the destination option is not displayed when
the Export operation is performed (WEBTOP-8914)

If a document or folder is exported to a machine where Native UCF is enabled and JDK/JRE is
disabled, the Select Folder dialog box is not displayed.

Ensure that the supported JDK/JRE is installed and configured on the client machine.

The Import dialog box does not display the Add Files,
Add Folders, and Remove buttons (WEBTOP-8913)

If Webtop is running on a computer where Native UCF is enabled and JDK/JRE is disabled, the
Import dialog box does not display the Add Files, Add Folders, and Remove buttons.

Ensure that the supported JDK/JRE is installed and configured on the client machine.

If the Advanced Search operation is performed with the
Current Location only option selected, the operation
fails (WEBTOP-8522)

If you perform the Advanced Search operation by selecting the Current Location only option in the
Locations field, the search operation fails. In addition, the following error message is displayed:
"Scope Unreachable”. This error occurs if a folder name specified in the search path contains the
semicolon (;) character.

It is recommended that you do not use the semicolon or any special character in folder names. If
a folder name includes such characters, and an Advanced Search operation is performed with this
folder as location, the operation fails.

Value Assistance attributes are not refreshed in Webtop
running in the accessibility mode (WEBTOP-6171)

In the Properties dialog box, if there are object types that have value assistance queries that depend
on each other, the Properties dialog box is not refreshed in Webtop running in the accessibility mode.

The "onChange" event used in the normal mode is not used in the accessibility mode. The
"onkeypress" event is used instead of the "onChange" event. You must press the Enter key after
selecting an option in the dropdown list for the refresh operation to be performed. Select the required
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attribute from the dropdown list and press the Enter key. The page is refreshed and the dependent
attributes are also refreshed.

The Advanced Search dropdown list is not refreshed
in Webtop running in the accessibility mode
(WEBTOP-6169)

The Advanced Search dropdown list is not refreshed in the accessibility mode.

The accessibility mode uses the "onkeypress" event instead of the "onclick" event and hence you must
press the Enter key for the selection and refresh operations to be performed.

Users can subscribe only to the latest version of a
repository item

When you subscribe to a repository item, you are subscribed only to the current version, which is
the latest version of the item. For example, if you select a repository item that has multiple versions,
and the latest version is 1.3, and you subscribe to version 1.2, you are subscribed to version 1.3 of the
repository item, and not to version 1.2 of the same item.

This behavior is common to all previous and current versions of Webtop.

Help pages without helpcontextid not displayed in 6.5

In 6.5 release, when you click on the help button for components that do not have a helpcontextid
associated with it, the help page will not be displayed (in a similar scenario, the help pages of
parent/previous components were displayed in earlier versions of Webtop).

New role created to prevent any user from delegating
workflow tasks (162770/BPM-262, BPM-1008)

In earlier releases, any user can delegate workflow tasks after installing Process Engine. To prevent this
from occurring, Process Builder version 6.5 SP1, includes a new role dm_workflow_task_supervisor
for work queue management. If a task needs to be processed by other users other than the task
performer, workflow supervisor, or sysadmin, then other users need to be a member of this new role.
The queue_manager and queue_advance_processor roles are members of this role.

For more information on this role, refer to Documentum System Object Reference Manual.
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Business Calendar Prerequisite (162776)

Webtop 6.5x must have Process Engine installed on the Content Server in order to use the Business
Calendar feature. For Webtop 6.0x, the BPM DocApp must be installed on the repository to use
this functionality.

Technical notes specific to Application
Connectors
The following technical notes apply to Application Connectors.

Allow multiple Citrix users to use Application
Connectors (DAC-559)

The Administrator who starts CredentialManager.exe must not log off from the Citrix server
after installing Documentum Application Connectors (DAC) on the Citrix server, because the
Administrator is the owner of the process that holds the credentials for all users. Therefore, it is
recommended that only the Administrator must install DAC on the Citrix server to allow multiple
Citrix users to use Application Connectors.

Application Connectors and Webtop compatibility

We recommend that you always use the same version of Documentum Application Connectors
(DAC) as the version of Webtop running in your environment. DAC works at the previous level of
functionality and does not break when installed in a mixed DAC and Webtop environment.

For example, if you work with Webtop 6.5 SP1, and then install DAC 6.5 SP1, DAC works with the
latest 6.5 SP1 functionality. If you work with Webtop 6.5 and then install DAC 6.5 SP1, DAC works
only at the previous 6.5 level and does not break.

The behavior of Save As has changed

When you perform a Save As operation, Documentum Application Connector (DAC) creates a copy
of the document in the repository as a new file, locks the new file in your name, and opens the new
file in the editing application. The document from which you performed the Save As operation, is
closed and remains unchanged.
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Admin or Power User privileges are required to install
Application Connectors

Admin or Power User privileges are required to install Application Connectors.

DAC for Outlook does not function properly if SQL
Server 2005 is running on the client machine (DAC-371)

Documentum Application Connectors (DAC) for Outlook does not function properly if SQL Server
2005 is running on the client machine.

Application server should be running when you install
Application Connectors (103580)

When you install Application Connectors, you are prompted for the URL of a valid application
server. The application server for which you type the URL should be running or the menu definition
file will not be downloaded to client and the Documentum custom menu will not be visible for
Word/PowerPoint/Excel applications. If the application server is started after the installation of
Application Connectors, users must should log out and log in again to their client workstation. As a
result, the Application Connectors runtime can download their necessary menu configuration.

Microsoft Word and Excel force you to save even when
no changes were made (111215)

If you open a repository document for editing through Microsoft Word or Excel, and if you then select
File>Exit without making any changes, you will get a dialog box asking you to save the document
(either into the repository or locally), even though you did not make changes. You can select No if
you do not want to save the document. This behavior indicates that Word and Excel automatically
change the file modified date and time when you open a document, thus making it appear that the
document’s content has been changed.
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Documentation

This section describes the documentation related to this product.

Webtop documentation set
These documents comprise the Webtop documentation set for this version of the product:

• Webtop Release Notes, version 6.5 SP3 (this document)

• Webtop User Guide, version 6.5 SP2 (P/N 300-009-270 A01)

• Web Development Kit Release Notes, version 6.5 SP3

• Web Development Kit and Webtop Deployment Guide, version 6.5 SP2 (P/N 300-009-274 A01)

• Web Development Kit Development Guide, version 6.5 (P/N 300-007-231 A01)

• Web Development Kit Tutorial, version 6.5 (P/N 300-007-232 A01)

• Web Development Kit and Webtop Reference Guide, version 6.5 (P/N 300-007-233 A01)

• Webtop Email Migration Guide, version 6.5 SP2 (P/N 300-009-492 A01)

• Collaborative Services Deployment Guide, version 6.5 SP3

Obtaining the correct documentation
The Powerlink website (http://powerlink.EMC.com) contains the downloadable packages for specific
product versions along with the release notes, installation guide, and other relevant documentation
associated with the product version. To locate product documentation, navigate to Support >
Technical Documentation and Advisories > Software ~ D ~ Documentation, then select the product
name and version number.

Note: The majority of Content Management products are listed under Software D > Documentum
?, where ? = a letter, or letters, in the alphabet.

Product documentation that is available online from the application (as online help) does not appear
as a separate item; it is automatically downloaded and installed with the software.
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Documentation corrections and clarifications
This section lists corrections and clarifications to the product documentation.

Incorrect reference to Webtop Extended Search as a
licensed option in the WDK and Webtop Deployment
Guide

TheWDK and Webtop Deployment Guide incorrectly reflects that the Webtop Extended Search is
a licensed option. Webtop Extended Search no longer requires an additional license, and any
Webtop/WDK customer can download Webtop Extended Search.

Incorporate the following changes in theWDK and Webtop Deployment Guide:
• Change the following statement from: "The extended search features are available as a licensed
option, which requires the installation of DARs in addition to the WDK-based application.” to:
"The extended search features require the installation of DARs in addition to the WDK-based
application.”

• Delete the following note: "Although Webtop Federated Search Service (FS2) is a licensed option,
no license file is required for the DAR installation.”

Incorrect context-sensitive help topics are displayed
in the Webtop user interface (WEBTOP-9009,
WEBTOP-9011, WEBTOP- 9013, WEBTOP-9014,
WEBTOP-9031)

Incorrect help topics are displayed when you click the Help icon on the following pages:
• Resume Workflow — the Resume a paused workflow help topic must be displayed

• Halt Workflow — the Pause a workflow help topic must be displayed

• Delegate — the Delegate a task help topic must be displayed

• Abort Workflow — the Stop a workflow help topic must be displayed

• Add Comment — the Perform a task help topic must be displayed

Incorrect documentation in the Send a quickflow
section of the Webtop User Guide (WEBTOP-965)

Step 6 in the Send a quickflow section of theWebtop User Guide indicates if a quickflow is configured
by selecting the Return to Me option, then a notification is sent to the supervisor after a user
completes a quickflow task.. This is incorrect.

206 EMC Documentum Webtop Version 6.5 SP3 Release Notes



Documentation

Modify Step 6 as follows:

Select the Return to Me option to ensure that the quickflow is assigned to you again after the task is
completed by all users/groups to whom it is assigned.

Webtop online help and Webtop User Guide PDF
display the "???” and "()” characters in some content
(WEBTOP-8968)

Redefine the cross-reference at the end of the following line that currently displays the "???” and "()”
characters in the Use modal dialogs section of the Webtop online help and theWebtop User Guide
PDF, respectively:

"This feature provides modal popup dialogs for action screens involving dialogs.”

Incorrect help topic is displayed when you open
Webtop help from your Inbox (WEBTOP-7818)

When you open the Webtop online help while accessing your Inbox, theWorkflows and Quickflows
topic is displayed instead of the Inbox overview topic.

Update the WDK and Webtop Deployment Guide with
additional information on configuring Oracle WebLogic
Server 11g R1 (10.3.1) and later (WEBTOP-9450)

Create the Configuring Oracle WebLogic Server 11g R1 (10.3.1) and later section in the Completing
the Deployment chapter in theWDK and Webtop Deployment Guide and add the following content:

For the Oracle WebLogic Server 11g R1 (10.3.1) and later, add the following configuration in
weblogic.xml that is available in the webtop\WEB-INF folder:
<session-descriptor>
<cookie-http-only>false</cookie-http-only>
</session-descriptor>
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Correction to content in the Webtop User Guide
(WEBTOP-3402)

Replace the content in the second bullet under Step 1 of the To start a workflow section in theWebtop
User Guide with the following content:

If your workflow is designed to include multiple packages, select Tools >Workflow > Start
Attachments and choose one document for each package.

Incomplete documentation about the Queue_processor
role in the Webtop User Guide (WEBTOP-8610)

Add the following documentation for the Queue_processor role in theWork queue roles section of
the Webtop User Guide:

Users with the Queue_processor role do not select the tasks on which they work.

Incorrect information in the Webtop User Guide
(WEBTOP-223)

The following content in Step 6 of the Send a quickflow section of theWebtop User Guide is incorrect:

To receive a notification when a user completes the review, select the Return to Me checkbox.

Change the content in Step 6 as follows:

Select the Return to Me checkbox to receive a task when a user completes the review.

Update the Webtop User Guide with additional
information on subscription

Users can subscribe only to the latest version of a repository item. Add the following content in the
first paragraph in the Subscriptions section of theWebtop User Guide:

When you subscribe to a repository item, you are subscribed only to the current version, which is
the latest version of the item. For example, if you select a repository item that has multiple versions,
and the latest version is 1.3, and you subscribe to version 1.2, you are subscribed to version 1.3 of the
repository item, and not to version 1.2 of the same item.
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Additional information for the WDK and Webtop
Deployment Guide

Add the following line at the end of the Caution note in the Enabling Documentum Collaborative
Services section of theWDK and Webtop Deployment Guide:

For more information, see the Documentum Composer User Guide.

In addition, change the Caution tag to a Note tag.

Incorrect references to "Webtop Federated Search
(WFS)” in the WDK and Webtop Deployment Guide

Chapter 11 in theWDK and Webtop Deployment Guide contains references to "Webtop Federated Search
Service (FS2)". These references must be changed to "Webtop Federated Search (WFS)”.

Correction to content in the WDK and Webtop
Deployment Guide

Update the content in the Changing the classloader and compiler settings section of theWDK and
Webtop Deployment Guide as follows:

Modify the content under "Configure the settings as follows:” as indicated:
<jspAttributes xmi:id="JSPAttribute_1178213473751"
name="jdkSourceLevel" value="15"/>

Add the following code if you are using WAS 6.1.0.21:
<jspAttributes xmi:id="JSPAttribute_3" name="useJDKCompiler"
value="true"/>

Modify the first sentence in the Setting com.ibm.ws.webcontainer.invokefilterscompatibility to
true” section as follows:

If you are using WAS 6.1.0.21, you must add the webcontainer com.ibm.ws.webcontainer.
invokefilterscompatibility custom property and set it to true using the WebSphere Admin console;
otherwise, all UCF content transfer operation will fail.

Correction to content in the Documentum Collaboration
Services online help (DCS-7)

The description of the usage and restrictions for the permanent_link attribute of RichText type is
incorrect in the Documentum Collaboration Services online help.

The documentationmust clearly state that the permanent_link attribute for the "dmc_richtext_relation"
of the "dm_relation_type" object must be set to TRUE in Documentum Collaboration Services Edition.

EMC Documentum Webtop Version 6.5 SP3 Release Notes 209



Documentation

Correction to the Search chapter in the Webtop User
Guide

The name Webtop Extended Search has been changed to Webtop Federated Search from 6.5 release,
only the name. The Extended Search occurs in the Search chapter of the Documentum Webtop User
Guide version 6.5. This name change to Federated Search does not affect the functionality (advanced
search functionality such as clustering of the search results, real-time monitoring, and search
templates). The deployment of the corresponding DARs too remains unchanged. The deployment
instructions are currently documented in the Installing Documentum Webtop Federated Search
chapter of theWeb Development Kit and Webtop Deployment Guide, version 6.5 SP1.

Correction to the Lifecycles chapter in the Webtop User
Guide

The following is the corrected description in the Viewing Lifecycles section from Lifecycles, Chapter 8
of the Documentum Webtop User Guide:

You can advance a file through its lifecycle manually by selecting the file and using the Promotemenu
option, or Records Manager (RM) Administrator can advance a file through its lifecycle automatically
based on conditions specified in the lifecycle definition, if a retention policy is associated with the
lifecycle. You can also demote a file to a previous lifecycle state. Ensure that the corrected text is
shared with the Documentum Records Manager Administrator User Guide.
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Chapter 8
Software Media, Organization, and
Files

This section describes the media in which the software is available, the organization of the product
components in the available media, and the file names for all available product components which
can be downloaded.

Software Media
This product is available as an FTPdownload from the Powerlinkwebsite (http://powerlink.EMC.com).
You should have received instructions through email regarding how to download products.

Organization
The Powerlink website (http://powerlink.EMC.com) provides access to https://emc.subscribenet.com/
control/dctm/index, which provides a complete listing of the products available for download.

Files
The following modules/files comprise the contents of this release:

• Documentum AppServer Policy Files, Version 6.5 SP3 (zip)

• Documentum Virtual Link Root Application, Version 6.5 SP3 (war)

• WDK_Samples_and_TestBed_6.5_SP3.zip

• EmailMigration.zip, Version 6.5 SP3

• DocumentumWeb Development Kit and Webtop Deployment Guide, Version 6.5 SP2 (pdf)

• Documentum Web Development Kit and Webtop Reference Guide, Version 6.5 (pdf)
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Software Media, Organization, and Files

• Documentum Webtop Release Notes, Version 6.5 SP3 (pdf)

• Documentum Webtop, Version 6.5 SP3 (war)
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Chapter 9
Installation

The instructions for installing the product are provided in the Documentum Web Development Kit
and Webtop Deployment Guide.

Ensure that your system meets the requirements listed in Chapter 4, Environment and System
Requirements before installing the software.
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Chapter 10
Troubleshooting and Getting Help

Documentum’s technical support services are designed to make your deployment and management
of Documentum products as effective as possible. The EMC Customer Support Guide provides a
thorough explanation of Documentum’s support services and policies. You can download this
document from the Powerlink site (http://powerlink.EMC.com) by navigating to: Support > Request
Support > Customer Support Guide.
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